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はじめに

Autodesk Maya 2010 リリースノート
Maya 2010 リリースノートは、Maya の既知の制限事項と解決方法を紹介し、
Maya の機能に応じて章に分けられています。

このリリースで修正された制限事項については、次を参照してください。

■ 一般的な修正事項 (3 ページ)

■ モデリングの修正事項 (4 ページ)

■ アニメーションの修正事項 (4 ページ)

■ キャラクタセットアップの修正事項 (5 ページ)

■ レンダリングの修正事項 (5 ページ)

■ 流体エフェクトの修正事項 (7 ページ)
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Autodesk Maya 2010 の修
正事項

修正事項
Autodesk® Maya® 2010 では、ユーザの皆様から報告されていた Maya ソフトウェ
アのいつくかの問題が修正されました。新機能と強化機能については、『Maya の
新機能』マニュアルの「Autodesk Maya の新機能」を参照してください。

以下のセクションでは、Maya 2010 で修正されたソフトウェアに関する制限事項
を紹介します。

一般的な修正事項
Maya 2010 で修正された一般的な制限事項について次に説明します。

Maya ソフトウェアレンダラのライセンス要求

Maya ソフトウェアレンダラでレンダーをするときに、環境変数 MAYA_LICENSE
を設定していててもライセンスが要求されなくなりました。

アセットの修正事項
Maya 2010 で修正されたアセットに関する制限事項について次に説明します。
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カスタムコンテナアイコンの透明度

Maya の旧バージョンでは、ハイパーグラフ（Hypergraph）のコンテナアイコ
ンは透明度をサポートしていませんでした。これは修正されました。

モデリングの修正事項
Maya 2010 で修正されたモデリングに関する制限事項について次に説明します。

自動マッピングでワールド空間が考慮されない

Maya 旧バージョンでは、ハードウェアテクスチャリング（Hardware
Texturing）モードをオンにして、パースビューの自動マッピング（Automatic
Mapping）を使用してテクスチャマップを割り当てたオブジェクトを移動する
と、テクスチャがシフトしていました。これは修正されました。

アニメーションの修正事項
Maya 2010 で修正されたアニメーションに関する制限事項について次に説明し
ます。

アニメーションレイヤの修正事項

アニメーションレイヤに関する以下の問題が修正されました。

キャラクタセットを含むアニメーションレイヤの使用

キャラクタセットを含むアニメーションレイヤをマージするときに発生してい
た問題が修正されました。キャラクタセットを含むアニメーションレイヤを
マージできるようになり、アニメーションレイヤへのキャラクタセットのコネ
クションが意図したとおりに維持されきます。

インポートしたアニメーションレイヤのマージ

インポートしたアニメーションレイヤを適切にマージできないという問題が修
正されました。アニメーションレイヤをシーンにインポートしてから、意図し
たとおりにマージできるようになりました。
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MotionBuilder からのレイヤのインポート

Maya に付属する FBX プラグインに、MotionBuilder アニメーションレイヤを
インポートする機能が追加されました。ただし、Maya のアニメーションレイ
ヤを MotionBuilder にエクスポートする機能はサポートされていません。

Maya の FBX プラグインの詳細と FBX プラグインの最新リリースについては、
http://www.autodesk.co.jp/fbx を参照してください。

キャラクタセットアップの修正事項
Maya 2010 で修正されたキャラクタセットアップに関する制限事項について次
に説明します。

ラップデフォーマでのカーブインフルエンスオブジェクトの使用

ラップデフォーマにカーブインフルエンスオブジェクトを使用すると予期せぬ
デフォメーションが生じる問題が修正されました。ラップデフォーマでカーブ
を使用してサーフェスを問題なくデフォームできるようになりました。

レンダリングの修正事項
Maya 2010 で修正されたレンダリングに関する制限事項について次に説明しま
す。

ベイク処理時のオーバーライド有効化（Enable Overrides）

以前は、ベイク処理時にオブジェクトのシェイプ（Shape）ノードのオブジェク
トディスプレイ（Object Display）セクションの描画オーバライド（Drawing
Overrides）サブセクションにあるオーバーライド有効化（Enable Overrides）
アトリビュートが反映されませんでした。これは修正されました。

頂点カラーのシェーディング

CG 2.0 の最適化により、頂点カラーのシェーディングがレンダービュー（Render
View）とバッチレンダー時に正しくレンダーされませんでした。これは修正さ
れました。
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立体視カメラと ATI グラフィックスカード

CG 2.1 の更新により、ATI グラフィックスカードを使用している場合に立体視
カメラで表示エラーが発生していました。これは修正されました。

mental ray for Maya レンダリング

mia_material_x_passesシェーダとフォトンとシャドウ

mia_material_x_passesシェーダで、フォトンとシャドウが正しく機能するよう
になりました。

mia_material_x_passesシェーダと不透明度の切り取り（Cutout
Opacity）アトリビュート

以前は、mia_material_x_passes シェーダと不透明度の切り取り（Cutout
Opacity）アトリビュートを同時に使用すると、レンダリング中に Maya が停止
することがありました。これは修正されました。

BSP2 とモーションストラクチャの構築

以前は、BSP2 はモーションステートメント "オン/オフ" のみを考慮し、シャッ
ター値に関係なくモーションストラクチャを構築していました。たとえば、
シャッター値が 0.0 0.0 であってもモーションストラクチャが構築されていまし
た。これは修正されました。

Maya から .mi フォーマットに変換されたファイルのパスのレンダリング

以前は、Maya ファイルから .miフォーマットへの変換にコマンドラインを使
用した場合、.miファイルのパスがレンダーされませんでした。これは修正され
ました。

mental ray for Maya とプロセッサの制限事項

以前は、ハイパースレッディングがオンに設定すると、mental ray for Maya レ
ンダラですべての利用可能なプロセッサが使用されませんでした。これが修正
され、すべての利用可能なプロセッサがレンダリングに使用されるようになりま
した。
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ヘア単位のテクスチャと頂点単位のテクスチャを併用するとレイトレー
スしたヘアのテクスチャ空間が正しくセットアップされない問題を修正

以前は、ヘア単位のテクスチャと頂点単位のテクスチャを併用した場合、レイト
レースしたヘアのテクスチャ空間が正しくセットアップされないことがありまし
た。これは修正されました。

レイヤセットへのリンク（Link to Layer Set）オプションが PSD ファイ
ルノードに対して正しく設定されるようになった

以前は、PSD ファイル テクスチャ（PSD File Texture）ノードでテクスチャファ
イルを検出できない場合、レイヤ セットへのリンク（Link to Layer Set）オプ
ションが合成（Composite）に設定されていました。これは修正されました。

流体エフェクトの修正事項
Maya 2010 で修正された流体エフェクトに関する制限事項について次に説明し
ます。

高解像度グリッドの流体エフェクトを nCache すると Mata がクラッシュ
する

Maya 2009 では、前の流体キャッシュシステムでサポートされていた高解像度
グリッドの流体エフェクトをキャッシングすると、Maya がクラッシュしていま
した。この問題は修正されました。Maya 2008 でキャッシングが可能であった
グリッドサイズに相当する大きさのグリッドの流体エフェクトを nCache でき
るようになりました。

nCloth の修正事項
Maya 2010 で修正された nCloth に関する制限事項について次に説明します。

nCloth のトランスフォームコンストレインでの衝突の除外（Exclude
Collisions）

以前は、トランスフォーム コンストレインがある nCloth オブジェクトで
dynamicConstraintShape ノードの衝突の除外（Exclude Collisions）を有効に
した場合、それ以降に nCloth オブジェクトに追加したすべてのコンストレイン
も衝突の除外の動作を適用してしまいました。この問題は修正されました。
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選択したオブジェクトやダイナミックリレーションシップ（Dynamic
Relationship）エディタでの nCloth キャッシングエラー

nCloth オブジェクトを nCache するときに、nCloth オブジェクトとその出力
メッシュを選択した場合やダイナミック リレーションシップ（Dynamic
Rlationships）エディタが開いている場合（つまり nCloth オブジェクトとその
出力メッシュを自動的に選択する）でも、エラーが発生しなくなりました。

nCloth オブジェクトを同じファイルにキャッシュする場合、速度チャン
ネルの接続が作成されない

同じキャッシュファイルにある 2 つの nCloth オブジェクトの位置と速度
（Position And Velocity）をキャッシュできるようになりました。つまり、速
度チャンネル用に追加の接続を作成する、あるいはキャッシュノードの各デー
タ出力に関連付けるチャンネルの名前を指定する必要がなくなりました。速度
チャンネルのキャッシュブレンドはまだサポートされていないのでご注意くだ
さい。

nCloth キャッシングと安定化

以前は、1 つのエッジに沿ってコンストレインされたキャッシュ済みの nCloth
オブジェクトは、キャッシュにアペンド（Append to Cache）後も安定化を行っ
ていました。これは修正されました。

nParticle の修正事項
Maya 2010 で修正された nParticle に関する制限事項について次に説明します。

エクスプレッションでの nParticle の存在時間（Age）の計算

以前は、nParticle のエクスプレッションで存在時間（Age）を使用すると存在
時間が間違って計算され、nParticles が早く消滅（シーンから消える）してしま
い、Maya が停止することもありました。これは修正されました。

spriteTwistPP で nParticles をキャッシングする場合にキャッシュ可能な
アトリビュート（Cacheable Attributes）をすべて（All）に設定する必要
がある

以前は、nParticleShape ノードでキャッシュ可能なアトリビュート（Cacheable
Attributes）を位置（Position）、位置と速度（Position and Velocity）または
ダイナミクスとレンダリング（Dynamics and Rendering）に設定した
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spriteTwistPP アトリビュートを含む nParticle オブジェクトをキャッシュする
と、キャッシュされたシーンを保存して再び開いたときに Maya が停止してい
ました。この動作は、nParticle オブジェクトに spriteScalePP アトリビュートが
含まれる場合にも生じることがありました。

spriteTwistPP アトリビュートのキャッシュが、ダイナミクスとレンダリング
（Dynamics and Rendering）またはすべて（All）の設定で実行されるようにな
りました。キャッシュ可能なアトリビュート（Cacheable Attributes）に位置
（Position）または位置と速度（Position and Velocity）を選択すると、
spriteTwistPP と spriteScalePP のアトリビュートはキャッシュしていないかぎ
り無視され、クラッシュすることはありません。

API の修正事項
Maya 2010 で修正された API に関する制限事項について次に説明します。

データメッシュでの MFnMesh::setStringBlindData と
MFnMesh::setBinaryBlindData

MFnMesh::setStringBlindData と MFnMesh::setBinaryBlindData をデータメッ
シュに使用した場合、Maya がより安定するようになりました。

編集モードまたは照会モードで MPxModelEditorCommand を使用

カスタム MPxModelEditorCommand は 'scriptedPanelType' コマンドでセット
アップし、パネルの作成やレイアウトへのペアレント化などに使用されるコール
バックスクリプトを指定できます。以前は、このようなスクリプトが編集モー
ドまたは照会モードでカスタム MPxModelEditorCommand を使用すると、
Maya が不安定になり停止する可能性がありました。これは修正されました。

UI にコールバックを設定した場合の MUiMessage

以前は、UI にコールバックを設定しようとすると、MUiMessage がエラーにな
ることがありました。これは修正されました。

スクリプティングの修正事項
Maya 2010 で修正されたスクリプティングに関する制限事項について次に説明
します。
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Maya 2008 で pymel がクラッシュする

Maya 2008 で pymel コマンドを使用するとクラッシュしていました。これは修
正されました。

Python での fileBrowserDialog fileCommand フラグ機能

Maya の旧バージョンでは、Python で fileBrowserDialog fileCommand フラグ
が機能しませんでしたが、これは修正されました。

fileBrowserDialog fileCommand フラグにより、起動時に
scanStringConstant を使用すると CER がクラッシュする

Maya の旧バージョンでは、起動時に scanStringConstant を使用すると、CER
がクラッシュしていました。これは修正されました。

md5 を Python にインポートできない

以前は md5 フォーマットを Python にインポートできませんでしたが、これは
修正されました。

Python の修正事項
Maya 2010 で修正された Python に関する制限事項について次に説明します。

MPolyMessage::addPolyComponentIdChangedCallback の実行

以前は、MPolyMessage::addPolyComponentIdChangedCallback コールバッ
クを実行すると Maya が停止していました。これは修正されました。

ポインタとして渡されるコールバックパラメータ

複数の MLockMessage コールバックに渡される "decision" 変数など、ポインタ
として渡されるコールバックパラメータが Python で適切に処理されるように
なりました。

注: これらのパラメータはポインタであるため、適切な MScriptUtil.set*()メソッ
ドを使用して戻り値を設定する必要があります。
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mayapy.exe または maya.standalone の使用時の環境変数

以前は mayapy.exe または maya.standalone の使用時に、os.environ が Maya
の環境変数（MAYA_APP_DIR, MAYA_SCRIPT_PATH など）に瞬時にアクセス
できないため、そのプラットフォームのデフォルトに設定されませんでした。こ
れは修正されました。

maya.cmds.file と loadReferenceDepth (lrd)でファイルを開く

以前は、loadReferenceDepth (lrd) を "all" または "topOnly" に設定した状態で
maya.cmds.file コマンドを使用してファイルを開くと、リファレンスのロード
中に Maya が停止することがありました。この場合、Python も停止していまし
た。これは修正されました。

プラグレベルのコールバックの削除

MLockMessage.setPlugLockQueryCallback()などによってセットアップされる、
プラグレベルのコールバックを削除しても、MMessage.removeCallback() が
Python の例外エラーを発生しなくなりました。
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インストールとライセン
ス発行

インストールに関する一般的な制限事項
次にインストールとライセンス発行に関する制限事項と解決方法を説明します。

（Linux）rpm ユーティリティを使用した Maya の登録用の構文が不正であ
る

Maya 2010 では、『インストールとライセンス発行』マニュアルの手順 9 の rpm
ユーティリティを使用した Maya のインストールの説明で、プロダクトキーを使
用して Maya を登録するための構文に誤りがあります。

adlmregコマンドを実行して Maya を Autodesk ライセンスを発行して登録する
ための正しい構文には、以下の 2 つのプロダクトキーが含まれます。

■ （スタンドアロンライセンス）
/usr/autodesk/maya2010-x64/bin/adlmreg -i S <productKey1>

<productKey2> 2010.0.0.F <serialNum>

/var/opt/Autodesk/Adlm/Maya2010/MayaConfig.pit

■ （ネットワークライセンス）
/usr/autodesk/maya2010-x64/bin/adlmreg -i N <productKey1>

<productKey2> 2010.0.0.F <serialNum>

/var/opt/Autodesk/Adlm/Maya2010/MayaConfig.pit

ここで <productKey1>と <productKey2>は、プロダクトキーで、<serialNum>

はシリアル番号です。

3
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注: Maya を単独で購入してプロダクトキーを 1 つしか取得していない場合、
<productKey1>と <productKey2>の両方に同じプロダクトキーを入力します。

例:

/usr/autodesk/maya2010-x64/bin/adlmreg -i S 657B1 657B1 2010.0.0.F

000-00000000

（Windows）デフォルトで Path 変数に Maya が追加されない

インストール時に、デフォルトでは Maya がシステムの Path 変数にセットアッ
プされなくなりました。コマンドラインから Maya を実行する場合、またはコ
マンドのフルパスを指定せずにバッチレンダーを行う場合、Maya を Path 変数
に追加しておくと便利です。

Maya のインストールウィザードで、システムパスに追加（Add to System
Path）をオンにすることもできますが、Maya 2010 のプログラムフォルダをシ
ステムの Path 環境変数に手動で追加することもできます。

詳細については、Maya ヘルプの『レンダリングとレンダー セットアップ』マ
ニュアルを参照し、「レンダリング ユーティリティ > コマンド ライン レンダラ
> コマンド ラインからレンダーする」のトピックに移動してください。

FLEXnet License Finder でネットワークライセンスを検出できない
（Windows 64 ビット版）

ネットワークライセンスを使用して Windows 64 ビット版オペレーティングシ
ステムで Maya を実行する場合、FL EXnet License Finder ウィンドウが開き、
適切なライセンスサーバを指定するように求められます。これはクライアント
のライセンスファイルが存在しない場合、サーバの lmgrd が実行されていない
場合、またはライセンスサーバを検出できない場合に発生します。

必須フィールドにサーバ情報を入力しても Maya は正常に起動せず、複数のエ
ラーメッセージが連続して表示されます。

解決方法

クライアントマシンでクライアントライセンスファイルを手動で編集し、ライ
センスサーバ名を追加します。例:

SERVER maya-licenseserver 0

USE_SERVER
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デフォルトでは、このファイルは <drive>:\FlexLM\Maya2010.licにありま
す。

ライセンスサーバのファイアウォールでクライアントマシンがブロック
されることがある

ラインセンスサーバマシン上でファイアウォールを実行している場合、クライ
アントマシンがサーバのライセンスにアクセスできるように、adskflex.exe と
lmgrd.exe の例外を追加する必要があります。

クライアントマシン上で Maya を実行しようとしたときにネットワークエラー
が発生した場合、ライセンスサーバが実行されていることを確認し、例外をセッ
トアップしてください。

（Windows）最初の再起動時にライセンスサーバに障害が発生する

ライセンスサーバマシンを Maya ライセンスサーバとして設定後に初めて再
起動したとき、lmgrd.exe プロセスが失敗した場合、LMTOOLS を使用してライ
センスサーバを手動で起動してください。

注: 手動での操作が必要になるのは、ライセンスサーバの最初の起動時のみで
す。以降の再起動では、ライセンスサーバは正常に起動します。

ライセンス サーバを手動で起動するには

1 [スタート] > [すべてのプログラム] > [Autodesk] > [Network License
Manager] > [LMTOOLS] を選択します。

LMTOOLS ウィンドウが開きます。

2 ［Start/Stop/Reread］タブをクリックし、［Start Server］をクリックし
ます。

SAMreport-Lite のサポート

Autodesk は、SAMreport-Lite と呼ばれる SAMreport のバージョンを提供して
おり、これを使用するとネットワークライセンスの使用状況を追跡できます。

Maya 2010 の『インストールとライセンス発行』マニュアルにある、
SAMreport-Lite のバージョンが Autodesk 製品ディスクに収録されているとい
う記述は誤りです。SAMreport-Lite は Maya 2010 DVD には収録されていませ
ん。SAMreport-Lite をダウンロードするには、Autodesk の Web サイトを参照
してください（www.autodesk.co.jp/samreportlite）。
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さらに、Maya 2010 の『インストールとライセンス発行』マニュアルの記述の
とおり、Autodesk 製品メニューブラウザで『SAMreport-Lite User’s Guide』（英
語）をご覧になれます。SAMreport-Lite のマニュアルは Maya からは閲覧でき
ません。

アンインストールに関する制限事項
前のバージョンの Backburner をアンインストールする

前のバージョンの Backburner がインストールされている状態で Maya 2010 と
Backburner を両方インストールする場合、インストーラには既存バージョンの
Backburner をアンインストールまたは修復するオプションが表示されます。た
だし、インストールされている Backburner のバージョンによっては、アンイン
ストールと修復を実行しても Backburner が削除されないことがあります。

解決方法

旧バージョンの Backburner をすべて手動でアンインストールしてから、Maya
2010 インストーラを使用してインストールします。

（Windows Vista）アンインストール進捗バーの更新速度が非常に遅い

Windows Vista で Maya 2010 をアンインストールする場合、アンインストール
の状況を示す進捗バーは数分間変化しません。アンインストールは正常に実行
され、完了時には進捗バーにアンインストールが完了したことが表示されます。

（Windows Vista SP 1）Maya、MatchMover、DirectConnect をアンイン
ストールすると 3ds max を実行できなくなる

Windows Vista Service Pack 1 では、Maya、MatchMover、DirectConnect を
アンインストールすると、3ds max を実行できなくなります。

解決方法

Maya、MatchMover、または DirectConnect を再インストールします。再イ
ンストール後は、前と同じように 3ds max を起動できるようになります。
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ベータプログラムに参加いただいた方へ
以下のリリースノートは、Maya 2009 または Maya 2010 のベータプログラム
の一部として Maya をインストールしたお客様向けです。

（Windows）保存された Maya 2010 ベータ用インストールファイルによ
り正常な DVD インストールを実行できない

Maya 2010 ベータプログラムに参加された場合、ディスクに保存されたインス
トールファイルが原因で DVD から Maya 2010 と Maya 2010 マニュアルをイ
ンストールできないことがあります。

ベータダウンロードパッケージから Maya インストーラを起動すると、インス
トールウィザードでは、セットアップ完了後もファイルをディスクに残す（Leave
files on disk after Setup has finished）というオプションが表示されます。デ
フォルトでは、オフに設定されています。このオプションをオンにすると、イン
ストールファイルはデフォルトではディレクトリ C:\Autodesk\Maya2010\win\

に保存されます。

解決方法

C:\Autodesk\Maya2010\win\ディレクトリからすべてのキャッシュ済みベータ
用インストールファイルを手動で削除してから、Maya 2010 を DVD からイン
ストールします。

（Windows）Maya 2009 ベータ用ライセンス発行ファイルが Maya 2010
のライセンス発行を妨害する

Maya 2009 ベータプログラムに参加された場合、Maya 2010 をインストール
する前にベータ用ライセンス発行ファイルを手動で削除する必要があります。

マシンに Maya 2009 ベータ用ライセンス発行ファイルがあると、次のエラー
メッセージが表示されることがあります。

1:5:2: adlmPITSetProductInformation failed 3:25.

解決方法

ベータバージョンの Maya 2009 をインストールした場合、以下の手順,を完了
して前のライセンス発行ファイルをシステムから削除してから、Maya 2010 を
インストールします。

1 Maya 2009 ベータバージョンをアンインストールします。
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2 以下のフォルダを手動で削除します。

■ C:\Documents and Settings\All users\Application

data\Autodesk\Adlm

■ C:\Program Files\Common Files\Autodesk Shared\adlm\R1
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基本的なインタフェース

UI に関する一般的な制限事項
一般的なユーザインタフェースに関する制限事項と解決方法について次に説明し
ます。プラットフォームに固有な UI の問題については、以下を参考にしてくださ
い。

■ Maya for Windows の制限事項 (148 ページ)

■ Maya for Linux の制限事項 (149 ページ)

■ Maya for Mac OS X の制限事項 (151 ページ)

多くの数値を使用する非複合アトリビュートのアトリビュートエディタで
新規項目の追加（Add New Item）ボタンが見当たらない

多くの数値を使用するアトリビュートのアトリビュートエディタには、新規項目
の追加（Add New Item）ボタンはありません。たとえば、プラス マイナス平均
（+/- Average）シェーディングノードの入力 1D（Input 1D）セクションには新
規項目の追加（Add New Item）ボタンはありません。

NVIDIA GeForce G80/G92 ベースのグラフィックスカードでの表示に関す
る諸問題

Maya と NVIDIA GeForce G80/G92 ベースのグラフィックスカードを使用する
と、画面のリフレッシュに関連するさまざまな問題が発生する場合があります。

4
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解決方法

環境変数 MAYA_GEFORCE_SKIP_OVERLAY=1 を Maya.env ファイルに追加し
ます。

スクリプト（Script）フィルタで filterChanged コールバックがコールさ
れない

スクリプトを変更しても、スクリプトフィルタによって filterChangedコールバッ
クがコールされることはありません。たとえば、次のような項目フィルタを作成
したとします。

itemFilter -byScript userScript filter1;

このスクリプトを変更しても、フィルタが変更されたというメッセージは Maya
から出力されません。

解決方法

同じスクリプトをフィルタに再度割り当ててください。

itemFilter -edit -byScript userScript filter1

Maya で UNIX シェルのキー繰り返し機能がオフのままになる

Maya を使用すると、UNIX シェルのキー繰り返し機能がオフになる場合があり
ます。

解決方法

UNIX コマンドの xsetを使用して、キー繰り返し機能をオンに戻してください。

xset r on

シェルフをロードするとスクリプトが 2 回表示される

シェルフをロードすると、それに含まれるすべてのスクリプトが重複して表示さ
れます。

解決方法

scripts/others/loadNewShelf.melスクリプトを編集して、以下の行を削除し
ます。

eval($proc);
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Maya 3D Shockwave エクスポータ

Maya 3D Shockwave エクスポータは Maya の一部として提供されなくなりまし
た。

切り離されたメニューと Windows XP

Windows XP スタイルのウィンドウやボタンを使用すると、Maya の切り離し
たメニューの表示に問題が生じます。

解決方法

[スタート] > [コントロール パネル]を選択して、[画面]アイコンをダブルクリッ
クします。[デザイン] タブを選択して、[ウィンドウとボタン] を [Windows ク
ラシック スタイル] に変更します。

メインウィンドウでアトリビュートエディタ（Attribute Editor）を使用
しているときにホットキーが機能しない

メインウィンドウでアトリビュート エディタを開いてクリックし、新しい値を
入力して Enter キーを押しても、キーボードのフォーカスがアトリビュート エ
ディタのままになります。すなわち、フォーカスをモデリングウィンドウに戻
さなければホットキーが機能しません。

解決方法

何も変更せずにフォーカスをモデリングウィンドウに戻すには、マウスをウィ
ンドウ上に置いて中マウスボタンをクリックしてください。

Linux マシンでのインタラクティブパフォーマンスを上げる

Linux マシンでアトリビュート エディタを使用しないときは、閉じるか非表示
にしておくと、Maya のインタラクティブパフォーマンスが上がります。

投げ縄ツール（Lasso Tool）を使ったコンポーネントの選択

セレクション モード（Selection Mode）がオブジェクト（Object）に設定され
ている場合、投げ縄ツールでオブジェクトや強調表示されているコンポーネント
を選択できないことがあります。特に、投げ縄が選択の優先順位の高いアイテム
に近づいたときに、この現象が起こります。
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解決方法

コンポーネントを選択するときには、セレクション モードをコンポーネント
（Component）に設定します。

電源節約ソフトウェアで問題が発生する

OpenGL を使用する電源節約ソフトウェアや何らかのスクリーンセーバーを使
用している場合、Maya が異常終了することや、Maya セッションやバッチレン
ダーの終わりにシステム問題が発生する可能性があります。この問題は 64 ビッ
トシステムで報告されています。

解決方法

Maya で作業するときは、電源節約ソフトウェアを無効にしてください。

スタートアップスクリプトで menuItem を使用すると既存のメニューが
壊れる

menuItem コマンドが指定された MEL スクリプトを使用して Maya を起動する
と、メインメニューバーにスクリプトのカスタムメニューしか表示されませ
ん。

解決方法

menuItem コマンドを指定したスクリプトの前に、次の MEL スクリプトを実行
します。
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global proc buildDeferredMenus()

{

// File Menu

buildFileMenu();

// Edit Menu

global string $gMainEditMenu;

string $editMenu = "MayaWindow|" + $gMainEditMenu;

buildEditMenu( $editMenu );

// Assets Menu

global string $gMainAssetsMenu;

buildAssetsMenu( "", $gMainAssetsMenu );

// Window Menu

global string $gMainWindowMenu;

buildViewMenu ( $gMainWindowMenu );

// Help Menu buildHelpMenu();

// Paint Effects menu

global string $gMainCreatorMenu;

string $creatorMenu = "MayaWindow|" + $gMainCreatorMenu;

buildCreatorMenu ( $creatorMenu );

}

日本語ユーザインタフェース
カスタムインストールパス

Maya のカスタムインストールパスは、ASCII 文字だけを使用して指定するこ
とをお勧めします。つまり、インストールパスの一部にマルチバイトテキスト
を入力すると、予期せぬ結果が発生する可能性があります。

マルチバイトノード名とアトリビュート

Maya では、ノード名とアトリビュートを指定するときマルチバイトテキスト
をサポートしていません。

解決方法

ノード名やアトリビュートにマルチバイトテキストを使用しないでください。
シングルバイトキャラクタだけが、有効なノードとアトリビュート名を作成で
きます。
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バージョン 8.5 より前の Maya ファイルを開始すると、パネル名が英語で
表示されます。

8.5 より前の Maya ファイルを Maya 8.5 日本語バージョンでロードすると、パ
ネル名が英語で表示されることがあります。

解決方法

パネル名を日本語で表示するには、シーンを Maya 8.5 で保存してから再び開い
てパネル名をリセットします。

Maya のローカライズバージョンの使用時に構文エラーが発生する

Maya の大半のコマンドはマルチバイトテキストで正しく処理されますが、ユー
ザインタフェースの一部のテキストフィールドでマルチバイトテキストを使用
すると、構文エラーが発生する可能性があります。

解決方法

テキストフィールドからマルチバイト文字を削除して、再実行してください。

Maya でのマルチバイトテキストを使用したスクリプティング

マルチバイトキャラクタを使用する MEL でのローカライズテキストは、ダブ
ルクォーテーションで囲んだ場合にのみ受け付けられます（"textstring"）。
ダブルコーテーションで囲まれていないマルチバイト文字で構成されたテキス
ト文字列を MEL コマンドの一部として実行すると、構文エラーが生成されま
す。

ユーザインタフェースパネル/コンフィギュレーション名に関する制限
事項

英語のパネル/コンフィギュレーション名を使用する MEL スクリプトと Python
スクリプトは、Maya のローカライズバージョンで正しく実行する前に更新し
なければなりません。

解決方法

次の例を参考にスクリプトの構文を変更してください。たとえば、次のような
行:getPanel -withLabel "Graph Editor"を次の行に置き換えます:getPanel

-withLabel (localizedPanelLabel("Graph Editor"))
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環境変数設定時のマルチバイトテキスト

Maya.env ファイルを使用してマルチバイト文字のある環境変数を初期化する
と、誤った動作や文字化けが発生する可能性があります。

解決方法

Maya.env を使用して環境変数を初期化するとき、マルチバイトテキストを使
用しないでください。

ファイルリファレンスのための名前の衝突プリフィックスを定義するマ
ルチバイトテキスト

Maya は、ファイルリファレンスのための名前の衝突プリフィックスを定義す
るときマルチバイトテキストをサポートしません。

解決方法

名前の衝突プリフィックスにマルチバイトテキストを使用しないでください。
シングルバイト文字だけが動作します。
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一般

アセットの制限事項
Maya 2008 以前のコンテナをロードすると警告メッセージが表示される

Maya 2010 では、コンテナは他のファイルの非コンテナノードを含まなくなりま
した。このような許可されないノードは、ファイルの読み取り時にコンテナから
自動的に削除されます。警告メッセージは影響を受けたノードに対して発行され
ます。

解決方法

リファレンスファイルを開き、リファレンスノードをコンテナに配置します。こ
のコンテナを親シーンのコンテナのサブコンテナにします。

アウトライナでカスタムコンテナアイコンを選択するとノイズが表示さ
れる

カスタムアイコンをコンテナに割り当ててからアウトライナで選択すると、アイ
コンの背景にノイズが生じる場合があります。

解決方法

PNG または XPM ファイルの使用時に、アイコンの背景カラーが均一になってい
ることを確認します。

5
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最初にロードしたテンプレートが常に Types.template のエラーとして報
告される

Types.template にエラーがあるという無効なエラーメッセージが定期的に発行
されます。実際には、Maya がロードしようとした最初のコンテナテンプレー
トファイルにエラーがあることを示します。

解決方法

実際にエラーのあるテンプレートファイルを特定し、削除または修正します。

パブリッシュされたアトリビュートが多すぎて、チャンネルボックス
（Channel Box）を開いたときに選択処理の速度が遅くなる

デフォルトでは、チャンネル ボックス（Channel Box）の生成が選択速度に影
響を与えないようにチャンネル ボックスのアトリビュート表示は最大 400 個に
制限されています。

解決方法 1

チャンネル ボックス（Channel Box）で、表示 > コンテナ > 選択したオブジェ
クトのアトリビュート（Show > Containers > Selected object attributes）を選
択します。

解決方法 2

対象のアトリビュートをまとめた各種ビューを使用してテンプレートを作成しま
す。コンテナのビュー モード（View Mode）をテンプレートの使用（Use
Template）に設定し、必要なビューを選択します。チャンネル ボックス
（Channel Box）には、対象のアトリビュートのみが表示されます。

解決方法 3

optionVar の containerChanBoxMaxWithTemplate と
containerChanBoxMaxNoTemplate を使用すると、チャンネルボックス
（Channel Box）の上限を修正できます。

例:

optionVar -intValuecontainerChanBoxMaxWithTemplate 1000

ここに負の値を指定した場合、チャンネルボックスはアトリビュートをカリン
グできません。
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パブリッシュされた float 値のスライダが適切な範囲にならない場合があ
る

コンテナにパブリッシュされ、最小値と最大値が割り当てられていないダイナ
ミックアトリビュートは、次に示すデフォルトのソフト最小値とソフト最大値
でコンテナ UI に表示されます。

■ 単位のないアトリビュート: -25 ～ 25

■ リニアアトリビュート: -100 ～ 100

■ 回転アトリビュート: -360 ～ 360

■ スケールアトリビュート: -10 ～ 10

解決方法

addAttr コマンドで softMinValue と softMaxValue フラグを使用して、カスタ
ムのソフト最小値とソフト最大値をアトリビュートに割り当てます。

元に戻す（Undo）の後でアセットエディタ（Asset Editor）がリフレッ
シュしない

アセットエディタ（Asset Editor）は、バインドまたはパブリッシュ操作を元に
戻した後に自動的にリフレッシュされません。元に戻す操作は正しく動作します
が、アセット エディタにはその結果が反映されません。

解決方法

コンテナの編集モードを解除してもう一度編集用に固定するか、リフレッシュ
（Refresh）ボタンをクリックします。

コンテナから削除するオプション

デフォルトでは、トランスフォームをコンテナから削除すると、関連するシェイ
プノードも一緒にコンテナから削除されます。これはコンテナに追加（Add to
Container）オプションの使用時に、階層を含む（Include Hierarchy）をオンに
してシェイプ（Shapes）に設定した場合と似ています。
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解決方法

optionVar「containerRemoveIncludeHier」を使用してこの動作を修正できま
す。この設定値とその効果を以下に示します。

■ 0 - 階層を含む（Include Hierarchy）はオフ

■ 1 - 階層を含む（Include Hierarchy）はオンでシェイプ（Shapes）に設定

■ 2 - 階層を含む（Include Hierarchy）はオンで下位（Below）（シェイプを
含む）に設定

■ 3 - 階層を含む（Include Hierarchy）はオンで上位（Above）に設定

■ 4 - 階層を含む（Include Hierarchy）はオンですべて（All）（下位と上位）
に設定

デフォルト値は 1 です。

多数のアトリビュートを使用する場合のアセットエディタ（Asset Editor）
とアトリビュートエディタ（Attribute Editor）のパフォーマンス

コンテナをフラット（Flat）ビューモードで表示するときに、40 個以上のパブ
リッシュ済みアトリビュートが存在する場合、40 を超えたアトリビュートはす
べてアトリビュートエディタ（Attribute Editor）とアセットエディタ（Asset
Editor）でグループに分類されます。UI のパフォーマンス向上のために、各グ
ループは独自のフレームで表示されます。FlatViewCap optionVar を使用して
これらのグループのサイズを設定できます。この値と効果を以下に示します。

■ 0: グループ化を完全に無効化

■ 12 以上: グループを指定した数に設定

■ その他の値: グループの数を 12 に設定

デフォルト値は 12 です。

ネストしたカレントコンテナの最上位にコンテナを作成する

ネストしたカレントコンテナの最上位にコンテナを作成しようとすると、Maya
はフリーズします。
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解決方法

カレントコンテナの設定（Set Current Container）をなし（None）に設定し、
コンテナを上位（Top Level）で作成してから、もう一度,カレントコンテナの
設定（Set Current Container）を設定します。

下位の階層を含めるオプションを使用してもリファレンスコンテナが含
まれない

コンテナの作成時に階層を含む（Include Hierarchy）で下位（シェイプを含む）
（Below (including Shapes)）オプションを選択しても、リファレンスコンテナ
は含まれません。

解決方法

コンテナの作成後、リファレンスコンテナを選択して手動で追加します。これ
には、アウトライナ（Outliner）で中マウスボタンでドラッグするか、または
アセット > コンテナに追加（Assets > Add to Container）を使用します。

一般的な制限事項
デフォルト設定で新規プロジェクトを作成するとエラーが発生する

Autodesk Packet File プラグインをロードしてから、デフォルト設定で新規プロ
ジェクトを作成しようとすると（ファイル > プロジェクト > 新規（File > Project
> New））、エラーが返されます。

解決方法

AutodeskPacketFile.mllプラグインをアンロードしてから、新規プロジェクトを
作成します。

ディスプレイレイヤ:の制限事項

以下の既知の制限事項は、再生オン（Playback On）と再生オフ（Playback Off）
のオプションの使用時、ディスプレイレイヤに影響を与えます（ディスプレイ
レイヤ エディタ（Display Layer Editor）で、レイヤ > すべてのレイヤを設定 >
再生オン（Layers > Set All Layers > Playback On）またはレイヤ > すべてのレ
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イヤを設定 > 再生オフ（Layers > Set All Layers > Playback Off）を選択しま
す）。

■ 再生オン（Playback On）に設定すると、すべてのオブジェクトのアニメー
ションの再生が想定どおりに再開されない場合がある
解決方法 1: アニメーションを再開するオブジェクトをそれぞれ選択します。

解決方法 2: コマンド: dgdirty -aを実行します。

注: このコマンドは、すべてのオブジェクトが再生オフ（Playback Off）状
態のディスプレイレイヤにオブジェクトが存在していても、これらすべてを
更新します。

■ 再生オフ（Playback Off）を選択すると、オブジェクトの位置が予期しない
位置に更新される場合がある
解決方法: タイム スライダ（Time Slider）で中マウスボタンでドラッグし
て、アニメーションを更新せずに時間を更新します。何も選択せずにアニ
メーションを再生し、中マウスボタンで 1 フレームずつ前後にドラッグして
オブジェクト配置を適切に維持します。

■ ディスプレイレイヤ上のアニメートされた IK ハンドルが、再生オフ
（Playback Off）に設定してもアニメートされ続ける
解決方法: IK ハンドルでコンストレインを使用します。

ダイナミック複合アトリビュート

ダイナミック複合アトリビュートをノードに追加し、次にその複合アトリビュー
トを削除すると、同じ名前でダイナミックアトリビュートを再作成することが
できなくなります。

解決方法

次のいずれかを実行します。

■ シーンを保存してリロードします。

■ オブジェクトを複製してオリジナルのオブジェクトを削除し、オリジナルの
オブジェクトと同じになるように複製オブジェクトの名前を変更します。
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アニメーション

アニメーションに関する一般的な制限事項
Autodesk® Maya®における一般的なアニメーションの問題に関する制限事項と解
決方法について次に説明します。

トポロジ変更を伴うオブジェクトのキャッシング

キャッシングは、トポロジが時間とともに変化しないオブジェクトに対して有用
な結果を生成します。一部のアニメートされたモデリングコンストラクションヒ
ストリ操作の結果では、トポロジが時間とともに変化します。これらのオブジェ
クトにキャッシュを作成することはできますが、キャッシングはトポロジが変化
しない事を前提にしているため、再生時にオブジェクトが予期せぬ変形をする事
があります。

また、キャッシュ作成後にメッシュのトポロジを変更し、それから新たにキャッ
シュを作成すると、意図したとおりに作成されない場合があります。たとえば、
低解像度モデルをキャッシュし、PolySmooth ノードを追加してから再びモデル
をキャッシュすると、キャッシュはディスクに正確に作成されますが、新しい
キャッシュノードがディペンデンシーグラフの不正な位置にコネクトされること
があります。

新しいジオメトリキャッシュを意図したとおりに機能させるには、以下の解決方
法を使用してください。

解決方法
1 新しいジオメトリキャッシュを作成します。
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2 編集 > 種類ごとにすべてを削除 > ヒストリ（Edit > Delete All By Type >
History）を選択します。

3 ジオメトリ キャッシュ > キャッシュのインポート（Geometry Cache >
Import Cache）を選択して、スムージングされたジオメトリのキャッシュ
をアタッチします。

キーのカット（Cut Keys）のシェイプ（Shape）オプションは、シェイプ
がチャンネルボックス（Channel Box）で展開されている場合のみ有効

オブジェクトからキーのカットを実行できるのは、そのシェイプノードがチャ
ンネルボックスで展開している場合のみです。

解決方法

シェイプでキーのカットを実行するには、シェイプのオプションを有効にして、
そのシェイプノードをチャンネル ボックス（Channel Box）で展開しておく必
要があります。

ペアブレンド/クォータニオンのアニメーションカーブの組み合わせで
オブジェクトがジャンプする

回転のアニメーションカーブのデフォルト設定が同期化されたクォータニオン
補間のときに、コンストレインされたオブジェクトにキーを設定すると、該当す
るオブジェクトにジャンプが発生する可能性があります。

解決方法

キーを設定する回転値を入力し直して、回転チャンネルのキー設定をやり直して
ください。

クォータニオンアニメーションカーブが Trax クリップに正しく変換さ
れない

解決方法

クリップのクォータニオンが正しく機能するのは、3 つの回転チャンネルがすべ
てキャラクタに含まれている場合だけです。これは、Maya の自動キャラクタ作
成機能を使用している場合に自動的に行われます。しかし、クォータニオンを使
用して手動でキャラクタを作成する場合は、キャラクタの 3 つの回転チャンネ
ルをすべて含める必要があります。
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同期化クォータニオンカーブ

同期化クォータニオンカーブの場合、オブジェクト上にある 3 つの回転チャン
ネルはすべて、同時に存在していなければなりません。回転チャンネルの 1 つ
を削除すると、残りのチャンネルのアニメーションが変更されるなど、予期せぬ
結果が生じます。

解決方法

チャンネルを削除する前に、カーブをオイラー角度に変換してください。また
は、チャンネルを削除する代わりに、チャンネルの回転キーにスタティックな値
を設定してください。

同期化クォータニオンの回転角度補間の制限

同期化クォータニオン（Synchronized Quaternion）プリファレンスで回転角度
のキーフレームを設定すると、回転角度は +/-360°の間で固定されます。

API での修正時に 3 つのチャンネルすべてが同期化されていなければア
ニメーションが予期せぬ動作をする

API を使用して、同期化されたアニメーションカーブ（クォータニオン、また
は同期化されたオイラー）のキーを修正する場合、3 つの回転チャンネルにあ
る、すべてのキーフレームは常に同期化されている必要があります。3 つの回転
チャンネルがすべて同期化されていない場合、アニメーションが予期せぬ動作を
し、最終的にはクラッシュします。

カレントキャラクタに対するオプションウィンドウ（編集 > キー（Edit
> Keys）メニュー）のオプションが無効になる

キャラクタがカレントである場合、いくつかのオプションウィンドウにあるオ
プションは無効になります。これは、それらのオプションが無効になるのは、カ
レントキャラクタのすべてのアトリビュートで動作するからです。編集 > キー
（Edit > Keys）メニュー項目の下にあるいくつかの機能のオプションウィンド
ウが影響を受けます。

解決方法

カレントキャラクタをなし（None）に設定します。
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ゴースト化とシミュレーションオブジェクト

ゴースト化を、パーティクルシミュレーション、ソフトボディ、リジッドボ
ディ、クラシック Cloth、ジグルデフォーマなどのシミュレーションオブジェ
クトに適用しようとすると、予期せぬ結果が発生する可能性があります。

解決方法

シミュレーションのディスクキャッシュを作成してください。

IK ハンドルが制御するジョイント上の優先回転角

IK ハンドルが制御するジョイントチェーンでスケルトン > 優先回転角に設定す
る（Skeleton > Set Preferred Angle）を使っても効果が見られない

解決方法
■ ジョイントの優先回転角を設定してから、IK ハンドルを作成します。

■ IK ハンドルを削除後に「元に戻す」操作で復元すると、優先回転角を尊重し
た IK ソリューションが生成されます。

最上位キャラクタの削除

サブキャラクタを持つキャラクタを削除し、サブキャラクタは削除しなかった場
合、そのサブキャラクタは characterPartition の一部ではなくなるので、Maya
UI からは認識されなくなります。

解決方法

以下を入力して、characterPartition に最上位キャラクタになったキャラクタを
手作業で追加します。

partition -add characterPartition <subCharacterName>;

FBIK と自動キー

フルボディ IK で作業しているときに、キーイングモードをボディパーツや選
択項目に設定しているにもかかわらず、自動キーによりフルボディのキーが設定
されてしまいます。
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解決方法

フルボディ IK リグにボディパーツや選択項目のキーのみを設定するには、自動
キーを無効にしてキーを手動で設定する必要があります。

アニメーションカーブをエクスポートすると、インポートできないファ
イルが作成されます。

アウトライナ（Outliner）でアニメーションカーブを選択してからエクスポー
トすると（ファイル > 選択項目のエクスポート（File > Export Selected））、
インポートできないファイルが作成されます。これは、多くの場合、ルートレ
ベルのアニメーション、もしくは、固有の名前を持たない子オブジェクトのアニ
メーションのエクスポート時に発生します。

解決方法

アニメーションカーブとオブジェクトを両方選択してからエクスポートします
（ファイル > 選択項目のエクスポート（File > Export Selected））。

あるいは、animImportExport プラグインをオンにしてから（ウィンドウ > 設
定/プリファレンス > プラグイン マネージャ（Window > Settings/Preferences
> Plug-in Manager））、選択項目のエクスポート オプション（Export Selection
Options）ウィンドウでカーブを animExport ファイルとしてエクスポートしま
す。

アニメーションレイヤの注意事項と制限事項
Maya のアニメーションレイヤに関する注意事項と制限事項を次に説明します。

Maya と MotionBuilder レイヤの相互運用性

Maya のリリースと、FBX やその全プラグインの個別リリースをともに実現する
ために、Maya から MotionBuilder へのレイヤのエクスポートは現在のところ
Maya の FBX プラグインではサポートされていません。

Maya の FBX プラグインの詳細と FBX プラグインの最新リリースについては、
http://www.autodesk.co.jp/fbx を参照してください。
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アニメーションのプレイブラストの制限事項
Maya のプレイブラスト（Playblast）ウィンドウに関する制限事項と解決方法を
次に説明します。

プレイブラストから抜ける際の制限

プレイブラストから抜ける場合は、必ずサウンドトラック全体が記録されるま
で待ってください。

インポートした大きなオーディオファイルによるプレイブラストの遅れ

インポートした大きな .aiff オーディオファイルを含むシーンでは、プレイブラ
ストの再生時間が大幅に遅くなることがあります。たとえば、40MB の .aiff ファ
イルでは、最初のコマンドコールと再生との間に 20 秒以上の遅れが生じる可能
性があります。

解決方法

ロードしたすべてのオーディオファイルを（重なり合わないようにして）Trax
エディタ（Trax Editor）から表示および再生するか、1 つの大きなオーディオ
ファイルではなく複数の短いオーディオファイルを使用してください。

長い aiff ファイルとの同期化の問題

大きなネガティブオフセットでサウンドをプレイブラストしていると、オーディ
オ同期の問題が発生することがあります。

解決方法

オーディオファイルを短くして、大きなネガティブオフセットを使用しなくて
すむようにしてください。

ドープシートの制限事項
Maya でのドープシートに関する制限事項と解決方法について次に説明します。

ドープシートのマニピュレータが消える

ドープシートのマニピュレータを使用する際に、ドープシートでチャンネルを展
開したり折り畳んだりすると、マニピュレータが消えます。
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解決方法

選択をやり直して、マニピュレータを復元します。

ドープシートで、カット & ペーストのホットキーが編集 > コピー（Edit
> Copy）または編集 > ペースト（Edit > Paste）で設定したとおりに動
作しない

ドープシートのマニピュレータでカットのホットキー（デフォルト: Ctrl + x）
またはペーストのホットキー（デフォルト: Ctrl + v）を使用すると、それぞれの
ドープシートメニューオプションウィンドウで設定したとおりに動作しませ
ん。その代わり、アニメーションは常に削除または挿入された時間やキーに合わ
せてシフトされます。

グラフ エディタの制限事項
Maya のグラフ エディタに関する制限事項と解決方法を次に説明します。

グラフ エディタ（Graph Editor）でキーをコピー/ペースト

複数のアニメーションカーブがあるキーを複数のアトリビュートにカット &
ペーストする場合は、選択する順番に特に注意してください。これは、ペースト
の順番に影響するためです。

グラフ エディタ（Graph Editor）またはドープシート（Dope Sheet）で複数の
アトリビュートのキーをカットする場合、各エディタのアウトライナ（ビュー領
域ではなく）からアトリビュートを選択します。

Trax エディタの制限事項
Maya® Trax™ エディタに関する制限事項と解決方法を次に説明します。

キャラクタをマージするとクリップはコピーされるがクリップ間のブレ
ンドがコピーされない

解決方法

マージ後にブレンドを手動で復元してください。
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開始時間または終了時間が同じ Trax のクリップがジャンプすることがあ
る

Trax にある複数のクリップの開始時間または終了時間が同じ場合、クリップと
クリップの間にブレンドがあると、開始または終了時にクリップがジャンプしま
す。

解決方法

次のいずれかを実行します。

■ 最後のクリップの保持（Hold）値を変更し、再生時間を制御します。

■ ブレンドされたクリップで「マージ」を使用し、シングルクリップを作成し
ます。

■ ブレンドされたクリップの開始点、または終点に対応するポーズを作成し、
ブレンドされたクリップの直前または直後に、ポーズを Trax にドラッグ &
ドロップして、強制的にキャラクタがポーズを維持しつづけるようにします。

相対クリップの一番上にレイヤ化されたアニメーションを作成すること
ができない

解決方法

相対クリップをマージして絶対クリップと置き換え、この絶対クリップの一番上
にレイヤ化されたアニメーションを作成します。

特定のクリップ構成でブレンドが機能しない

絶対クリップの後が相対クリップで、その後で別の絶対クリップにブレンドされ
る場合、ブレンドの動作が正しく動作しない場合があります。

解決方法

最初の絶対クリップに保持クリップを作成し、相対クリップの最後にドラッグし
ます。これを 2 番目の絶対クリップとブレンドします。これで正しいアニメー
ションになります。
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アニメーションのフレームレートを変更すると Trax タイムワープとブ
レンドの問題が発生する

アニメーションのフレームレートを変更すると、Trax タイムワープとブレンド
カーブが正しくスケールされません。

解決方法

フレームレートの変更を補正するには、タイムワープやブレンドカーブをすべ
てスケールする必要があります。これらは常に 0 から 1 の範囲内であることが
前提となっていますが、フレームレートが変更されると、変更後のフレームレー
トに合わせてスケールされます。タイムレンジ内の 0 から 1 の範囲にあうよう
に、カーブをスケールしてください。

クロスオブジェクトを Trax キャラクタにペアレント化する

クロスオブジェクトが Trax キャラクタにペアレント化されていると、Trax エ
ディタでクロスが正しく評価されません。

解決方法

オブジェクトノードとクロスノードを選択し、メインキャラクタの階層からペ
アレント化解除します。クロスのキャッシュを削除し、シミュレーションを実行
します。

パスアニメーションの制限事項
Maya のパスアニメーションに関する制限事項と解決方法を次に説明します。

ジオメトリがフローラティスからはじきだされる

グループ化された複数のジオメトリを持つトランスフォームオブジェクトをパ
スアニメーションでアニメートしたあと、オブジェクトの周りをラティスで囲
んでフローを適用すると、一部のジオメトリがフローラティスから「はじき出
され」ます。
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解決方法

次のいずれかを実行します。

■ トランスフォームオブジェクトの下でグループ化されたすべてのジオメトリ
にフローラティスの効果が及ぶように、FFD のラティスの外側（Outside
Lattice）アトリビュートをすべて（All）に設定します。

■ フローの FFD のベースラティスを選択して少し拡大し、ジオメトリをフロー
ラティスの内部に収めてください。
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キャラクタセットアップ

キャラクタセットアップに関する一般的な制限
事項

Autodesk® Maya® での一般的なキャラクタセットアップに関する制限事項と解
決方法について次に説明します。

最上位のキャラクタセットを削除すると、Maya がサブキャラクタを認識
しなくなる

サブキャラクタを持つキャラクタを削除し、サブキャラクタは削除しなかった場
合、そのサブキャラクタはキャラクタパーティションの一部ではなくなるので、
Maya UI からは認識されなくなります。

解決方法

以下を入力して、characterPartition に最上位キャラクタになったキャラクタを手
作業で追加します。

partition -add characterPartition <subCharacterName>;

スケルトンとインバースキネマティクスの制限
事項

Maya のスケルトンとインバースキネマティクスに関する制限事項と解決方法を
次に説明します。
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ikSpline の高度なツイストアトリビュートは、X 軸の正方向のジョイン
トのみで有効

ikSpline ソルバの高度なツイストアトリビュートは、X 軸の正方向のジョイン
トのみを想定しています。

ジョイントの挿入ツール（Insert Joint Tool）が特定の角度で機能しない

ジョイントの挿入ツール（Insert Joint Tool）は、ジョイントピボットの表示が
オフで、カメラが特定の角度にタンブルされている場合は機能しません。

解決方法

ジョイントピボットの表示を有効にするか、カメラを少し移動します。

優先回転角に設定する（Set Preferred Angle）の制限事項

IK ハンドルが制御するチェーンのジョイント上でスケルトン > 優先回転角に設
定する（Skeleton > Set Preferred Angle）を使用しても効果が見られない

解決方法

ジョイントの優先回転角を設定してから、IK ハンドルを作成します。あるいは、
IK ハンドルを削除後に元に戻す操作で復元すると、優先回転角を尊重した IK ソ
リューションを取得できます。

スキニングの制限事項
Maya のスムーススキニングとリジッドスキニングに関する制限事項と解決方
法を次に説明します。

頂点のカラーのスキンウエイトの表示が NURBS またはサブディビジョ
ンサーフェスで動作しない

頂点のカラーのスキンウェイト表示（スムースバインドオプション（Smooth
Bind Options）ウィンドウのスケルトンのカラー化（Colorize Skeleton）オプ
ションで設定）は、ポリゴンオブジェクトのみでサポートされています。一方、
サーフェスのカラーのスキンウェイトはすべてのジオメトリタイプでサポート
されています。
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デフォーマ

デフォーマに関する一般的な制限事項
Autodesk® Maya®のデフォーマ（スキン以外のデフォメーション）に関する制限
事項と解決方法を次に説明します。

リファレンスファイルのターゲットブレンドシェイプの使用

リファレンスファイルからターゲットブレンドシェイプを使用して、ベースオ
ブジェクトをデフォームする場合、リファレンスがロードされていない状態でメ
インシーンを開くと、そのベースオブジェクトの位置が予期せぬ位置に変更され
る場合があります。特に、ロードされていないターゲットは、原点（Origin）ア
トリビュートがローカル（Local）に設定されている場合でも、原点（Origin）ア
トリビュートがワールド（World）に設定されているかのように処理されます。

解決方法

シーンを初めて開いて保存するときに、リファレンスファイルをロードします。
意図したとおりのベースオブジェクトの操作を選択して保持する場合、リファレ
ンスファイルをアンロードできます。

新規インフルエンスオブジェクトをスムーススキンに追加する

スムーススキンに新しいインフルエンスオブジェクトを追加しても、コンポーネ
ントエディタ（Component Editor）にすぐには表示されません。

解決方法

コンポーネントエディタを一度閉じてから再度開いてください。
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デフォーマでの変形後にオブジェクトの上流トポロジを変更した場合の
予期せぬ結果

デフォーマで変形後にオブジェクトの上流トポロジを変更すると、予期せぬ結果
が発生します。Maya でオブジェクトを変形する場合は、オブジェクトの一部の
コンポーネント（NURBS カーブ/サーフェスの CV、ポリゴン頂点、変形された
ラティスポイントなど）への参照が生成されます。

変形されたオブジェクトの上流トポロジ（すなわち、オブジェクトのコンポーネ
ントのうち、上記のようなリファレンスが生成されるコンポーネントの数）を変
更するには、いくつかの方法があります。例:

カーブのリビルド操作を実行すると、カーブの CV の数が変更され、
makeNurbSphere ノードのセクションまたはスパンのアトリビュートを変更す
ると NURBS サーフェスの CV の数が変化する可能性があります。また、ポリゴ
ン > スムース（Polygons > Smooth）操作を実行すると、スムースされたオブ
ジェクトのポリゴン頂点の数が劇的に変化する可能性があります。今のところ
Maya には、このような上流トポロジの変更を適切な方法で下流ノードに伝達す
る手段はありません。

解決方法

上流トポロジを変更するオブジェクトをデフォーマで変形する場合は次のように
操作します。デフォーマのデフォメーションセットからオブジェクトを削除し
たあとで、トポロジの変更操作を実行し、変更後のオブジェクトをデフォメー
ションセットに戻します。デフォメーションがクラスタで、変形率（%）を編
集していた場合は、オブジェクトのトポロジを変更したあとで、同じ編集操作を
繰り返す必要があります。

スキンとしてスケルトンにバインドしたオブジェクトの上流トポロジを変更する
場合は、次のように操作します。スケルトンからバインドを解除し、（スキン >
スキンのデタッチ（Skin > Detach Skin））、トポロジ変更操作を適用したあ
と、スキンを再バインドします（スキン > スキンのバインド（Skin > Bind
Skin））。この際、複製したオブジェクトにスキンウェイトをコピーしておけ
ば、トポロジ変更後のオブジェクトにスキンウェイト値をコピーしてウェイト
情報を維持することができます。

上流トポロジを変更するオブジェクトがワイヤカーブである（たとえば、ワイ
ヤデフォーマのインフルエンスオブジェクト）場合は、次のように操作します。
ワイヤデフォーマからカーブを削除してカーブのトポロジを変更したあと、カー
ブをワイヤデフォーマに戻します。
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この制限事項のその他の例
■ ラップの予期せぬ動作

ラップデフォーマとして使用するシェイプのフェース数や CV 数を変更すると、
予期せぬラップ動作が発生します。

解決方法

シェイプをインフルエンスオブジェクトとして削除し、その後、再度インフル
エンスオブジェクトとして追加します。これでラップのデータがリセットされ、
正常に動作するようになります。

■ デフォーマで変形されたオブジェクトの下流ノードの CV 数の変更

オブジェクトをデフォーマで変形後にその下流ノードの CV の数を変更すると、
オブジェクトの CV の移動、回転、スケールを正常に行うことができません。こ
の問題は、NURBS サーフェスにノットを追加または削除した場合や、ポリゴン
フェースや頂点を削除した場合に起こります。

解決方法

変形したオブジェクトのシェイプノードとツィークノード間のメッセージアト
リビュートのコネクションを切断します。これを行うには、シェイプノードを
選択してハイパーグラフ（Hypergraph）内にそのヒストリを表示します。ツィー
クノードとそのシェイプノード間のコネクションが表示されるはずです。この
コネクションを選択して Delete キーを押すと、コネクションが切断されます。

部分解像度（Partial Resolution）を設定したラティスによりターゲット
ジオメトリが歪む

ラティスデフォーマの部分解像度アトリビュートが原因で発生する精度の損失
により、ラティス変形させたジオメトリが大幅に歪むことがあります。

解決方法

ラティスデフォーマの部分解像度アトリビュートの値を小さくするか、全体解
像度（Full Resolution）を使用してください。
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ファーやモーションブラーと組み合わせて使用すると、ジグルデフォー
マが正確にチェックを行わない場合がある

解決方法

ジグルデフォーマを持つファーオブジェクトやモーションブラーのバッチレ
ンダリングでは、ジグルディスクキャッシュを作成する必要があります。

ジグルデフォメーション上でゴーストが不安定

解決方法

ジグルディスクキャッシュを作成すれば、通常はゴーストがジグルデフォメー
ションで正常に機能するようになります。
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NURBS モデリング

NURBS モデリングの制限事項
ベベル Plus（Bevel Plus）の制限事項

開始位置（At Start） がオフになっていると、エンドフェースが自身と交差した
場合、まれに望ましくない結果になることがあります。

解決方法

開始位置（At Start）をオン、終了位置（At End）をオフにして、ベベルのデプス
（Bevel Depth）と押し出す距離（Extrude Distance）を負の値に設定します（値
の前に「-」を付けてください）。必要に応じて、目的の結果が得られるようにオ
リジナルのカーブを変更します。

グループに対する NURBS からサブディビジョンサーフェスへの変換でエ
ラーが返される

NURBS オブジェクトのグループで修正 > 変換 > NURBS をサブディビジョンに
（Modify > Convert > NURBS to Subdiv）オプションを使用すると、次のエラー
が返されることがあります。

// エラー: 複数のオブジェクトが名前とマッチします（Error: More than one object

matches name）

解決方法

修正 > 変換 > NURBS をサブディビジョンに（Modify > Convert > NURBS to

Subdiv） を選択します。NURBS をサブディビジョンに（NURBS to Subdiv）
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ウィンドウで、オリジナルの維持（Keep Original）をオンに設定して作成
（Create）をクリックします。変換されたバージョンの NURBS グループがオリ
ジナルのグループの上に表示されます。オリジナルのグループを削除します。

Adobe Illustrator オブジェクトの作成の制限事
項

Illustrator のバージョンの互換性

Maya が互換性を持つのは Adobe Illustrator 8 のファイルのみです。他のバー
ジョンで作成された Illustrator ファイルをインポートしようとすると、予期せ
ぬ結果が起こるかもしれません。

解決方法

8 以外のバージョンの Illustrator で作業している場合は、ファイルを Illustrator
8 フォーマットに変換します。

Illustrator のファイルをインポートすると予期せぬ結果が起こる

インポートした Adobe Illustrator ファイルで、ポイントが急に離れたりその他
見慣れないジオメトリが表示されることがあります。

解決方法

この問題は、原点の位置を変更したり、Illustrator ファイルタイプを変更して
再インポートしたりすると、解消される場合があります。

Adobe Illustrator ファイルをインポートできない

内側のパスが外側のパスの後ろにある複合パスの場合、ファイルを Maya にイ
ンポートしようとすると、次のエラーメッセージが表示されます。

// Error: bevelPlus1 (Bevel Plus Node): Group 2 curve 4 is not inside

the previous curve. Group these curves appropriately in Adobe (R)

Illustrator (R)）

// エラー: ベベルの出力の作成に失敗しました（ Error: Failed to create bevel

output）
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解決方法

グループ化を修正して Adobe Illustrator ファイルのパスを合成する必要がある
ことがあります。以下の手順を実行します。

1 Adobe Illustrator でファイルを開きます。

2 複合パスを選択します。

3 [オブジェクト] > [複合パス] > [解除]を選択します。

4 外側のパスを選択します。

5 [オブジェクト] >[アレンジ] > [背面へ]を選択します。

6 両方のパスを選択します。

7 [オブジェクト] > [複合パス] > [作成]を選択します。

8 ファイルを保存し、Maya にインポートします。

Maya で何もインポートしない場合、作成 > Adobe Illustrator オブジェクト
（Create > Adobe Illustrator Object）操作を繰り返す必要があります。

ベベルされたテキストがレンダーしたときに正しくテッセレーションさ
れない

ワイヤフレームモードでは作成 > Adobe Illustrator オブジェクト（Create >
Adobe Illustrator Object）を使用して作成したサーフェスとベベル（Bevel）が
問題なく表示されるのに、シェーディングモードではうまく表示されないこと
があります。このようなサーフェスは、テッセレーションの精度が悪いため、
Maya では適切にレンダーされません。

mental ray では異なるテッセレーションのアルゴリズムを採用しているため、
mental ray でレンダリングを行うとこの問題をかなり改善できます。
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サブディビジョンサー
フェス

サブディビジョンサーフェスの制限事項
デフォーマセットのサブディビジョンサーフェス頂点メンバのウェイト
フィールドに何も表示されない

デフォーマセットのサブディビジョン（Subdivision）サーフェス頂点メンバの
ウェイトフィールド（cluster、skinCluster、または jointCluster）に何も表示さ
れないことがあり、新しいウェイト値を入力しても変化がありません。

解決方法

クラスタハンドルまたはジョイントを選択し、メンバーシップの編集ツール（Edit
Membership Tool）を使用してクラスタメンバを選択してください。コンポーネ
ント エディタ（Component Editor）を使用すると、クラスタメンバのウェイト
値が表示され、編集できるようになります。コンポーネント エディタウィンドウ
でリスト > 自動更新（List > Auto Update）をオフにした場合、表の先頭列にある
コンポーネントの名前をクリックすると、シーンビューでクラスタメンバが選択
され、識別できるようになります。

均等にスケールされていないサブディビジョンサーフェスを使用すると予
期せぬ結果が生じる

均等にスケールされていなくて階層的な編集がされているサブディビジョンサー
フェスでは、粗いメッシュのコンポーネント（ベースを含む）を回転したときに、
適切に動作しないことがあります。
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解決方法

スケールオプションを設定して修正 > トランスフォームのフリーズ（Modify >
Freeze Transformations）を使用し、問題のあるオブジェクトから均等ではない
スケールをなくします。

UV テクスチャエディタ（UV Texture Editor）でテクスチャ境界の UV 頂
点を選択する

UV テクスチャ エディタでテクスチャ境界上にある UV 頂点を選択すると、複数
の頂点が選択されることがある

UV テクスチャエディタ（UV Texture Editor）のトポロジのクリーニン
グで UV のディストーションが発生する

UV テクスチャエディタ（UV Texture Editor）でサブディビジョンサーフェス
のサブディビジョン サーフェス > トポロジのクリーニング（Subdiv Surfaces >
Clean Topology）オプションを使用すると、UV が歪む場合があります。

解決方法

サブディビジョンサーフェスを右クリックし、表示されるマーキングメニュー
からポリゴン（Polygon）を選択します。ハイパーグラフ階層（Hypergraph
Hierarchy）を開き、polyToSubdShape1HistPoly ノードを選択します。サブ
ディビジョン サーフェス > トポロジのクリーニング（Subdiv Surfaces > Clean
Topology）を選択します。

サブディビジョン UV に関連するファイルリファレンス

UV があるサブディビジョンサーフェスを含むファイルを参照すると、親ファイ
ルに UV の情報が含まれます。
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ポリゴンとゲーム

ポリゴンとゲームに関する一般的な制限事項
ポリゴンとゲームに関する一般的な制限事項と解決方法について次に説明します。

マニュアルの頂点ループまたはフェースループの選択に関する誤記

ポリゴンメッシュの頂点ループまたはフェースループの選択に関するマニュアル
では、手順 3 に「ループを向ける方向の隣接する頂点またはフェースをダブルク
リックする」と記載されています。実際には、Shift キーを押してからダブルク
リックします。

ヒストリのある Crease ノードがスムースメッシュのパフォーマンスに影
響を与えることがある

コンストラクションヒストリに折り目ノードが含まれている場合、スムース メッ
シュ プレビュー（Smooth Mesh Preview）モードで表示されているポリゴンメッ
シュへの編集のインタラクティブなパフォーマンスが悪影響を受けることがあり
ます。これはマウスの最初のクリック & ドラッグ操作から顕著です。

解決方法

ポリゴンメッシュのコンストラクションヒストリに折り目ノードが入らないよう
にしてください。または、頂点の編集を実行する前にコンストラクションヒスト
リを削除します。
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エッジループの挿入（Insert Edge Loop）とエッジループのオフセット
（Offset Edge Loop）ツール使用時のスナップ許容値

挿入とエッジ ループのオフセット ツールは、スナップ磁石（Snap magnets）
プリファレンス設定が 0 より大きい場合や、スナップ許容値（Magnet
tolerance）設定が大きい値（10 など）に設定されている場合に、選択したエッ
ジの終端にのみスナップします。

解決方法

スナップ許容値（Magnet tolerance）設定を小さい値にするか、スナップ磁石
（Snap magnets）設定を 0 にします。

共有されたフェースに反対方向にワインドする UV があると法線が反転
する

2 つのフェースを持つメッシュ上の UV マップで作業していて、その UV が反対
方向にワインドしながらもエッジを渡って共有されている場合、1 つのフェース
上の法線が、まるでフェースが真中で分割されてフリップしているかのように不
正に表示されることがあります。

解決方法

この問題が発生するシーンに対して、UV または共有されたエッジに沿った法線
の共有を解除して、問題を修正します。

インスタンスポリゴンメッシュを結合するとジオメトリが削除される場
合がある

結合（Combine）コマンドを使用して 2 つのインスタンスポリゴンメッシュを
結合すると、警告なしに、片方のポリゴンメッシュが削除されることがありま
す。この現象は、選択したポリゴンメッシュの 1 つのトランスフォームノード
のルートレベルから複数の DAG パスが出ている場合に起こります。

解決方法

この問題が発生する場合は、結合（Combine）オプションを使用する前に、コ
ピー（Copy）オプションを使用してポリゴンメッシュを複製します。
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コンストレイン選択機能でのシェルオプションで、ポリゴンシェルの代
わりに UV テクスチャシェルが選択される

Maya の旧バージョンでは、コンストレインを使用した選択機能（選択 > コンス
トレインを使用した選択（Select > Select Using Constraints））は、伝播オプ
ションがシェル（Shell）に設定されているときにポリゴンシェルを選択してい
ました。Maya 8.5 では、UV テクスチャシェルのみが選択されるようになりま
した。

解決方法

ポリゴンシェルを選択するオブジェクト上でコンポーネントを選択してから選
択 > 選択項目の変換 > UV シェルに（Select > Convert Selection > To UV Shell）
を選択して、選択項目を変換します。

異なるプラットフォームとバージョンで UV レイアウトが異なって表示
される

最近 Maya に行われた浮動小数点演算方式の変更により、UV シェルが計算され
る順序が変更されました。この結果、異なるハードウェアプラットフォームや
後続バージョンの Maya にファイルがロードされると、特に元の UV レイアウ
トが編集された場合に UV のレイアウトが異なって表示されることがあります。

解決方法

オリジナルのファイルのヒストリを削除してから、他のプラットフォームまたは
バージョンで開く前に保存します。

黒の頂点カラー値がコーナーの頂点に保存されない

ポリゴンメッシュのコーナー頂点に割り当てられた黒の頂点カラーは、ファイ
ルを保存したときに保持されません。後でファイルを開くと、メッシュ値のコー
ナー頂点の CPV 情報は白またはグレイで表示されます。

解決方法

コーナー頂点に黒い CPV 値を適用する必要がある場合は、0 ではなく、小さな
整数値を使用します（たとえば、0.01）。

選択したコンポーネントの順序が Maya で維持されない

グローバルセレクションリストでは、ポリゴンメッシュの頂点、フェース、
エッジの選択順序は保持されません。
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解決方法

選択した各コンポーネントを次のスクリプトを使用して配列に集め、その配列を
必要に応じて使用してください。

global proc selectProc() {

global string $gSelectedComponents[];

string $selC[] = `ls -sl -flatten`;

if (size($selC) > 0) {

int $match = 0;

for ($newSel in $selC) {

$match = 0;

for ($oneComponent in $gSelectedComponents) {

if ($newSel == $oneComponent) $match = 1;

}

if ($match == 0)

$gSelectedComponents[size($gSelectedComponents)] = $newSel;

}

}

else {

clear ($gSelectedComponents);

}

int $debug = 1;

if ($debug && (size($selC) > 0)) {

print ("Selected components (in the order) ...\n");

print ($gSelectedComponents);

print ("\n"); } } // to load the scriptJob

int $jobNum = `scriptJob -e "SelectionChanged" "selectProc"`; //

to unload the scriptJob scriptJob -kill $jobNum;

カラーセットエディタ（Color Set Editor）でブレンドウェイトが 0 ～ 1
の範囲に制限されている

カラー セット エディタのブレンド（Blend）オプションを使用してカラーセッ
トをブレンドすると、イメージをレンダリングするときに、ブレンドウェイト
が 0 ～ 1 の範囲に制限されます。つまり、1 を超えるブレンドウェイトの値は
最大値の 1 に切り捨てられます。これは、OpenGL のデフォルトレンダリング
パイプラインで既知の制限事項です。

58 | 第 11 章   ポリゴンとゲーム



シェーディングモードでポリゴンフェースが表示されない

オブジェクトにトランスフォームのフリーズ（Freeze Transformations）を実行
すると、「法線の反転」レンダリングオプションが自動的にオンになります。
つまり、バックフェースカリングモードで 3D ビューを表示すると、表側のポ
リゴンフェースが非表示になります。

ただし、ポリゴン表示オプションでバックフェースカリング（シェーディング
> バック フェース カリング（Shading > Backface Culling））をオンに設定する
と、バックフェースのポリゴンもカリングされます。オブジェクトが選択され
ていない場合、シェーディングモードではすべてのポリゴンフェースが非表示
になり、まるでオブジェクトが消えたように見えます。

cp アトリビュートの制限事項

ポリゴンオブジェクトでは、cp アトリビュートはローカル空間内の頂点の実際
の位置を、ポイント（pnts）アトリビュートはツィーク（tweak）値（ほかの頂
点との相対的なオフセット）を表します。

cp アトリビュートは、xv/yv/zv という名前の子アトリビュートを持つ複合アト
リビュートです。親アトリビュートの値を取得すると、誤ってポイントアトリ
ビュートと同じ値が返されます。

解決方法

cp 複合アトリビュート全体ではなく、xv/yv/zv の子アトリビュートを個別に使
用してください。

例:

polyCube; select -r pCube1.vtx[0] ; move -r .1 .1 .1; getAttr

pCube1.cp[0]; // Result: 0.1 0.1 0.1 // getAttr pCube1.cp[0].xv;

// Result: -0.4 // Real X position (-.5 + .1)

polySeparate コマンド

オブジェクトが非表示になっていると、polySeparate コマンドはエラーになり
ます。

この場合のエラーメッセージは次のように内容が正しくないことがあります。

Warning: polySeparate works only on polygonal objects.
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解決方法

オブジェクトを見える（表示）状態にしてください。

ブーリアンの操作で、頂点カラーとコンポーネントレベルのブラインド
データ情報が保存されない

Mesh > Booleans操作で、頂点カラーとコンポーネントレベルのブラインドデー
タ情報が保存されません。

複数のオブジェクトのエッジをフリップする

複数のオブジェクトのエッジを一度にフリップすると、クラッシュにつながりま
す。

解決方法

一度に 1 つのオブジェクトからエッジを選択し、フリップしてください。

ヒストリがなければポリゴンオブジェクトの頂点カラーのアニメーショ
ンが動作しない

モデリング/コンストラクションヒストリのない頂点カラーのアニメーション
は、ポリゴンオブジェクトに対しては動作しません。

解決方法

たとえば、実際には何も移動していないコンポーネントの移動操作のように、無
難なコンストラクションヒストリを使用します。

ラミナ（Lamina）フェースと非多様体ジオメトリを削除するとクリーン
アップで予期せぬ結果が生じる

クリーンアップ（Cleanup）を使用するときに、非多様体ジオメトリの削除とラ
ミナフェースの削除を組み合わせると、予期せぬ結果が生じることがあります。

解決方法

最初に、ラミナフェースをクリーンアップします。多くの場合、これで非多様
体ジオメトリも除去されます。
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MfnMesh の制限事項

MFnMesh::assign UVs()メソッドは、ヒストリを正式にサポートしていません。
ヒストリがオブジェクトをリビルドすると、結果として UV が削除されることが
あります。

MFnMesh::create UVSet() メソッドは、MFnMesh がメッシュデータを使用し
ていると動作しません。

アトリビュートの転送（Transfer Attributes）用のエンベロープ
（Envelope）アトリビュート

エンベロープ アトリビュートはアトリビュートの転送でサポートされていませ
ん。

ユーザ定義の法線がスキンポリゴンメッシュで無視される

ユーザ定義の（ロック）法線は、続けてスキンする場合、均一にスケールしない
ポリゴンメッシュ上で無視されます。

解決方法

スキニングの前にポリゴンメッシュ上でトランスフォームをフリーズします。

ソフト選択により 180 度回転した UV がフリップする

ソフト選択（Soft Selection）がオンのときに、頂点セットを 180 度回転させよ
うとすると、選択範囲がフリップして正負反転します。

解決方法

選択した頂点をより小さく、細かく回転させます。

英語版キーボード以外でのツィークモードのホットキーの問題

英語版以外のキーボードでは、ツィーク モード（Tweak mode）のホットキー
（`）は動作しません。

解決方法 1

移動ツール（Move Tool）設定のツィーク モード（Tweak mode）オプション
でツィーク モード（Tweak mode）のオンとオフを切り替えます。
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解決方法 2

1 ウィンドウ > 設定/プリファレンス > ホットキーエディタ（Window >
Settings/Preferences > Hotkey Editor）を選択します。

2 ホットキー エディタ（Hotkey Editor）のカテゴリ（Categories）の下にあ
る修正（Modify）を選択します。次に、コマンド（Commands）の下にあ
る STRSTweakModeOn を選択します。

3 新しいホットキーの割り当て（Assign New Hotkey）でキーを入力します。
ただし、修飾キーは入力しません。

注:  Maya のデフォルトのホットキーに影響を与えたくない場合は、この値
を「9」キーに設定します。

4 方向（Direction）をプレス（Press）に設定します。

5 割り当て（Assign）をクリックします。

6 コマンド（Commands）の下の STRSTweakModeOff を選択します。

7 同じ情報を使用して手順 3 ～ 5 を繰り返します。ただし、手順 4 では、方
向（Direction）をリリース（Release）に設定します。

解決方法 3

Maya を使用するキーボードを英語（US）版 IME に設定します。詳細について
は、オペレーティングシステムのマニュアルを参照してください。

このレイアウトを記憶（Remember This Layout）オプションは、コンポー
ネントエディタ（Component Editor）のポリゴン（Polygons）タブで使
用できない

コンポーネント エディタ（Component Editor）で作業するときに、オプション
> このレイアウトを記憶（Options > Remember This Layout）オプションはポ
リゴン（Polygons）タブと 詳細ポリゴン（AdvPolygons）タブでは使用できま
せん。

エッジで選択項目のコンストレイン角度が機能しない

エッジを選択してから選択項目のコンストレイン（Selection Constraint）ウィ
ンドウ（選択 > コンストレインを使用した選択（Select > Select Using
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Constraints））で修正しようとしても、選択項目は制御できない状態のままで
す。

解決方法

スクリプトエディタに以下のスクリプトをコピー & ペーストして実行します。
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import maya.OpenMaya as OpenMaya

import math

def selectEdgesByAngle(angle):

cosangle = math.cos(math.radians(angle))

edgesToSelect = OpenMaya.MSelectionList()

selection = OpenMaya.MSelectionList()

OpenMaya.MGlobal.getActiveSelectionList( selection )

iter = OpenMaya.MItSelectionList ( selection, OpenMaya.MFn.kMesh

)

while not iter.isDone(): edgeArray = OpenMaya.MIntArray()

dagPath = OpenMaya.MDagPath()

iter.getDagPath( dagPath )

mObj = OpenMaya.MObject()

iter.getDependNode( mObj )

meshFn = OpenMaya.MFnMesh(dagPath)

edgeIter = OpenMaya.MItMeshEdge( mObj )

while not edgeIter.isDone():

status = OpenMaya.MStatus

connectedFaceIds = OpenMaya.MIntArray()

edgeIter.getConnectedFaces(connectedFaceIds)

if connectedFaceIds.length() != 2:

edgeArray.append(edgeIter.index())

else:

normal1 = OpenMaya.MVector()

normal2 = OpenMaya.MVector()

meshFn.getPolygonNormal(connectedFaceIds[0], normal1)

meshFn.getPolygonNormal(connectedFaceIds[1], normal2)

dotProduct = normal1 * normal2

if dotProduct <= cosangle:

edgeArray.append(edgeIter.index()) edgeIter.next() compList =

OpenMaya.MFnSingleIndexedComponent()

components = compList.create( OpenMaya.MFn.kMeshEdgeComponent )

compList.addElements( edgeArray )

edgesToSelect.add( dagPath, components )
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iter.next()OpenMaya.MGlobal.setActiveSelectionList( edgesToSelect

)

このスクリプトの実行後、エッジを選択して以下のコマンドを実行します。

selectEdgesByAngle.selectEdgesByAngle(30)

目的の角度には 30 を使用しています。

ポリゴンとゲームに関する一般的な制限事項 | 65



66



アーティザン、3D ペイン
ト、ペイントエフェクト

アーティザンの制限事項
アーティザンに関する制限事項と解決方法について次に説明します。

頂点カラーペイントツール（Paint Vertex Color Tool）

頂点とは対照的に、頂点フェースをペイントする場合には、マップのインポート
とエクスポートは使用できません。

アーティザンツールのカラーフィードバック
■ トリムしたサーフェスでは、アーティザンツールは正常に機能しますが、カ

ラーフィードバックは表示されません。

NURBS サーフェスからのアトリビュートマップのエクスポート

次数を 3 以外に指定した場合、NURBS サーフェスのアトリビュートマップはエ
クスポートされません。

サブディビジョンエッジセレクションマップのインポート

サブディビジョンエッジセレクションマップのインポートは機能しません。

解決方法

頂点としてインポートし、選択してエッジに変換します。

12
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3D ペイントツールの制限事項
3D ペイントツールに関する制限事項と解決方法について次に説明します。

レイヤシェーダに割り当てられたテクスチャにペイントできない

レイヤシェーダに割り当てられたテクスチャにペイントすることはできません。

大きなテクスチャで 3D ペイントが遅くなる

1K x 1K より大きいイメージの編集時にパフォーマンスが大幅に低下する場合、
その解像度でテクスチャを表示するのにビデオカードのメモリ不足が原因であ
る可能性があります。

解決方法

プリファレンス（Preferences）ウィンドウ（ウィンドウ > 設定/プリファレンス
> プリファレンス（Window > Settings/Preferences > Preferences））のディ
スプレイ（Display）カテゴリにあるテクスチャ表示の最大解像度（Maximum
Texture Display Resolution）を設定することによって、表示に使用するテクス
チャの最大サイズを固定することができます。この設定を有効にするには、
Autodesk® Maya® を再起動することをお勧めします。

テクスチャ配置

3D ペイントツールでは、テクスチャ配置パラメータに対する変更はすべて無視
されます。

解決方法

ハイパーシェード（Hypershade）で編集 > ファイルテクスチャに変換（Edit >
Convert to File Texture）を使って、テクスチャ配置が変更されたテクスチャを
ファイルテクスチャに変換し、変換後のテクスチャにペイントします。

高速操作（Fast Interaction）を使ってペイントする

ディスプレイ > 高速操作（Display > Fast Interaction）がオンの場合、3D ペイ
ントツールは動作しません。

解決方法

ペイント中は高速操作をオフにします。
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ペイントエフェクトの制限事項
ペイントエフェクトに関する制限事項と解決方法について次に説明します。

Linux でペイントエフェクト（Paint Effects）が更新されない

Linux で、ペイント エフェクト（Paint Effects）パネルを開いたときまたは初期
化した直後にシーンに適用した最初のストロークがペイントエフェクト（Paint
Effects）ストロークの場合、ビューポートに表示されません。またシステムベ
ル音はしますが、警告メッセージは表示されません。

解決方法

シーンをタンブルするなどしてビューポートをリフレッシュすると、ペイント
エフェクトストロークが意図したとおりにビューポートに表示されます。

セルフシャドウとディレクショナルライト

ペイントエフェクトをディレクショナルライトでレンダリングすると、セルフ
シャドウが正しく計算されないことがあります。

解決方法

ディレクショナルライトを幅の狭いスポットライトに置き換えて、シーンのオ
ブジェクトから十分に遠ざけて配置し、一方向から効果的にライトを照らすよう
にします。

ライティングベースの幅（Lighting Based Width）がトゥーンラインの
ペイントエフェクトブラシに割り当てられない

ペイントエフェクトブラシをトゥーンラインに割り当てると、ライティング
ベースの幅（Lighting Based Width）アトリビュートがペイントエフェクトブ
ラシに対して設定されません。

解決方法

ライティング ベースの幅（Lighting Based Width）アトリビュート（ブラシの
アトリビュート エディタのイルミネーション（Illumination）セクション内）を
トゥーンラインのライティング ベースの幅（Lighting Based Width）の値に設
定します。
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pfxStrokes MEL コマンドがトゥーンノードでサポートされない

pfxStrokes MEL コマンドがペイントエフェクトトゥーンオブジェクトのプロ
ファイルカーブを出力しません。

解決方法

修正 > ペイント エフェクトをカーブに変換（Modify > Convert Paint Effects to
Curves）を選択して、トゥーンオブジェクトを NURBS カーブに変換します。
変換した NURBS カーブで pfxStrokes MEL コマンドを実行します。

ストローク自体にトランスフォームが適用されたペイントエフェクトの
ストロークは、6.5 と 7.0 で見え方が異なることがある

7.0 以前のバージョンでは、ビュープレーンにペイントされたストロークを回転
したとき、法線の使用がオンに設定され、ストロークがストロークの法線に依存
する場合には、ストロークが正しく描画されないことがありました。トランス
フォームしたストロークの描画の問題を解決するために、ペイントエフェクト
ブラシのアトリビュートを調整した旧バージョンのファイルがある場合、これら
のストロークは 7.0 では異なって表示される場合があります。サーフェスにペイ
ントされたストロークの場合は、この問題はないはずです。

解決方法

情報が残っていれば、問題解決のために調整したアトリビュートを再調整しま
す。情報がない場合は、6.5 でストロークをポリゴンに変換し、ヒストリを削除
して正確にマッチさせることができます。また、ストロークノードの法線を修
正すると、7.0 以前のストロークの感じに合わせるのに役立つ場合があります。

pfxstrokes コマンドの出力でカンマが失われる

pfxstrokes コマンドのファイル出力は、失われたカンマを追加するよう Maya
7.0 で修正されました。このカンマの位置は、pfxHair ノードの法線 Z 値の後で
す。

解決方法

Maya 6.5 以前のバージョンで作成されたユーザスクリプトで、以前この失われ
たカンマに対処していた場合は、更新が必要となります。
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ペイントエフェクトブラシ設定（Paint Effects Brush Settings）ウィンド
ウのカラーボックスのポップアップメニュー

ペイントエフェクトブラシ設定ウィンドウにはさまざまなカラースライダア
トリビュートがあり、この上で右クリックすると、ポップアップメニューを表
示することができます。このメニューに表示される項目の中で機能するのはカ
ラーチューザ（Color Chooser）項目だけです。その他のメニューにより、カ
ラー値の動作が変更されることはないので、これらのメニューは無視されます。

ペイントエフェクトのメッシュブラシ

メッシュブラシを使用したペイントエフェクト三角形の補間は、三角形の数が
少ない歪んだテクスチャになる場合があります。

解決方法

ブラシの三角形の密度を増やすか、ペイントエフェクトストロークをポリゴン
に変換してレンダリングします。

フィルムフィットがペイントエフェクトに悪影響を及ぼす

解決方法

フィルムのアスペクト比を xres/yres またはレンダー設定（Render Settings）
ウィンドウのデバイスアスペクト比（Device Aspect Ratio）の値と同じに設定
します。フィルムのアスペクト比を高くし過ぎないように（サンプルファイル
の値は低過ぎます）してください。アスペクト比が高すぎるとパースビューが
変わってしまいます。

ブラシスプリングがあるストローク名の変更

ペイントエフェクトストロークにブラシスプリングがありそのブラシ名を変更
すると、スプリングが正しく機能しなくなる可能性があります。

解決方法

ブラシ名を元に戻す、または、エクスプレッションを編集して新しいブラシ名を
参照するようにします。
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インタラクティブパフォーマンス設定とストロークの再描画

ペイントエフェクトのパフォーマンス設定（Performance Settings）がインタラ
クティブ（Interactive）に設定されている場合に、再生直後に、選択したスト
ロークやブラシを更新してもストロークが再描画されないことがあります。

解決方法

他のオブジェクトを選択してからストロークを選択し直してください。これでイ
ンタラクティブに更新できるようになります。

ライトフォグによってストロークが白をレンダリングする

ライトフォグによってペイントエフェクトのストロークが白をレンダリングし
てしまいます。

解決方法

シーンのライトにライトフォグがある場合には、ライトによる照射
（Illuminated）がオンになっているすべてのブラシの実際のライト（Real
Lights）をオフにします。

再生中にタービュランスが機能を停止する

一旦オフにすると、タービュランスが再生中のペイントエフェクトのストロー
クで機能しなくなります。

解決方法

アトリビュートエディタ（Attribute Editor）でフローアニメーション（Flow
Animation）ブロックを開いてください。

メッシュと細線によるペイントエフェクトのキャンバスラッピング

ブラシタイプが細線またはメッシュのペイントエフェクトブラシでは、シーン
またはキャンバスのラップがオンのときにはラップは行われません。

IPR でのストロークシャドウ

IPR でペイントエフェクトのストロークは表示されないが、シャドウが表示さ
れてしまいます。
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解決方法

シャドウが表示されないようにするには、レンダリングを行う前にストロークを
非表示にしてください。

ライトリンク

ペイントエフェクトでは、ライトのリンク機能はサポートされていません。

フィールドレンダリング

ペイントエフェクトでは、フィールドレンダリングはサポートされていません。

解決方法

フレーム間隔（By Frame）の値を 0.5 に設定してレンダリングし、合成パッケー
ジでインタレースしてください。

フレームのエッジ近くでのポップ

フレームのエッジ付近にストロークがあると、ペイントエフェクトレンダリン
グが「ポップする（急に動く）」ことがあります。

解決方法

この問題は、スタンプの密度と透明度を上げると、解決されることがあります。

スケールされたオブジェクトとストロークのジャンプ

非常に大きく拡大されたオブジェクトでは、サーフェスのアイソパラムライン
と交差したときに、ペイントエフェクトのストロークが「ジャンプ」すること
があります。

解決方法

この問題を回避するには、オブジェクトにトランスフォームのフリーズ（Freeze
Transformations）コマンドを適用します。

Z アップ環境

Z アップ環境ではペイントエフェクトで予期せぬ結果が生じます。
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解決方法

環境を Y アップに設定し、Maya を再起動します。

トランスフォームのフリーズ（Freeze Transformations）

トランスフォームのフリーズはペイントエフェクトのストロークでは動作しま
せん。

トランスフォームと単位

単位がセンチメートルに設定されていない場合、ペイントエフェクトで予期せ
ぬトランスフォーム結果が生じることがあります。

スクリプトの再生

圧力の値や設定のように、ストローク作成時に自動的に設定されたパラメータ
は、ストロークコマンド自体の引数ではありません。したがって、スクリプト
を再生しても、結果は作成したものとまったく同じにはなりません。

スクリーンスペース幅（Screenspace Width）オプションの変更

木などのオブジェクトのスクリーンスペース幅をオンにすると、木のサイズが
シーンのスケールではなく、キャンバスのスケールを基準にスケールされるよう
になります。

解決方法

キャンバスのスケールをシーンのスケールと同じ値に設定したあと、チューブ
（大枝、小枝、葉、花などを含む）の幅を必要な値に変更してください。

ペイントエフェクトキャンバスでの 3D Paint Tool（3D ペイントツール）
テクスチャの変更

ペイントエフェクトキャンバスを使用して、3D ペイントツールで作成された
テクスチャマップを編集しようとすると、ファイルテクスチャが正しく更新さ
れないことがあります。

解決方法

シーンを保存してから、ペイントエフェクトキャンバスでテクスチャの編集を
試みてください。
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最新のブラシストロークの描画が数ピクセルずれる

ペイントエフェクトを使用すると、一部のグラフィックスカードで、最後のス
トローク操作の再描画が数ピクセルずれることがあります。

解決方法

Maya を起動する前に、環境変数 MAYA_RENDERVIEW_USE_TEXTURES を 1
に設定してください。これによって、通常の glDrawPixel コールの代わりに
OpenGL テクスチャコールを使ってストロークを描画できるようになります。

パーティクルクラウドとペイントエフェクトストロークが混ざらない

ペイントエフェクトストロークでパーティクルクラウドエミッタを作成する
と、ストロークは前面に配置されたクラウドシェイプによって切り取られます。

解決方法

パーティクルクラウドを別途合成してください。

mental ray for Maya での 3D ペイントに関する問題

3D ペイントでテクスチャをペイントする際に、mental ray for Maya で新しい
ペイントストロークが自動では検出されません。

解決方法

mental ray でレンダーする前に、ペイントしたテクスチャまたはシーン全体を
保存しておき、すべてのストロークが正しくレンダーされるようにします。
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ダイナミクス

ダイナミクスの制限事項
エクスプレッションに rand()を使用すると、パーティクルシステムはディ
スクキャッシュと非ディスクキャッシュとで異なる結果を得ることがあ
る

解決方法

ランダムな数をシードします。たとえば、if(frame < 2) seed(1) など。

シーンを保存したあとにリジッドボディの再生結果が異なる

リジッドソルバに伴って生じるサイクルが、異なる評価順序の原因となります。
この問題は、サイクルの DG 評価順序に関係します。

解決方法

リジッドボディを含むシーンを保存する前に、次のことを行います。

1 ソルバ > メモリのキャッシング > 削除（Solvers > Memory Caching >
Delete）を選択します。

2 ソルバ > メモリのキャッシング > 無効化（Solvers > Memory Caching >
Disable）を選択します。
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インタラクティブ再生の制限事項

インタラクティブ再生は現在、パッシブリジッドボディでは機能しません。た
とえば、ソルバの再生中にパッシブリジッドボディを動かしても、アクティブ
リジッドボディはオリジナルの位置でしかパッシブリジッドボディと衝突しま
せん。

トリムサーフェスからのパーティクル放出が設定されているとき新しい
穴が反映されない

トリムサーフェスからパーティクルを放出している場合、サーフェスのトリム
を追加したり解除したりしても、放出に新しい穴が反映されません。

解決方法

このエミッタに関連付けられた geoConnector ノードをコールして、テッセレー
ションの値を少しだけ変更（たとえば、200 から 201 に）してください。これ
によって、テッセレーションが再設定され、新しいトリムが正確に取得されま
す。

パッシブにキーフレーム設定されたリジッドボディをリセットしても正
しくアクティブにできない

トランスフォームを固定しないと、パッシブにキーフレーム設定されたリジッド
ボディをリセットしても、正しくアクティブにすることはできません。

解決方法

最初にオブジェクトをモデリングし、修正 > トランスフォームのフリーズ
（Modify > Freeze Transformations）を選択してアクティブ/パッシブキーを設
定してから、最後にフィールドを追加します。

単位がセンチメートルではない場合は、フローエフェクトとカーブフ
ローは機能しない

解決方法

シーンの単位をセンチメートルに設定し、新規シーンを作成してから、オリジ
ナルのシーンを再度開きます。
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パーティクルエクスプレッションでファイルリファレンスがサポートさ
れない

解決方法

パーティクルエクスプレッションをメインファイルに入力します。

フィールドやエミッタでパーティクル位置を変換できない

フィールドやエミッタにより、パーティクル位置を標準以外の単位で変換するこ
とはできません。

解決方法

標準の単位を使用します。

パーティクルが作成時に衝突することがある

サーフェスエミッタがコリジョンオブジェクトでもある場合、パーティクルは
作成時に衝突します。

解決方法

サーフェス放出の法線スピード（normal speed）パラメータを反転します。

回転ピボットとインスタンス化

インスタンスは、基になったノードの回転ピボットと異なるピボットを持つこと
ができません。

解決方法

scripts/unsupported ディレクトリ（Maya のメインインストールディレクトリ
の下）にある createInstancerPivot.mel スクリプトを参照してください。使用の
手引きが記載されています。

モーションブラーがある場合のハードウェアレンダリングの制限事項

モーションブラーを適用したパーティクルは、マルチパスオプション値がモー
ションブラー値よりも高い場合にのみ、ハードウェアレンダリングされます。

完全に等しい 2 つのリジッドボディが衝突しない

上下に重なった 2 つの等しいリジッドボディは衝突しない場合があります。
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解決方法

いずれかのリジッドボディを少しだけスケール、回転、または移動させてくだ
さい。

リジッドボディで非平面ポリゴンが認識されない

解決方法

認識されない非平面ポリゴンを三角化してください。

リジッドボディ/リジッドコンストレインの関係のコピー

リジッドボディ/リジッドコンストレインをコピーすると、コピーされたコンス
トレインとコピーされたリジッドボディが関連付けられません。

解決方法

編集 > 複製（Edit > Duplicate）オプションウィンドウで、入力グラフの複製
（Duplicate Input Graph）をオンに設定してください。

パーティクルシミュレーション、ソフトボディ、リジッドボディなど
のシミュレーションオブジェクトでゴーストが不安定

パーティクルシミュレーション、ソフトボディ、リジッドボディ、クラシック
Cloth、ジグルデフォーマなどのシミュレーションオブジェクトでゴーストが
不安定になります。

解決方法

シミュレーション用のディスクキャッシュを作成すれば、通常はゴーストがオ
ブジェクト上で機能するようになります。

emit コマンドを使ってパーティクルを放出したときに、パーティクルが
正しく評価されない場合がある

この問題動作は、エクスプレッションが実行されていない、または Maya がバッ
チモードやプロンプトモードで、不適切な量のパーティクルを得た結果として
起こる場合があります。
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解決方法

イベントが起こると予測される順序に従って、count アトリビュートで getAttr

を起動します。getAttrは、各フレームで 1 回限りは MEL スクリプトまたは通
常のエクスプレッション内からコールすることができます。

ソフトボディのポリゴントポロジを変更すると、エラーメッセージが
表示される

ソフトボディにしたあと、（上位のコンストラクションヒストリを編集して）
ポリゴンオブジェクトのトポロジを変更すると、エラーメッセージが表示され
ます。

解決方法

ソフトボディの作成前にコンストラクションヒストリを必要に応じて調整する
か、または変更後ソフトボディを削除して再作成します。

ダイナミクスと .mi のエクスポート

インタラクティブに .miにエクスポートすると、ダイナミクスで正しい結果が
得られない可能性があります。

解決方法

次のいずれかを実行します。

■ カレントフレームまでシーンを手動で進めてエクスポートする

■ .miへバッチでエクスポートする

ダイナミクスの制限事項 | 81



82



レンダリング

レンダリングに関する一般的な制限事項
その他のいろいろなレンダリングに関する制限事項と解決方法について次に説明
します。

レンダリング関連マニュアル内のパスの誤り

トピック「コマンド ラインからレンダー」に、Maya Terminal.term が
/Applications/Autodesk/maya2009/Maya.app/Contents/bin/MayaENV.shの環
境をセットアップする単純な Bourne シェルスクリプトを提供するという記述が
あります。

この正しいパス
は、/Applications/Autodesk/maya2010/Maya.app/Contents/bin/MayaENV.sh

です。

mayabatch -render コマンドをサポートしていない

Windows 上の mayabatch -renderフラグ（Linux/Mac OS X 上では maya

-render）はサポートされなくなり、削除されました。代わりに Render -r コマン
ドを使用してください。

Mac OS X 上の Maya からのバッチレンダリングがコンソールと
mayaRender.log に書き出される

Mac OS X プラットフォームでは、Maya 内からバッチレンダリングを行った場
合、出力はコンソールアプリケーションに送信されると同時に mayaRender.log

という名前で ~/Library/Logs/Maya にログされます。
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バッチレンダープロセスが完了時に終了しない

Maya でバッチレンダーを起動して完了後に別のバッチレンダーを起動すると、
現在のレンダーをキャンセルするかどうかを尋ねるメッセージが表示される場合
があります。最初のバッチレンダーが確実に完了している場合は、はい（yes）
を選択します。

開始フレーム（Start frame）/終了フレーム（End frame）/フレーム間
隔（By frame）の各値がレンダラの切り替え時に破損する

レンダー設定: 共通（Render Settings: Common）タブで、開始フレーム（Start
frame）、終了フレーム（End frame）、フレーム間隔（By frame）の各値にプ
リファレンスを設定すると、レンダラの切り替え時にこれらの値が破損する場合
があります。

従来のシーンでフェース単位の割り当てとマテリアルのオーバーライド
を使用してレンダーレイヤを切り替えると、コネクションエラーが発生
する

フェース単位の割り当てとマテリアルのオーバーライドを使用して従来のシーン
でレンダーレイヤを切り替えると、エラーが発生してマテリアルの割り当てが
正しく表示されない場合があります。この問題を解決するには、
fixRenderLayerOutAdjustmentErrors.melスクリプトを次のように実行しま
す。

1 スクリプト エディタ（Script Editor）を開き、ファイル > ソース スクリプ
ト（File > Source Script）を選択します。インストールディレクトリ
\scripts\othersから fixRenderLayerOutAdjustmentErrors.melを選択
します。

2 Maya で MEL コマンド入力ラインに fixRenderLayerOutAdjustmentErrors

と入力します。

Mac OS X プラットフォームの立体視サポート

立体視機能は、Mac OS X 10.5.6 以降のみでサポートされています。

Windows と Mac OS X で水平インタレースモードが反転している

Windows と Mac OS X プラットフォームでは、立体視カメラの水平インタレー
スモードで描画される走査線の方向が反転しています。
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解決方法

コマンドラインに以下のコマンドを入力します。

stereoCameraView -e -swapEyes StereoPanelEditor;

この操作によってすべての立体視カメラモードの視点が入れ替わるため、後で
コマンドをもう一度実行して以前の状態を復元する必要があることに注意してく
ださい。

Windows Vista で 4 つのバッファを持つ立体視を作成するときにビデオ
カードが Basic モードに切り替わる

Windows Vista で 4 つのバッファを持つ立体視を作成するときに、ビデオカー
ドドライバが Aero から Basic に切り替わります。

Maya でレンダーした PSD ファイルを PSD ファイルテクスチャで読み取
ることができない

レイヤ付きの PSD ファイルをレンダーしてから Maya に PSD ファイルテクス
チャとしてロードしようとすると、黒のテクスチャが生成されます。

解決方法

テクスチャのレンダー時に、レイヤ付き PSD（PSD Layered）ではなく PSD を
使用します。

ライブコントロールが Live モード以外では動作しない

ライブコントロールが動作しない場合は、Maya Live モードに切り替えてくだ
さい。

レンダリングのワークフローに関する問題

プラグインライトを使用したライトリンク

プラグインライトを使用したライトリンクに関しては、いくつかの制限があり
ます。

■ プラグインライトはライト リンク エディタ（Light Linking Editor）とリ
レーションシップ エディタ（Relationship Editor）では表示されません。

■ プラグインライトに対しては、lightLink コマンドの照会オプションが機能
しません。このため、ライティング/シェーディング > ライトが照らすオブ
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ジェクトの選択（Lighting/Shading > Select Objects Illuminated by Light）
またはライティング/シェーディング > オブジェクトを照らすライトの選択
（Lighting/Shading > Select Lights Illuminating Objects）を選択すると、
エラーが発生します。

ライト リンク エディタ（Light Linking Editor）とライトの削除

使用中のライトを削除すると、ライト リンク エディタの動作が混乱して、次の
ようなエラーメッセージが表示される場合があります: 「エラー: 名前とマッチ
するオブジェクトがありません: directionalLight1」（「Error: No object matches
name: directionalLight1」）。また、ライトの削除操作を元に戻す（Undo）
と、ライトの選択状態が誤って表示される場合があります。

解決方法

モデリングビュー内の全オブジェクトの選択を解除して、ライトリンクエディ
タをクリアしてください。

Maya ソフトウェアレンダリングの制限事項
その他のいろいろなソフトウェアに関する制限事項と解決方法について次に説明
します。

パッチ単位のシェーディング割り当て

現在、ソフトウェアレンダリングにおいて、パッチ単位のシェーディング割り
当ては適用されません。

-optimizeRender フラグを使用する場合の最適化されたシーンファイル
の場所

-optimizeRender フラグを使用している場合、最適化されたシーンファイルは、
プリファレンスまたはMAYA_PROJECT環境変数で定義された、現在のプロジェ
クトを基準にした場所に作成されます。

解決方法

最適化されたファイルを作成する場所への絶対パスを指定します。
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レイトレースシャドウがペイントエフェクトでサポートされていない

レイトレースシャドウはペイントエフェクトでは機能しません。

解決方法

ペイントエフェクトオブジェクトをポリゴンに変換します。

mental ray for Maya レンダリングの制限事項
mental ray for Maya のソフトウェア上の制限事項と解決方法について次に説明
します。

mental ray がハイパースレッディングの影響を受ける

Intel CPU は、実際には単一の物理 CPU 上で実行している追加の論理プロセッ
サをシミュレートする、ハイパースレッディング機能を提供しています。この機
能は、mental ray のような並列実行で追加プロセッサを利用するアプリケーショ
ンのアクセラレートを目的としています。ただし、ハイパースレッドは物理的な
プロセッサのようなパフォーマンス向上があるわけではなく、15 ～ 25% 程度の
向上で、わずかまたは目に見えないことがあります。

解決方法 1

mental ray を使用する際には、ハイパースレッドをオフにします。

解決方法 2

スレッドの自動レンダー（Auto Render Threads）を無効にして、レンダース
レッドの数を手動で設定します。

IPR と mental ray for Maya レンダリング、およびアニメーションパラ
メータ

IPR（Interactive Photorealistic Rendering）を使用する場合、mental ray for
Maya は、タイムスライダの変更も含め、アニメーションパラメータを更新し
ません。
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mental ray for Maya の IPR の制限事項

現在、mental ray for Maya の IPR は以下をサポートしていません。

■ LOD カメラの更新

■ ホットキー 3 を使用するスムースメッシュプレビュー

シャドウ方法（Shadow method）がデフォルトで簡易（Simple）に設定
されており、ボリュームエフェクトと互換性がない

mental ray のレンダー設定（Render Settings）ウィンドウの精度（Quality）
タブにあるシャドウ方法（Shadow Method）は、デフォルトでは簡易（Simple）
に設定されています。簡易シャドウは流体、ボリュームファー、パーティクル、
ボリュームシェーダなどのボリュームエフェクトと互換性がないため、シャド
ウのボリュームエフェクトが正しくレンダリングされないことがあります。

問題への対処法

シャドウ方法のセグメント（Segments）を使用します。

ボリュームエンジンに対して簡易（Simple）のシャドウ方法（Shadow
Method）を使用すると、ライトの位置と交点の値が反転する

簡易（Simple）のシャドウ方法（Shadow Method）を使用すると、シャドウは
ライトの位置を state->org に、交点を state->point に渡します。ただし、これ
らの値はボリュームエンジンの使用時に反転します。これは、現在のソフトウェ
アに想定される動作です。

レンダリングの前に非多様ジオメトリを削除する必要がある

近似値を持つ非多様ジオメトリは、mental ray for Maya レンダリングの使用時
に、Maya が突然終了してしまう場合があります。これは、mental ray for Maya
の既知の制限事項です。したがって、非多様ジオメトリを削除してからレンダリ
ングする必要があります。

マテリアルスウォッチが IPR 中に更新されない

mental ray の IPR のレンダー時に、ハイパーシェード（Hypershade）とアトリ
ビュート エディタ（Attribute Editor）の mental ray のマテリアルスウォッチ
を調整しても更新されません。
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スウォッチを mental ray で再レンダーするには、mental ray IPR を停止しま
す。

高速サブサーフェススキャッタリングをファイナルギャザーとともに使
用した場合、より正確かつ低速になる

Maya 2008 以降、高速サブサーフェススキャッタリングをファイナルギャザー
とともに使用した場合、より正確になりましたが、速度も低下しました。これ
は、misss_lightmap_write()シェーダと、このシェーダを使用するすべてのフェ
ノメナで、精度を保証するための追加の計算が行われるようになったからです。

ファイルをインポートする前に Mayatomr プラグインをロードする必要
がある

ファイルのインポートは、必ず Mayatomrプラグインをロードしてから行ってく
ださい。ファイルをインポートしてから Mayatomrプラグインをロードすると、
mental ray でレンダーしようとするときにエラーが発生する場合があります。

ファイナルギャザーマップビジュアライザの制限事項

レンダー設定（Render Settings）の間接ライティング（Indirect Lighting）タブ
にあるマップビジュアライザの有効化（Enable Map Visualizer）オプションや
ファイナルギャザリング（Final Gathering）の使用時に、デフォルトのファイ
ナルギャザーファイル名を使用するとビジュアライザにポイントが表示されま
せん。

解決方法

デフォルト設定の代わりに、一次ファイナルギャザーファイル（Primary Final
Gather File）アトリビュートの絶対パスを入力します。

パーティクルレンダリング

mental ray を使用すると、ポイント（Points）、マルチポイント（MultiPoint）、
球体（Spheres）、スプライト（Sprites）、ストリーク（Streak）、マルチスト
リーク（MultiStreak）タイプのパーティクルもレンダリングできます。これら
は mental ray に渡してレンダリングするパーティクル単位のデータから実際の
ジオメトリを作成するジオメトリシェーダで構築されます。

ハードウェアパーティクルはソフトウェアパーティクルと同じようにシェーディ
ングされます。シェーディンググループをパーティクルシェイプに割り当てる
必要があり、そのサーフェスシェーダがパーティクルの外観を完全に定義しま
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す。これは、ハードウェアパーティクルを mental ray でレンダリングする場合
に、シェーディングに関連するアトリビュートは一切サポートされないことを意
味します。

spriteNumPP はサポートされません。このため、パーティクル単位で異なるス
プライトを割り当てることはできません。また、mental ray と Maya ハードウェ
アとではパーティクルのレンダリング結果が若干異なります。

ハイパーシェード（Hypershade）からシーンファイルをインポートする
際に警告メッセージが表示される

mental ray ノードを含むシーンファイルをインポートする際に、次のような警
告メッセージが表示される場合があります。

// Warning: 'Draft.message' is already connected to

'mentalrayItemsList.options'. //

これらの警告メッセージは、mental ray 関連ノードの既存のコネクションに関
するもので、実害はなく無視しても問題ありません。

また、これらの警告が発生した際には、警告のダイアログボックスも表示されま
す。多数のファイルをインポートするときに、ファイルごとに表示される警告
メッセージのダイアログボックスを手動で閉じる手間を省くには、fileコマンド
に -prompt falseを指定します。

mental ray for Maya のフレームバッファは 32 ビットデプスフレーム
バッファしか出力しない

mental ray for Maya は 32 ビットのデプスフレームバッファのみを出力し、
16 ビットは出力しません。

解決方法

外部ツールを使用して、デプスを特定のアプリケーション用の制限範囲にクラン
プします。カラー値もコンポーネント単位で 32 ビットであるため（HDR）、32
ビットのデプスを読み取れない合成パッケージは mental ray での使用には適し
ません。

mental ray for Maya のマップの転写（Transfer Maps）の制限

mental ray のマップの転写のベイク処理に加えて、

■ .tifファイルフォーマットで Maya のマップの転写をベイク処理し、さら
に
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■ オプションで、マップをシェーダにコネクト（Connect maps to shader）を
選択すると、

2 度目に mental ray のマップの転写をベイク処理したときに、mental ray はエ
ラーを生成します。

mental ray は LZW圧縮の TIFフォーマットを解釈できません。

解決方法

このエラーを回避するには、次のいずれかの手順を実行します。

■ Maya のマップの転写では mental ray で使用できるファイルフォーマット、
たとえば EXRや DDSなどを使用します。

■ mental ray のマップの転写を 2 度目にベイク処理する前に、ソースサーフェ
スに別のマテリアルを割り当てます。

■ シェーダオプションで、マップをシェーダにコネクト（Connect maps to
shader）オプションを選択解除します。

mental ray for Maya のマップの転写カスタムシェーダの制限

カスタムマップの作成時、マップの転写は輪郭シェーダやジオメトリシェーダ
のテクスチャへのベイク処理をサポートしません。マテリアルシェーダ（レン
ダーノードの作成（Create Render Node）ウィンドウで mental ray タブのマ
テリアル（Materials）セクションの下にリスト表示されるシェーダ）だけがテ
クスチャにベイク処理できます。カスタムシェーダは、Maya でマテリアル
シェーダとして認識されるようにしてください。

Zpic サポートの削除

Softimage Depth（Zpic）ファイルフォーマットは、mental ray for Maya のレ
ンダリングでサポートされなくなりました。

mental ray の mia_roundcorners シェーダは両面ジオメトリとともに使用
する

mental ray の mia_roundcorners シェーダは両面ジオメトリとともに使用する
必要があります。
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mental ray 出力シェーダに「geometry」型のパラメータが含まれると
き、バッチレンダーが出力イメージファイルを生成しないことがある

シーンに「geometry」型のパラメータを持つ mental ray 出力シェーダが含まれ
る場合、バッチレンダーは出力イメージファイルを生成しません。エラーメッ
セージは表示されませんが、レンダーが完了してもイメージファイルは生成さ
れていません。

解決方法

パラメータを「integer」などの別の型に変更します。

アニメーション時のサーフェスの変更は mental ray for Maya のモーショ
ンブラーでサポートされない

アニメーション時のサーフェスの変更（たとえば、頂点の数の変更）は、mental
ray for Maya のモーションブラーではサポートされていません。モーションの
間隔が大きく、トポロジの変更がこの間隔内に発生する場合、mental ray は警
告メッセージ「Shapes are not equivalent, no motion vectors computed」を
発行し、シェイプのモーションデータの計算をスキップします。

mental ray で単一マップにベイク処理を行うと間違った UV セットが使
用される

単一マップにベイク処理（Bake to one map）が有効化されている場合、mental
ray では現在、オブジェクトに対して指定されたカレント UV セットにかかわら
ず、デフォルト UV セットのみがベイク処理されます。

解決方法

メッシュ UV セットの割り当てのオーバーライドを使用し、すべての UV セッ
トをその名前に変更します。

mental ray で複数のモーショントランスフォームがサポートされない

複数のモーショントランスフォームは、mental ray for Maya ではサポートされ
ていません。カーブしたモーションブラーを得るには、アニメーションをトラ
ンスフォームではなくシェイプノードに適用する必要があります。さらに、レ
ンダー設定（Render Settings）のオプション（Options）タブにあるトランス
レーション（Translation）セクションのパフォーマンス（Performance）サブ
セクションで、モーション セグメントを出力（Export Motion Segments）オプ
ションを有効にする必要があります。
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mia_physicalsun シェーダを使用するとイメージプレーンのレンダー結果
が暗くなる

レンダー設定（Render Settings）の環境（Environment）セクションにある作
成（Create）ボタンを使用して mia_physicalsun や mia_physicalsky をシーン
に追加した場合、露光を調整する mia_exposure_simple シェーダを含むノード
ネットワークが自動的に作成されます。mia_exposure_simple シェーダがネッ
トワークに追加される理由は、mia_physicalsunとmia_physicalskyシェーダは
物理的に正しい高ダイナミックレンジのイメージを作成し、このイメージを露
光制御なしで表示するとレンダービューで真っ白になってしまうからです。
mia_exposure_simple シェーダは太陽と空に作用するだけでなく、イメージプ
レーンを含むシーン全体に影響を及ぼします。標準的なイメージプレーンは、
明るい空と比べて相対的に暗く表示されます。イメージプレーンのブライトネ
スを、カラー ゲイン（Color Gain）アトリビュートとカラー オフセット（Color
Offset）アトリビュートを使用して、または mia_exposure_simple シェーダの
アトリビュートを使用して調整できます。

mental ray ボリュームファーがタイルのエッジにアーティファクトを生
成する

mental ray ボリュームファーでシャドウのタイルエッジにアーティファクトが
生成されることがあります。

解決方法

イメージ全体に単一のタイルを使用します。ただし、大量のメモリが消費され、
レンダリングに使用されるマシンのコアは 1 つのみになります。

ファーノードで間違ったバウンディングボックスがレポートされる

Maya は、FurFeedback ノードで、間違った（ゼロ）バウンディングボックス
をレポートします。

解決方法

表示 > ロケータ（Show > Locators）を有効にすると、バウンディングボック
スが正しくなります。
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マルチレンダーパスの制限事項

2D モーションベクトルパスの制限事項

2D モーションベクトルパスのファイルフォーマット

2D モーション ベクトル（2D Motion Vector） パスは 32 ビット出力を必要と
します。したがって、このパスを作成する場合、ファイルフォーマットは
openEXR にする必要があります。ただし、レンダーパスごとに異なるファイル
フォーマットを選択できないため、パスのリストに 2D モーション ベクトルパ
スが含まれる場合は、すべてのパスを openEXR ファイルに書き込む必要があり
ます。この制限事項は正規化した 2D モーション ベクトル（Normalized 2D
Motion Vector）パスには該当しません。

2D モーション ベクトルパスと Toxik の併用

mental ray for Maya での 2D モーション ベクトル パスは 3 チャンネルで、4
チャンネルはサポートしていません。

解決方法

Toxik で blur ノードの延長オプションを使用するには、有効範囲のパスをレン
ダリングして Toxik の Set Alpha を使用します。

mental ray の太陽と空のシェーダがパスを通常よりも明るくする

マルチレンダーパスで mia_physicalsun と mia_physicalsky シェーダを使用す
ると、パスが通常よりも明るく表示される場合があります。この違いは特に、屈
折パスで顕著になります。

解決方法

マルチレンダーパス機能と、mia_physicalsun や mia_physicalsky シェーダを
併用しないでください。シーンでこれらのシェーダを使用する必要がある場合は
.exrフォーマットにレンダーし、Toxik などの合成ソフトウェアで必要なトー
ンマッピングを実行します。

モーションベクトルをレンダリングするとメモリの消費量が増加する

BSP2 でモーションベクトルをレンダリングすると、モーションブラーのレン
ダリングと同様にメモリの消費量が増加することがあります。メモリが不足する
場合は、BSP または大きい BSP を使用してみてください。
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レンダープロキシの制限事項
■ テクスチャを含むレンダープロキシをエクスポートする場合は、選択項目の

エクスポート オプション（Export Selection Options）ウィンドウのファイ
ル パスのエクスポート（Export file paths）セクションのテクスチャ ファイ
ル（Texture file）カテゴリを絶対（Absolute）にする必要があります。

■ レンダープロキシは、現在スタティックジオメトリのみをサポートしてい
ます。したがって、ファイルにデフォーマを加えてアニメートした上でプロ
キシとしてエクスポートし、mental ray for Maya でこれを新規ファイルに
ロードすると、最終フレームしか読み込まれません。

■ プロキシをファイルにロードしてデフォーマを加えることはできません。プ
ロキシシェイプを修正（すなわち、Maya シーンのバウンディングボックス
のサイズを変更）するとクランプが発生する可能性があるので、修正はしな
いでください。

自動ボリュームを使用するとシーンにライトがない場合でもシャドウが
レンダーされる

自動ボリュームを使用すると、シーンにライトがない場合でもシャドウがレン
ダーされる場合があります。

新しいアトリビュートを mental ray ベースシェーダに追加するときに
ショートネームが間違って表示される

新しいアトリビュートを mental ray ベースシェーダにアペンドすると、出力値
のショートネームが間違って表示されます。

解決方法

.mi 宣言で明示的なショート ネームを出力パラメータに追加し、シーンを別名で
保存オプション（Save Scene As Options）ウィンドウのファイル タイプの特定
オプション（File Type Specific Options）セクションにあるノードのアトリビュー
トにフル ネームを使用（Use full names for attributes on nodes）を有効にし
た状態で Maya ファイルを保存します。

mentalrayGlobals による冗長レベルの変更が機能しない

mentalrayGlobals によるメッセージの冗長レベルを変更しても、機能しません。
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解決方法

レンダー > カレントフレームのレンダー（Render > Render Current Frame）

から冗長レベルを変更します。

Maya 2009 で作成した .mi ファイルが Maya 2010 スタンドアロンではレ
ンダーされない

Maya 2009 を使用してシーンを .mi ファイルとしてエクスポートし、その .mi

ファイルを Maya 2010 スタンドアロンでレンダーしようとするとエラーが発生
することがあります。

解決方法

この問題を解決するには、シーンを Maya 2010 で開き、.miファイルとして再
度エクスポートします。

ハードウェアレンダリングの制限事項
このセクションでは、ハードウェアレンダリングのサポートされていない機能、
制限事項、解決方法を示します。

既知の制限事項

立方体マップで移動やスケールの効果が出ない

環境立方体マップでの移動やスケールは、ハードウェアレンダラでは処理対象
とされません。立方体マップのレンダリングは、ソフトウェアレンダリングの
場合とは大幅に異なります。この制限事項の解決方法はありません。

投影テクスチャのベイク処理時にハードウェアレンダラのパフォーマン
スが低速

投影テクスチャのベイク処理時にハードウェアレンダラのパフォーマンスが低
速です。

解決方法: Maya ハードウェア（Maya Hardware）タブのレンダー設定（Render
Settings）でベイク処理解像度（カラー解像度（Color resolution）、バンプ解
像度（Bump resolution））を削減します。
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mental ray のエリアライトの表示に関するハードウェアレンダラの制限
事項

mental ray のエリアライトを表示すると、ハードウェアレンダラは実際のレン
ダーと同じ結果を生成せずに、高精度（High Quality）モードで表示できる、非
常に大まかな近似を生成します。

Maya ハードウェアレンダラは、mental ray のエリアライトの次の構成をサ
ポートします。

■ Maya エリアライトを使用する必要があります。

■ 長方形の mental ray のエリアライトシェイプのみがサポートされていま
す。

■ カラー、輝度、減衰率などの基本的なライトパラメータはサポートされてい
ます。

■ シャドウの近似がサポートされています。

■ 拡散ハイライトとスペキュラハイライトの両方に固定ポイントサンプリン
グレートが使用されます。ライトの領域が大きく、ライトがサーフェスに近
いスペキュラハイライトでは、サンプリングアーティファクトが生じる場
合があります。

■ その他のライトシェイプと、ハイサンプル（High Samples）、ハイサンプ
ル制限（High Sample Limit）、ローサンプル（Low Samples）などのオプ
ションはサポートされません。

ハードウェアレンダラでは透明なポリゴンが正しくソートされず、透明
度マッピングオブジェクトでアーティファクトが生じる

シェーダの異なるオブジェクトまたはオブジェクトの一部で、カメラから見て
3D 境界領域にオーバーラップがある場合は、透明度のソート結果がソフトウェ
アレンダリングとは異なることがあります。

これは、ハードウェアレンダラでのソートが、ピクセル単位になっていないた
めです。レンダー設定（Render Settings）での透明度ソートには、基本的に 2
つのモードがあります。

■ オブジェクト単位（Per Object）

■ ポリゴン単位（Per Polygon）
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オブジェクトのワールド空間のバウンディングボックスに位置揃えされた軸が、
レンダリングに使用されたカレントのカメラのデプスをソートするための主な基
準として使用されます。

オブジェクト単位（Per Object）の場合、オブジェクトはカメラのデプスで遠い
ものから近いものの順にソートされます。距離は、バウンディングボックスの
中心からカメラの「視点」位置までを測定したものです。オブジェクトに複数の
シェーダが割り当てられている場合は、オブジェクトの各部のバウンディング
ボックスについて測定が行われます。各部は「シェーダセクション」と呼ばれ、
各ボックスは「シェーダバウンズ」と呼ばれます。オブジェクト全体で 1 つの
シェーダを使用していれば、「シェーダバウンズ」はオブジェクト全体のバウ
ンディングボックスに等しくなります。「シェーダバウンズ」は、後ろから前
の順にソートされます。

ポリゴン単位（Per Polygon）では、さらに細かいソート機能があります。各オ
ブジェクトごとに、ポリゴンが後ろから前にソートされます。デプスでソートさ
れた「シェーダバウンズ」を描画する際に、ポリゴンが後ろから前の順に描画
されます。このオプションがオンになっていなければ、ポリゴンは「シェーダ
バウンズ」単位で任意の順番で描画されます。

解決方法

より適切なソートを行うために、以下のどちらかを行います。

■ オブジェクトのポリゴンを個別のオブジェクトに分割します。

■ 単一のオブジェクトの単一のシェーダ領域を、オブジェクト当たり 1 つの
シェーダがある個別のオブジェクトに分割します。

ハードウェアレンダラのクリッププレーンがソフトウェアレンダラと
mental ray レンダラのデフォルト動作と異なる

ソフトウェアレンダラと mental ray レンダラでは、1 つのオブジェクトの一部
がファークリッピングプレーンより遠くにある場合、ファークリッピングプ
レーンより遠い部分を含むオブジェクトの全体がレンダーされます。

しかし、ハードウェアレンダラでは、オブジェクトの一部がファークリッピン
グプレーンより遠くにある場合、ファークリッピングプレーンの前面にあるオ
ブジェクトの一部だけがレンダーされます。ファークリッピングプレーンより
遠くにあるオブジェクトの部分はクリップされますが、レンダーされません。
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Ashli シェーダプラグインがボーナスツールの一部になっている

Maya 2009 より、ASHLI プラグインを Maya ボーナスツール（Bonus Tools）
の一部として使用できるようになりました。ボーナスツールは役に立つ無償の
Maya スクリプトとプラグインのコレクションで、Autodesk Web サイト
（http://www.autodesk.co.jp/maya-bonustools）から利用できます。

ATI Ashli ハードウェアシェーダプラグインが 64 ビット Linux で不安定

ATI Ashli ハードウェアシェーダプラグインが 64 ビット Linux で不安定で、
表示のためシェーダファイルをロード中に Maya がクラッシュすることがあり
ます。

シャドウが nVidia カード上の最新バージョン Cg で破損する

（Windows、Linux）Cg 1.5 ライブラリのベータ 2 バージョンを提供していま
す。しかし、これらのライブラリの新しいバージョンでは、nVidia カード上で、
すべてのプラットフォームにおいてシャドウが正しく動作しません。ATI カード
ではこの問題は発生していないようです。

（Mac OS X）ユニバーサルバイナリライブラリバージョンが必要であるため、
Cg ライブラリの 1.5.0012 バージョンを提供しています。しかし、Mac OS X
10.4.8 では、nVidia カード上で、シャドウが正しくレンダーされません。

ランタイム領域にある Cg ライブラリを、CgFx プラグインシェーダ開発の新し
いバージョンに置き換えることができます。ただし、これらのライブラリの新し
いバージョンは承認またはサポートされていません（たとえば、このシャドウ問
題が発生します）。

ベクターレンダリングの制限事項
ベクターレンダリングに関する制限事項と解決方法について次に説明します。

異なるオペレーティングシステムで作成したフレームを結合しない

異なるオペレーティングシステム（たとえば、32 ビット版オペレーティングシ
ステムと 64 ビット版オペレーティングシステム）でベクトルレンダリングか
ら作成したフレームを結合しないでください。これはレンダラ出力が少し異なる
場合があるためです。
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Backburner レンダリングの制限事項
Backburner をサービスとして使用してレンダリングすると、利用可能な
すべてのプロセッサが使用されない場合があります。

Backburner サーバセットアップをサービスとして使用してレンダリングすると
き、コンピュータで利用可能なすべてのプロセッサがレンダリングに使用されな
い場合があります。

解決方法
1 Backburner サービスのインストール後、[コントロールパネル] > [管理ツー

ル] > [サービス] を開きます。

2 Backburner server アイコンを右クリックして Backburner Service プロパ
ティを開きます。

3 Log On タブの Log on as: セクションで This account を選択します。

4 ユーザ名とパスワードを指定します。

5 Maya を起動し、手順 4 で作成したユーザ名とパスワードのプリファレン
スを作成します。
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Maya nDynamics

nDynamics に関する一般的な制限事項
nDynamics に関するさまざまな制限事項と解決方法を紹介します。

非表示/可視の nucleus オブジェクトの併用

シーンに非表示と可視両方の nucleus オブジェクトがあり同じ nucleus ソルバに
割り当てると、シミュレーションは、シーンのすべての nucleus オブジェクトが
可視の場合と同じようには再生されない場合があります。

解決方法

シミュレーション時に nucleus オブジェクトを非表示にするかその可視性をアニ
メートし、すべての nucleus オブジェクトが可視の場合と同じようにシミュレー
ションを再生するには、すべてのオブジェクトを可視に設定したシミュレーショ
ンをキャッシュします。最終シミュレーションでは可視に設定しない nucleus オ
ブジェクトをすべて選択して非表示にします。

以前にキャッシュ済みの nCloth オブジェクトを使用する nParticle のキャッ
シュ

nParticle オブジェクトを同じキャッシュファイルにキャッシュ済みの 2 つ以上の
nCloth オブジェクトと同時にキャッシュすると、生成されるキャッシュの nCloth
オブジェクトは、ジオメトリごとに 1 ファイル（One file per geometry）オプ
ションを使用していない場合想定どおりに動作しません。
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解決方法

nCloth オブジェクトと nParticle オブジェクトを同じシーンに一緒にキャッシュ
する場合、nCloth と nParticle の nCache オプションの設定時に必ず nCache
の作成オプション（Create nCache Options）ウィンドウでジオメトリごとに 1
ファイル（One file per geometry）を選択してください。

キャッシュ済み nParticle が nCloth と衝突しない

nCloth と衝突する nParticle オブジェクトを nCache すると、シミュレーショ
ンの再生時に nParticle が nCloth オブジェクトと衝突しません。

解決方法

nParticle と nCloth オブジェクトを同時に nCache します。nCloth と nParticle
の nCache オプションの設定時に必ずnCache の作成オプション（Create nCache
Options）ウィンドウでジオメトリごとに 1 ファイル（One file per geometry）
を選択してください。
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Maya nCloth

nCloth に関する一般的な制限事項
その他のいろいろな nCloth に関する制限事項と解決方法について次に説明しま
す。

ソルバの割り当て（Assign Solver）で、孤立した nCloth オブジェクトが
nucleus ソルバに割り当てられない

nCloth を作成し、nucleus ソルバに割り当てていない場合に、nSolver > ソルバ
の割り当て（nSolver > Assign Solver）メニュー項目を使用した割り当て処理が機
能しません。代わりに、「選択したオブジェクトは nSolver に属しません（Selected
object does not belong to an nSolver）」というエラーメッセージが表示され、
オブジェクトはソルバにコネクトされません。

解決方法

addActiveToNSystem MEL プロシージャを使用して、新しい nCloth オブジェク
トを既存の nucleus ソルバにコネクトします。たとえば、
addActiveToNSystem("nClothShape2", "nucleus1"); などとします。

nRigid のコリジョン表示が nRigid オブジェクトとずれる

シーン内のすべての nCloth オブジェクトがキャッシュされていると、キャッシュ
後の nRigid のコリジョン表示が 1 フレームずれて表示されます。

解決方法

非常に小さいキャッシュされていない nCloth オブジェクトをシーンに追加しま
す。
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開始フレーム後にパッシブコリジョンオブジェクトのトポロジを変更す
る

開始フレーム後に nConstraint を使用するパッシブコリジョンオブジェクトの
トポロジを変更して、結果のフレームの頂点またはフェースが元のフレームより
少なくなっている場合、その直後に再生を再開すると Maya が永久に停止する
場合があります。

解決方法

シーンを再生する前に、再生範囲の始点に戻してください。

隣接する境界の縫合（Weld Adjacent Borders）コンストレインとファイ
ルの保存

nCloth オブジェクトが隣接する境界の縫合（Weld Adjacent Borders）コンス
トレインを使用してコンストレインされ、ファイルが開始フレーム以外で保存さ
れ再び開かれた場合、再びロードされたシーンでは再生時にコンストレインが正
しく更新されません。

解決方法

保存する前に、再生範囲の始点に戻してください。

ラップされたサーフェス上の nConstraint

nCloth オブジェクトがメッシュをラップデフォーマとして使用しているとき
に、nCloth とメッシュサーフェスの間に nConstraint が作成された場合、コ
ンストレインは作用しません。

解決方法

ラップのシェイプをパッシブコリジョンオブジェクトにしてから、コンストレ
インを作成します。

引き裂き可能なコンストレインを削除する

引き裂き可能なコンストレインをダイナミックコンストレインの削除（Remove
Dynamic Constraint）を使用して削除しても、nCloth はシミュレート時に引き
裂かれます。
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解決方法

ハイパーグラフ（Hypergraph）で、polySplitVert、polyMergeVert、
polySoftEdge の各ノードを選択して削除します。

dynamicConstraintShape ノードの最大距離の値により Maya がクラッシュ
することがある

nConstraint（dynamicConstraintShapeノード）の最大距離（Max Distance）
を使用してコンストレインに加える nucleus オブジェクトコンポーネントを指
定すると、各オブジェクトの各コンポーネントが相互にコンストレインされるよ
うなコネクションが生成される場合があります。これによりパフォーマンスが低
下し、nCloth メッシュや nParticle システムが大きい場合など、使用可能なメ
モリを使い果たしてしまうことがあります。

解決方法

dynamicConstraintShape ノードのコネクション密度（Connection Density）
の値を下げてコネクションがまばらになるように設定すると、パフォーマンスが
向上し、さらにオリジナルのシミュレーションの動作を維持できるだけのオブ
ジェクトのコンポーネント間のコネクションが残ります。

シミュレーション時のトポロジ変更

nCloth のシミュレート中のトポロジ変更（頂点を変更するメッシュサーフェス
への修正）は、Maya 2008 ではサポートされていません。nCloth オブジェクト
のトポロジ変更は、コリジョン失敗になる可能性があります。

頂点マップとコンストレイン

Maya 2008 では、頂点同士をコネクトするコンストレインについてのみペイン
トされた頂点マップを作成することができます。

リファレンスファイルからの nCloth 作成

リファレンスファイルからジオメトリを使用してクロスオブジェクトを作成す
るとき、リファレンスをアンロードしてそのファイルを保存すると、リファレン
スノードに誤ったジオメトリが表示されることがあります。
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nCloth の入力メッシュがジオメトリキャッシュにドライブされている場
合、nCloth が正しくキャッシュしない

nCloth オブジェクトの入力メッシュがジオメトリキャッシュにドライブされて
いる場合、多くの nCache 操作は nCloth キャッシュではなく、ジオメトリ
キャッシュに作用します。

解決方法
1 nCloth オブジェクトを選択し、アニメーション（Animation）メニュー

セットからデフォーマの編集 > 中間オブジェクトの表示（Edit Deformers
> Display Intermediate Objects）を選択します。

nCloth 入力メッシュや、ジオメトリキャッシュ前のメッシュを含むすべ
ての上流シェイプが表示されます。

2 出力メッシュシェイプを選択するには、トランスフォームノードから下へ
Pick Walk を実行し、出力クロスメッシュが選択されるまで、右にウォー
クします。あるいは、アトリビュート エディタ（Attribute Editor）で
OutputMesh タブを選択します。

3 アニメーション（Animation）メニューセットからデフォーマの編集 > 中
間オブジェクトの非表示（Edit Deformers > Hide Intermediate Objects）
を選択して、上流メッシュを非表示にします。

4 nDynamics メニューから、nMesh > カレント メッシュの表示（nMesh >
Display Current Mesh）を選択して、入力メッシュを非表示にします。

スムージングとキャッシング

低解像度モデルを作成し、そのモデルに対して nCache を作成して、そこに
polysmooth を追加してから新しくスムージングされたモデルに nCache を作成
すると、Maya は新しいモデルの代わりに低解像度モデルを再キャッシュしま
す。

解決方法

スムージングされたオブジェクトに新しいキャッシュを作成した後、編集 > 種
類ごとにすべてを削除 > ヒストリ（Edit > Delete All by Type > History）を選
択します。次にジオメトリ キャッシュ > インポート（Geometry Cache >
Import）を選択して、スムージングされたジオメトリのキャッシュをアタッチ
します。
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トポロジ変更による nCloth オブジェクトのキャッシング

キャッシングは、トポロジが経時的に変化しないオブジェクトの結果を生成する
のに便利です。一部のアニメートされたモデリングコンストラクションヒスト
リ操作の結果では、トポロジが経時的に変化します。これらのオブジェクトに
キャッシュを作成することはできますが、一定のトポロジを仮定しているため、
再生時にオブジェクトが変形されることがあります。

ペイントされたリンクルマップが初期状態（Initial State）の設定後に
動作しない

頂点プロパティのペイント（Paint Vertex Properties）を使用してリンクルマッ
プを nCloth に適用すると、最初のシミュレーションの再生時に nCloth オブ
ジェクトにしか影響を与えないことがあります。nCloth オブジェクトの初期状
態（Initial State）を設定してからシミュレーションを再生すると、ペイントさ
れたリンクルマップが nCloth オブジェクトの動作に影響を与えない場合があ
ります。

解決方法

リンクルマップのスケール（Wrinkle Map Scale）をアニメートすると、リンク
ルの更新を強制できます。これは、簡単なエクスプレッションでリンクル マッ
プのスケール（Wrinkle Map Scale）の値を設定することで実行できます。たと
えば、等号（=）を リンクル マップのスケール値の前に追加します。

最後のツール（Last Tool）と nCloth のペイント

nCloth プロパティテクスチャマップをペイントするとき、最後に使用したツー
ル（デフォルトのホットキー「y」）を使用してペイントを再び軌道することが
できません。

コンポーネント間のコンストレインをフレーム単位で更新する

dynamicConstraint ノード上のコネクションの更新（Connection Update）アト
リビュートをフレーム単位（Per Frame）に設定すると、コンポーネント間
（Component to Component）コンストレインを使用しても効力を持たなくな
ります。
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シェーディングモードでの厚みマップ（Thickness map）

フェース（Face）コリジョンのあるオブジェクトのコリジョンの厚みをシェー
ディングモードでペイントしているとき、マップ済みの厚みのばらつきを確認
することが難しい場合があります。

解決方法

シーンをワイヤフレームモードで表示します（シェーディング > ワイヤフレー
ム（Shading > Wireframe））。

コリジョンの厚みを表示する

ソルバ表示（Solver Display）（nClothShape ノード）をコリジョンの厚み
（Collision Thickness）に設定して、nCloth パッシブコリジョンオブジェクト
を修正すると、シーンビューが調整どおりにただちに更新されないことがあり
ます。

解決方法

1 フレーム前進させるか開始フレームに巻き戻して、シーンビューを更新しま
す。

押し出し半径（Push Out Radius）がコリジョンの厚み（Collision
Thickness）より小さい場合、nCloth がジグルまたは振動する

nCloth オブジェクトの押し出し半径（Push Out Radius）の値がコリジョンの
厚み（Collision Thickness）よりも小さい場合、nCloth が他の nucleus オブ
ジェクトと衝突してジグルまたは振動することがあります。

解決方法

nCloth オブジェクトの押し出し半径（Push Out Radius）の値をコリジョンの
厚み（Collision Thickness）の値よりも大きくします。

nCloth 入力メッシュから出力メッシュへの下流コネクションの転写

通常 nCloth の入力メッシュからの下流コネクションは、入力メッシュが nCloth
に変化した場合には出力メッシュに転写されません。

唯一の例外は入力メッシュのワールド空間（World Space）値（ポリゴン メッ
シュ ノードの worldMesh）とラップノードのラップアトリビュート（Wrap
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Attributes）（wrapノードの driverPoints）間のコネクションです。これらのコ
ネクションは転写されます。

解決方法

入力メッシュから出力メッシュへのコネクションを手動またはスクリプトを使用
して転写します。

ネガティブな押し出し（Push Out）値

nClothShape ノードのネガティブな押し出し値は、法線が逆転したオブジェク
トを想定しています。現状の動作では、押し出し値が -1.0 未満の場合、法線の
向きだけがフリップします。このため、サーフェスの裏側に微妙な押し出しを作
成することができません。

解決方法

期待通りの結果を得るには、サーフェスで法線をフリップさせ、押し出し値に正
の数を使用します。

nCloth オブジェクトのサイズの影響を受ける揚力アトリビュート

同じ nCloth オブジェクトを、同じ揚力（Lift）アトリビュート値を持つ異なる
サイズにスケールすると、スケールした nCloth オブジェクトはシミュレート時
に異なる動作をする場合があります。

解決方法

スケールした各 nCloth オブジェクトの揚力（Lift）アトリビュートを、意図し
た動作が得られるまで調整します。
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Maya nParticle

nParticle に関する一般的な制限事項
nParticle に関するさまざまな制限事項と解決方法を紹介します。

nParticle ツール（nParticle Tool）をリセットすると、従来のパーティクル
ツール（Particle Tool）ウィンドウに戻る

nParticle ツール（nParticle Tool）使用時にツールのリセット（Reset Tool）を選
択すると、ツール設定（Tool Settings）ウィンドウが nParticle ツール（nParticle
Tool）設定から従来のパーティクル ツール（Particle Tool）設定に変更されます。

解決方法
1 nParticle ツール（nParticle Tool）のリセット後に表示されるツール設定

（Tool Settings）ウィンドウを閉じます。

2 nParticle > nParticle の作成 > nParticle ツール（nParticles > Create nParticles

> nParticle Tool） を選択して、nParticle ツール（nParticle Tool）設定
ウィンドウを再び開きます。

nParticle の作成を元に戻したときに、シーンから nParticle が削除されな
い場合がある

nParticle システムの作成を元に戻す場合に、元に戻す（Undo）（編集 > 元に戻
す（Edit > Undo））を 2 ～ 3 回実行しないと、nParticle システムをシーンから
削除できない場合があります。
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コネクションを持たない nParticle オブジェクトの複製が保存したシーン
ファイルで再生されない

nParticle オブジェクトの複製はシーンで正しく再生されますが、シーンファイ
ルを保存してから Maya で開くと、正しく再生されません。これは、複製した
nParticle オブジェクトを nucleus ソルバに割り当て、時間にコネクトする必要
があるためです。

解決方法
1 addActiveToNSystem MEL プロシージャを使用して、新しい nParticle オ

ブジェクトを既存の nucleus ソルバにコネクトします。たとえば、
addActiveToNSystem("nParticleShape2", "nucleus1");などとします。

複製した nParticle オブジェクトをオリジナルとは違うソルバにコネクトす
る場合、シミュレーションを正しく再生するには、ファイルを保存してか
らもう一度開く必要があります。

2 次のコマンドラインを使用して nParticle オブジェクトを time にコネクト
します。connectAttr time1.outTime nParticleShape2.currentTime;

3 複製した nParticle オブジェクトをエミッタに割り当てるには、ダイナミッ
ク リレーションシップ（Dynamic Relationships）エディタを使用してコネ
クションを作成します。

nParticle オブジェクトを開始フレームより後のフレームで複製すると
Maya がクラッシュする

nParticle システムをシミュレーションの開始フレームより後のフレームで複製
して再生を続行すると、Maya がクラッシュすることがあります。

解決方法

次のいずれかを実行します。

■ nParticle システムの複製をシミュレーションの開始フレーム以前で作成しま
す。

■ オブジェクトの複製直後にシミュレーションを巻き戻して再生します。
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ソルバの割り当て（Assign Solver）で、孤立した nParticle オブジェクト
が nucleus ソルバに割り当てられない

nParticle を作成して nucleus ソルバに割り当てていない場合に、nSolver > ソ
ルバの割り当て（nSolver > Assign Solver）メニュー項目を使用した割り当て処
理が機能しません。代わりに、「選択したオブジェクトは nSolver に属しません
（Selected object does not belong to an nSolver）」というエラーメッセージ
が表示され、オブジェクトはソルバにコネクトされません。

解決方法

addActiveToNSystem MEL プロシージャを使用して、新しい nParticle オブジェ
クトを既存の nucleus ソルバにコネクトします。たとえば、
addActiveToNSystem("nParticleShape2", "nucleus1"); などとします。

バウンス（Bounce）が 0 のときに nParticle 間のコリジョンが不安定に
なる

2 つの nParticle システムの個々の nParticle 間で発生するコリジョン（nParticle
のセルフコリジョンではない）は、両方の nParticle オブジェクトのバウンス
（Bounce）アトリビュートが 0 に設定されると、誇張されます。

解決方法

衝突する nParticle オブジェクトのいずれかのバウンス（Bounce）アトリビュー
トを 0.001 などの非常に小さい値に設定します。

nParticle のない先頭フレームが nParticle キャッシュから除外される

先頭フレームにパーティクルがない nParticle システムをキャッシュすると、先
頭フレームは nCache に含まれません。Maya はキャッシュ範囲をシーンにパー
ティクルが表示される最初のフレームに設定し、シミュレーションの先頭フレー
ムは未キャッシュとして処理されます。つまり、空の先頭フレームを含むシミュ
レーションをバッチレンダーするには、無制限ライセンスが必要になります。

解決方法

シミュレーションのすべてのオブジェクトをキャッシュする場合、バッチレン
ダー時に nucleus ノードを無効にします（nucleus ノードのアトリビュート エ
ディタで有効化（Enable）をオフにします）。
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nParticle キャッシュのブレンドとマージが動作しない

Maya 2010 は、nParticle キャッシュのブレンドとマージをサポートしていませ
ん。

nParticle のキャッシュ時にエラーメッセージが表示される

シミュレーションの初期フレームにパーティクルが存在しない nParticle nCache
を作成した場合、初期フレームのキャッシュファイルが存在しない、または
キャッシュファイルが空であることを示すエラーメッセージが表示されます。
このエラーメッセージは、新規作成したプリファレンスで Maya を起動した直
後にキャッシュを作成した場合にも表示されます。これは初期化されていない一
部のプリファレンスに原因があります。

解決方法

nParticle キャッシュを再生します。シミュレーションが意図したとおりに動作
する場合は、エラーメッセージは無視してください。シミュレーションが意図
したとおりに動作しない場合は、キャッシュがあるならばそれを削除し、nCache
の作成オプション（Create nCache Options）ウィンドウを開きます。もう一度
キャッシュを作成します。

nParticle の collisionTime の精度が最も近いフレームにしかならない

nParticle では、collisionTime は最も近いフレームの精度で値を返します。

解決方法

シミュレーションの前のフレームの nParticle の位置と速度から値を計算して、
コリジョン時間を見積もります。

nParticle の作成スクリプトが他のコマンドをコールする

nParticleコマンド、particleFillコマンド、または NCreateEmitterスクリ
プトを使用すると、evalDeferredがある下位レベルのスクリプトがコールされ
ます。スクリプトでこれらのコマンドを使用し、同じスクリプトでパーティクル
単位のダイナミックアトリビュートにアクセスする場合は、最初に延期された
コマンドを更新できるようにする必要があります。

解決方法

各 evalDeferredをリストしたコマンドを挿入して、延期されているすべてのコ
マンドを一掃します。
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Maya ファー

ファーに関する一般的な制限事項
paintFX ストロークスタンプ上のファースタンプをレンダリングすると予
期しない結果になる

paintFX スタンプ上のファースタンプは、カメラでレンダリングすると予期しな
い結果になります。

解決方法

この問題を解決するには、カメラを新規作成して不具合が生じたカメラの代わり
に使用します。

PolySmooth ノードが原因でファーにフリッカが発生する

Maya 6.5 より前のファイルに、スキニング後にポリゴンのスムースが適用された
ポリゴンオブジェクトが含まれていて、UV のスムース（Smooth UVs）オプショ
ンがオンにされている場合、レンダリングしたファーのアニメーションまたはモー
ションブラーにフリッカが発生します。

解決方法

これを修正するには、スクリプトエディタ（Script Editor）で setAttr

smoothNode.ma 1;を実行し、スムースノードの UV のスムース（Smooth UV ）
をオフにします。

これは、UV のスムースがオフになっている限り、Maya 6.5 で作成したシーン
ファイルでは発生しません。
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弦の高さの比率（Chord Height Ratio）を使用するとファーがフリップす
る

マルチフレームレンダリングのフレームの一部で、弦の高さの比率を使用（Use
Chord Height Ratio）がオンになっている NURBS サーフェスに適用されたファー
がフリップし、反対の方向を向く可能性があります。弦の高さの比率アトリビュー
トは、アトリビュートエディタ（Attribute Editor）の高度テッセレーション
（Advanced Tessellation）セクションの二次テッセレーション（Secondary
Tessellation Attributes）にあります。レンダリングの前に、弦の高さの比率を
使用がオンに設定されていないことを確認してください。

ファーでボリュームライトが認識されない

ファーではボリュームライトは認識されません。つまり、ボリュームライトか
ら放射されたライトがファーのレンダリングに影響を与えることはありません。

高解像度でレンダリングする

8000 × 8000 よりも高い解像度でレンダリングする場合、ファーはメモリ不足に
なります。これについては、解決方法はありません。

Maya ソフトウェアレンダラでファーをレンダ
リングするときの制限事項

1 次 NURBS サーフェスが極端に細かくテッセレーションされる

1 次 NURBS サーフェスをファー用にテッセレーションすると、極端に重いジオ
メトリが作成されて処理に時間がかかり、大きな中間ファイルが作成されます。

解決方法

ジオメトリをポリゴンに変換します。

正射投影ビューでファーが正しくレンダリングされない

Maya ソフトウェアレンダラでの正射投影ビューでは、ファーが正しいサイズ
でレンダリングされません。

解決方法

mental images® mental ray® for Maya でファーをレンダーしてください。
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ファーでフィールドレンダリングがサポートされていない

Maya でフィールドレンダリング（Field Rendering）をオンに切り替えても、
ファーがそれを無視してフレームをレンダリングします。

解決方法

フレーム間隔（By Frame）の値を 0.5 に設定してレンダリングし、合成パッケー
ジでインタレースしてください。

カメラを負にスケールするとファーがまったくレンダリングされない

負にスケールされたカメラでは、ファーをレンダリングできません。

スポットライトで周縁部の角度（Penumbra Angle）が設定されている場
合にファーがグリッドとしてレンダリングされる

シャドウマップを含むスポットライトに周縁部の角度が設定されていると、
ファーがグリッドとしてレンダリングされることがあります。

解決方法

周縁部の角度の値を 0 に設定します。代わりに、グリッドアーティファクトが
表示されなくなるまで、シャドウマップのサイズを拡大します。

ファーでは 16 ビットフォーマットはまったくサポートされていない

ファーでは 16 ビットフォーマットはまったくサポートされていません。

解決方法

ファーは、16 ビットファイルフォーマットにレンダリングしたときに正しく合
成されます。ただし、ファーのパス自体は 8 ビットのままです。レンダリング
イメージのフォーマットを、サポートされているイメージフォーマットに設定
してください。

または mental ray for Maya でレンダーします。

スポットライトの周縁部の角度アトリビュートとドロップオフアトリ
ビュートをファーシャドウに適用するときの注意

ファーシャドウマップを使用するときもスポットライトの周縁部の角度アトリ
ビュートとドロップオフアトリビュートを設定できますが、ファーシャドウは
これらのアトリビュート値によって影響を受けないため、ファーシャドウの輝
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度は減衰しません。そのため、エッジ付近のファーのシャドウが鮮明過ぎる場合
があります。

ファーではテクスチャマッピングされたライトがサポートされていない

ファーでは、テクスチャマッピングされたライトはサポートされていません。

解決方法

mental ray for Maya でレンダーします。

弦の高さの比率（Chord Height Ratio）を使用するとファーがフリップす
る

マルチフレームレンダリングのフレームの一部で、弦の高さの比率を使用（Use
Chord Height Ratio）がオンになっている NURBS サーフェスに適用されたファー
がフリップし、反対の方向を向く可能性があります。弦の高さの比率アトリビュー
トは、アトリビュートエディタ（Attribute Editor）の高度テッセレーション
（Advanced Tessellation）セクションの二次テッセレーション（Secondary
Tessellation Attributes）にあります。

解決方法

レンダリングの前に、弦の高さの比率を使用がオンに設定されていないことを確
認してください。

非常に大きなシャドウマップでファーをレンダリングするとメモリ不足
になることがある

非常に大きなシャドウマップでファーをレンダリングすると、メモリ不足にな
ります。

解決方法

シャドウマップのサイズかファーグローバル（Fur Globals）でシャドウマッ
プレンダリング（Shadow Map Rendering）のヘア/ピクセル（Hairs/Pixel）
値、またはその両方を小さくします。
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mental ray for Maya でファーをレンダリングす
るときの制限事項

インスタンスオブジェクト上のファーがレンダリングされない

複製オプションで以下でグループ化 > 新規グループ（Group Under > New Group）
が選択されていると、インスタンスオブジェクト上のファーは mental ray for
Maya でレンダリングできません。

モーションブラーが機能しない

セグメントアトリビュートをキーフレーム設定していると、mental ray for Maya
ではモーションブラーが無効になります。
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Maya Live

シーンに関する一般的な制限事項
Autodesk® Maya® Live™を使ったシーンの一般的な問題に関する制限事項とその
解決方法について次に説明します。

距離の値が強制的にゼロに設定される

Survey パネルで値を Distance Constraints に設定すると、ゼロにリセットされる
ことがあります。

解決方法

アトリビュートエディタ（Attribute Editor）で、または MEL コマンドを使用し
て目的の値を入力してください。

Maya Live プラグインをロードする前にファイルを開くとエラーになる

Maya Live プラグインをロードする前に Maya Live ファイルを開くと、エラーが
発生します。

解決方法

Maya Live で作業を開始する前に、Maya Live プラグインをロードしてください。

Live ウィンドウのサイズ変更

ウィンドウの寸法を小さくすると、Maya Live 機能の一部がビューの範囲外に出
てしまいます。
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解決方法

すべてのオプションが使用できるようにするには、Maya Live を全画面表示して
使用します。

変更の保存プロンプト

Scene > New Matchmove を選択すると、シーンを変更しなかった場合でも、変
更の保存を促すプロンプトが表示されることがあります。

セットアップの制限事項
Maya Live を使ったセットアップの問題に関する制限事項と解決方法について次
に説明します。

Softimage イメージファイルの表示

Use Cache チェックボックスがオフの場合、拡張子が .pic ではない Avid®

Softimage® イメージファイルは表示されません。

解決方法

イメージ名を変更して .pic 拡張子をつけるか、別のフォーマットに変更するか、
Setup Cache コントロールパネルで Use Cache チェックボックスをオンにして
ください。

イメージプレーンストリーク

イメージがイメージプレーンに正しく表示されず、イメージの右側にあるピク
セルがストリークとして表示されることがあります。

解決方法

この問題は、マシンに十分なテクスチャメモリがない場合に発生します。Setup
Cache コントロールパネルを開き、Texture Method パラメータで None を選
択してください。

トラックの制限事項
Maya Live を使ったトラックの問題に関する制限事項と解決方法について次に説
明します。
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トラックポイントの削除

ソリューションで使用されたトラックポイントの削除を元に戻すと、コネクト
される 3D ロケータしか再表示されません。

解決方法

もう一度、編集 > 元に戻す（Edit > Undo）を選択して、トラックポイントを元
に戻してください。

トラックフィールドの操作

pointCenteredCamera ビューパネルで、トラックフィールドの選択やサイズ
変更が難しい場合があります。

トラックフィールドの配置からのメッセージ

トラックフィールドを配置すると、スクリプトエディタ（Script Editor）に次
のメッセージが表示されます。

// Undo: dragTrackedPoint_doDrag //.

解決方法

このメッセージは無視してください。

トラックポイント名のリフレッシュ

コントロールパネルのトラックポイントや調査コンストレインの名前を変更し
ても、ビューパネルでラベル名は変更されません。

解決方法

次にビューパネルがリフレッシュされるのを待ちます。

選択が解除されたトラックフィールドツール

シーンを保存すると、トラックフィールドツールの選択が解除されます。

解決方法

ポイントをドラッグする必要がある場合は、トラックフィールドツールを再度
選択してください。
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Ready-To-Solve バーが赤のままになる

As Object チェックボックスを使用してオブジェクトモーションを解決するた
めに準備した場合、Track Summary の Ready-To-Solve インジケータは赤のま
まになります。これは、Ready-To-Solve インジケータがカメラのソルバ寄与度
に基づいていることが原因です。

解決方法

赤いインジケータを無視して、Solve タスクを続けてください。

ソルバの制限事項
Maya Live を使ったソルバの問題に関する制限事項と解決方法について次に説明
します。

Start、Continue、Refine を元に戻す

Start、Continue、または Refine 手順を元に戻すと、エラーが発生します。

解決方法

編集 > 元に戻す（Edit > Undo）を選択する前に、結果として求められたソリュー
ションを削除してください。

ルートフレームソルバのエラー

ルートフレームソルバでエラーが発生し、スクリプトエディタ（Script Editor）
に次のメッセージが表示されることがあります。

// Error; // Exception. // // Error; // Solve Failed. //

解決方法

もう一度、Solve または Start をクリックすると、ソルバが動作します。

Playblast フレーム範囲

Solve コントロールパネルの Playblast ボタンを押すと、Solve コントロールパ
ネルで指定されたフレームではなく、フレーム範囲全体が再生されます。
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解決方法

代わりに、タイムスライダバーでフレーム範囲を選択してください。

調査コンストレイン可変フィールド

調査コンストレイン可変フィールドのいずれかに 0 を入力すると、ソルバのパ
フォーマンスが低下します。

解決方法

調査コンストレイン可変フィールドには 0 を入力しないでください。
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Maya 流体エフェクト

流体エフェクトの制限事項
温度の乱気流を使用する流体と下位互換性

温度の乱気流を使用した 7.0.1 以前の古い流体がある場合、下位互換性の問題によ
り、そのシミュレーションが再生するごとに異なって再生されます。

解決方法

このランダムな動作をそのままにしたくなければ、温度の乱気流を使用している
各 fluidShape に対して次の MEL スクリプトを実行します。

setAttr fluidShape.usePre70Dynamics false;

同じ名前の流体によってキャッシュの問題が発生する

シーンに 2 つ以上の流体があり、その fluidShapeノードの名前が同じ場合、こ
れらの流体に対して流体キャッシュが正しく動作しないことがあります。

解決方法

シーンの流体ノードをキャッシュするつもりであれば、そのノードに必ず固有の
名前を付けてください。

流体キャッシュノードに間違った名前が付けられる

関連する流体やネームスペースにある流体に対してキャッシュや最初の状態を作
成すると、キャッシュノードに間違った名前が付けられます。たとえば、
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fluffy:fluidShape1 に対してキャッシュを作成すると、キャッシュノードの名前
は fluidShape1 になります。

解決方法

キャッシュノードを initialState_fluidShape1 か cache_fluidShape1 か適切な
名前に変更します。

マージした流体 nCache のソースキャッシュは無効化または削除する必
要がある

流体 nCache をマージする場合、各ソースキャッシュファイルを無効化または
削除する必要があります。無効化または削除しないと、キャッシュされた流体シ
ミュレーションが意図したとおりに再生されない場合があります。

解決方法

次のいずれかを実行して、ソース流体キャッシュを無効化または削除します。

■ キャッシュを無効化するには、流体オブジェクトを選択し、ダイナミクス
（Dynamics）メニューセットから流体 nCache > 選択項目にあるすべての
キャッシュの無効化（Fluid nCache > Disable All Caches On Selected）を
選択します。

■ ソースキャッシュクリップをマージ後に削除するには、流体キャッシュの
マージ オプション（Merge Fluid Cache Options）ウィンドウで、キャッ
シュ: マージ後に既存のキャッシュを削除（Cache: Delete existing caches
after merge）を選択します。

複数の流体オブジェクトを含む流体キャッシュファイルが意図したとお
りに再生されない

複数のキャッシュされた流体オブジェクトを含む流体キャッシュファイルは意
図したとおりに再生されない場合があります。特に、キャッシュを他の流体
nCache ファイルとブレンドやマージした場合に起こります。

解決方法

キャッシュファイルに含まれる流体オブジェクトが 1 つになるよう、各流体オ
ブジェクトを個別に選択してキャッシュします。
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バッチレンダー時に、欠落した流体キャッシュが再シミュレートされな
い

キャッシュからのバッチレンダー時に、流体キャッシュが見つからない場合に
再シミュレートを試行しなくなりました。流体 nCache では、流体キャッシュ
ファイルが見つからないことを示すエラーメッセージが表示されます。この動
作は旧バージョンの流体キャッシングとは異なります。

既存の流体キャッシュをアタッチするとき、キャッシュされたチャンネ
ルが正しくアタッチされない

既存キャッシュ ファイルのアタッチ（Attach Existing Cache File）を使用して
既存の流体キャッシュファイルをアタッチすると、キャッシュファイルの全チャ
ンネルがアタッチされません。アタッチするキャッシュが流体にコネクトされた
キャッシュノードと同じチャンネルを持つ場合であっても、チャンネルの名前
が完全に指定されていないため、密度（Density）データ（1 番目のチャンネル）
のみが流体に送られます。

解決方法

キャッシュするチャンネルを、コネクトした順序で指定します。各チャンネルの
フルネームを、XML ファイルにリスト表示されたとおりに指定してください。
例:

setAttr -typ "string" fluidShape1Cache1.channel[0]

"fluidShape1_density";

setAttr -typ "string" fluidShape1Cache1.channel[1]

"fluidShape1_velocity";

アタッチしたキャッシュに追加のチャンネルが含まれる場合は、ハイパーグラフ
（Hypergraph）を開き、各チャンネルに関連付けられた名前を確認します。

キャッシュにアペンド（Append to Cache）が、シミュレートされてい
ないペイント済みの流体フレームに対しては機能しない

関連する制限事項は次の 2 つです。

■ キャッシュにアペンド（Append to Cache）（流体 nCache > キャッシュに
アペンド（Fluid nCache > Append to Cache））は、流体ペイント ツール
（Paint Fluids Tool）を使用してペイントした、シミュレートされていない
流体フレームに対しては機能しません。ペイント済みキャッシュフレームを
アペンドするには、キャッシュフレームの置き換え（Replace Cache Frame）
を使用する必要があります。
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■ ペイント済みキャッシュフレームの置き換えは、流体キャッシュ フレーム
の置き換えオプション（Replace Fluid Cache Frame(s) Options）ウィンド
ウを開いている場合のみに機能します。

解決方法

ペイント済みまたはインポート済みのフレームを流体キャッシュの最後にアペン
ドするには、次の操作を行います。

1 未修正フレームをアペンドします（流体 nCache > キャッシュにアペンド
（Fluid nCache > Append to Cache））。

2 フレームを適宜に修正します。

3 流体 nCache > キャッシュ フレームの置き換え（Fluid nCache > Replace

Cache Frame） を選択して、アペンドしたフレームを置き換えます。

フレームの置き換え操作を有効にするには、流体キャッシュ フレームの置
き換えオプション（Replace Fluid Cache Frame(s) Options）ウィンドウを
開いた状態にしておく必要があります。

4 置き換え（Replace）をクリックします。

MR レンダリングで流体の名前が適切に読み込まれない

流体の名前が固有でない場合、mental ray for Maya でアニメーションが適切に
レンダリングされません。

解決方法

シーン内の各流体シェイプには、必ず固有の名前を付けてください。また、流体
を複製する場合は、子ノードに固有の名前を割り当てる（Assign Unique Name
to Child Nodes）を必ずオンにしてください。

流体テクスチャが更新されない

流体が outColor にコネクトされていない場合、流体テクスチャは更新されませ
ん。流体が outAlpha にのみコネクトされている場合に mental ray for Maya で
レンダリングしても、流体は更新されません。

解決方法

流体テクスチャとシェーダの間に輝度ノードを挿入します。
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不透明度テクスチャ（Opacity Texture）でサーフェスシェーディングさ
れた 3D 流体がソフトウェアレンダーでは異なって表示される

ドロップオフシェイプ（Dropoff Shape）がオフであるか、またはエッジのド
ロップオフ（Edge Dropoff）が 0 で、3D 流体が境界ボクセルで（サーフェスし
きい値より大きい）密度を持っている場合、ハードウェア描画では外側の境界は
表示されません。

解決方法

ハードウェア描画で外の境界を表示する場合は、ドロップオフシェイプを立方
体に設定し、エッジのドロップオフを 0.01 に設定します。

2D テクスチャの衝突が一部の領域で消える

流体は、衝突オブジェクトの周囲の領域には入りません。

解決方法

ポリゴンメニューセットでメッシュ > 三角化（Mesh > Triangulate）を使用し
て、ポリゴンメッシュを明示的に三角分割します。

エクスポートしたファイルで流体オブジェクトがレンダリングされない

入力をオフにした状態で流体をエクスポートした場合、流体から流体自体への
シェーディングコネクションが失われることがあり、流体はレンダリングされ
なくなります。

解決方法

ハイパーシェード（Hypershade）を開き、流体自体に fluidShape を割り当てる
と、流体は再度レンダリングされます。

リファレンスファイルの初期状態のキャッシュが親ファイルから変更さ
れる

リファレンスファイルに初期状態のキャッシュがあると、それを親ファイルか
ら変更できます。

解決方法

ペイントしたり初期状態を保存したりして（するつもりがなくても）変更しない
でください。
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フローティングオブジェクトのアニメーションの制限事項

フローティングオブジェクトのアニメーションは、単位がセンチメートルの場
合のみ正しく動作します。

解決方法

関連するロケータシェイプ上の追加のアトリビュート（Extra Attributes）を見
て、単位の変更を補正するように変更します。シーンスケール（Scene Scale）
は通常は海洋シェーダ（Ocean Shader）のスケール（Scale)アトリビュートに合
わせるために使用しますが、センチメートルに対して単位を補正するために使用
することもできます。または、重力やその他の物理定数を変更して、目的の動き
をセンチメートル以外の単位でも得ることができます。

イメージプレーンのアルファは、ボリューム流体と使用すると増加する

ボリューム流体で使用するとイメージプレーンのアルファが増加します。

解決方法

次のようにレンダリングをやり直してください。

1 イメージプレーンのカラーゲイン（Color Gain）を 0 に、カラーオフセッ
ト（Color Offset）を 1 に設定してください。

2 流体ノードのカラーランプを真っ黒に設定してから白熱光のランプを白に
設定してください。

string 型や enums 型とは異なる複合型アトリビュートプリセットのブレ
ンディングカットオフ

ランプアトリビュートのあるノードにブレンディングを伴うアトリビュートプ
リセットを適用するときに、対応するランプのエントリが 1 対 1 に対応してい
ない場合、予期せぬ結果が生じることがあります。満足する結果が得られない場
合は、手動で修正する必要があります。このようなブレンドを元に戻すと、位置
と値が 0 の余分なインデックスエントリが作られることがあります。余分なエ
ントリは削除してください。

海洋（Ocean）シェーダ: 海洋シェーダからループするタイリングテクス
チャをどのように作成するか

海洋シェーダをループさせる方法について詳しく説明します: LOOP_FRAMES は
任意の数値で、アニメーションをループさせるフレーム数です。
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1 海洋または海洋シェーダを作成します。周波数の値（numFrequencies）と
波の高さ（waveHeight）をどちらも 0 に設定すると、海が完全に平坦にな
り、レンダリングしやすくなります。

2 海洋シェーダの波の高さのオフセット（waveHeightOffset）に、海洋テク
スチャ（Ocean Texture）を、投影（Projection）を ON、新規テクスチャ
配置ノードと同時作成（newTexturePlacement）を OFF に設定してマッピ
ングします。投影の回転 X（rotateX）を 90 に設定します。

3 このテクスチャのカラーオフセット（colorOffset）に、別の海洋テクス
チャを、投影を OFF、新規テクスチャ配置を OFF に設定してマッピングし
ます。

4 一方の開始が他方の終了と一致するような 2 つの海洋テクスチャのタイム
値をアニメートします。

oceanTexture1 の時間（time）フィールドに次のように入力します。

=frame/30 （時間パラメータは一般的に、フレームではなく秒で指定しま
す）。

oceanTexture2 の時間フィールドに次のように入力します。

=(frame -LOOP_FRAMES)/30

5 クロスディゾルブを実施するために、2 つのテクスチャの波の高さ
（waveHeight）に次のようなアニメーションキーを設定します。

oceanTexture1 の１フレーム目 = 希望値、LOOP_FRAMES フレーム目 = 0

oceanTexture2 の1フレーム目 = 0、LOOP_FRAMES フレーム目 = 希望値

これで海洋アニメーションが上記の LOOP_FRAMES で指定したフレーム数に
渡ってループするはずです。これを 2 つの海洋テクスチャに適用するには同じ
値を設定する必要があります（波の高さと時間を除く）。この方法では、
heightfield ノードを使用した海洋ディスプレイスメントをプレビューできませ
ん（ディスプレイスメントをポリゴンに変換すればプレビューできるようになり
ます）。また、ブイとボードは波の高さでアニメートできません（現在、海洋
シェーダでのテクスチャマッピングでは、これらのエフェクトは考慮されませ
ん）。
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海洋の水平線の外観

大きい海洋オブジェクトを mental ray for Maya レンダラまたは Maya レンダ
ラのいずれかでレンダーした場合、水平線近くでぼやけて表示されることがあり
ます。

解決方法

水平線フィルタ（Horizon Filter）の値を 1.0 から 0.1 に下げます。

海洋の水平線と波

水平線が波に覆い隠されるようにカメラが配置された場合、波にラインアーティ
ファクトが表示されることがあります。

解決方法
■ 水平線フィルタ（Horizon Filter）の値を 0 にします。海洋の水平線に沿っ

たジッターを防ぐには、より高いアンチエイリアス設定が必要になる場合が
あります。

■ mental ray for Maya レンダラでシーンをレンダーします。

複数のライトを使用して流体オブジェクトを照らすと、ライトの強度が
増加する

複数のライトを使用して流体オブジェクトを含むシーンを照らすと、各ライトの
強度が誤って増加します。

解決方法
1 流体オブジェクト専用のライトを個別に作成します。

2 ライト リンク（Light Linking）のリレーションシップ エディタ
（Relationship Editor）（ウィンドウ > リレーションシップ エディタ > ラ
イト リンク（Window > Relationship Editors > Light Linking））を使用
して、ライトを流体オブジェクトにリンクします。

3 各ライトの強度を適宜に調整します。
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ボリュームライトのアンビエントの放出（Emit Ambient）アトリビュー
トが IPR 内で更新されない

IPR 実行中にアンビエントの放出アトリビュートを選択しても、最新の結果は得
られません。

解決方法

このレンダーを更新するには、領域を選択し直すか、別のアトリビュートを変更
します。

マルチプロセッサでの流体レンダリングでアーティファクトが生じるこ
とがある

流体のレンダリングに 4 つを超えるプロセッサを使用すると、アーティファク
トが生じることがあります。

解決方法

プロセッサの数を 4 つ以下に減らしてから、もう一度実行してください。

テクスチャがオリジナルの位置に戻らない

テクスチャ（Texture）の座標の設定方法（Coordinate Method）がグリッド
（grid）に設定されている状態で、自動保存をオンにして流体をペイントした場
合、テクスチャは元の位置には戻りません。

解決方法

元に戻すを実行して、座標の設定方法を固定型（fixed）に変更してから、もう
一度グリッドに戻してください。不要なグリッドを保存するのは避け、どのグ
リッドを保存する必要があるかを指定するように初期状態の保存オプションが設
定されていることを確認してください。

流体をレンダリングしたサーフェスにセルフシャドウを適用すると、予
期せぬ結果が生じる

流体をレンダリングしたサーフェスにセルフシャドウを適用すると、予期せぬ
暗い領域やアーティファクトが生じることがあります。
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解決方法

これは流体に透明度がない場合のみ発生します。アーティファクトが生じなくな
るまで、精度を上げてください。また、透明度に 0 以外の値を設定しても、予
想通りの結果が得られます。

キャッシングを使用した場合のハードウェアディスプレイの問題

アトリビュートエディタで、ノードの動作 > キャッシング（Node Behaviour >
Caching）がオンの場合、ハードウェアディスプレイで予期せぬ結果となるこ
とがあります。

解決方法

流体エフェクトでは、ノードの動作 > キャッシング（Node Behaviour >
Caching）をオンにしないでください。オフにしてからファイルを保存し、
Autodesk® Maya® を再起動してください。

流体サーフェスのデプスバッファが正確ではない

デプス出力を持つ流体とサーフェススタイルの流体をレンダリングする場合、
特に、流体サーフェスの透明度が 0 の場合、デブスバッファにサーフェスが正
しく表示されると考えられます。デフォルトでは、デプスバッファには何も表
示されません。デプス出力で流体を表示するには、カメラのデプスタイプを最
も近い可視デプスに設定する必要があります。ただし、デプスの値はブロッビ
サーフェスの実際のデプスではなく、流体バウンドとほとんど交差します。この
結果、流体バウンドでのオブジェクト（またはペイントエフェクト）の合成で
問題が発生します。

解決方法

ボリュームサンプルオーバーライド（volumeSamplesOverride）を有効にし、
流体シェイプでボリュームサンプルを増やすことにより、正しいデプスに近づ
けることができます。ただし、この結果、サーフェスタイプの流体を持つアー
ティファクトが作成され、レンダリング時間が長くなる可能性があります。

ボクセルが小さすぎると流体ワイヤフレームの描画（パーティクル）が
機能しない

解像度の値が低い場合、流体（Fluid）ワイヤフレームの描画（パーティクル）
には何も表示されません。

136 | 第 20 章   Maya 流体エフェクト



解決方法

シェーディングモードまたは長方形を使用してください。

ノードに複合型アトリビュートがあると部分的なプリセットを作成でき
ない

ノードのアトリビュートのサブセットだけが含まれるようにプリセットファイ
ルを編集したくなるかもしれませんが、複合型アトリビュートを持つノードにプ
リセットを適用すると、まずこのアトリビュートがすべて空にされ、このアトリ
ビュートにプリセットからエントリが追加されます。これらのファイル、特に、
ランプのような複合型アトリビュートのエントリは変更しないでください。

流体をスムース補間された穴が多数あるポリゴンに変換する

流体をスムース補間したポリゴンを変換すると、メッシュに穴が開いてしまうこ
とがよくあります。

解決方法

リニア補間を使用して、頂点を平均化します。スムース補間を使用する場合は、
境界が非多様体頂点を持つ場合を除き、穴を埋める（fillHole）を使用してこれ
らの穴に対処することができます。この場合、ジオメトリが非多様体ではなくな
るまで、しきい値を上げることをお勧めします。

サーフェスレンダリングされた 2D 流体イメージが、ディスプレイ: レン
ダリングのまま（Display: As Render）と一致しない

2D 流体のサーフェスのレンダリング結果は、ディスプレイ: レンダリングのま
ま（Display: As Render）モードで表示された流体と同じようにならないことが
あります。

■ ドロップオフシェイプ（Droppoff Shape）のコーン（Cone）およびダブル
コーン（Double Cone）がキャップされないので、両端が開いた状態のまま
になっています。これは故意に行われています。

■ 2D 流体では、デプスに沿って十分な三角形が生成されないので、球体
（Sphere）はシリンダ、コーン（Cone）は 2 つのシリンダの集まりのよう
に見えます。

■ ドロップオフシェイプがオフの場合、またはエッジドロップオフが 0 の場
合、シェイプに関係なく結果はリボン状になります。
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ノイズとボリュームオブジェクト

ボリューメトリックオブジェクトで 2D テクスチャを使用する場合、テクスチャ
は投影として使用する必要があります。

Maya をアンインストールしても古いプリセットが削除されない

プリセットフォルダに独自のプリセットを追加した場合、Maya をアンインス
トールしても、このプリセットフォルダは削除されません。したがって、たと
えば、ベータサイトとして Maya の古いバージョンを以前インストールしてい
た場合、正しく動作しない古いプリセットの一部が、新しいインストールに残っ
ている可能性があります。

解決方法

古いプリセットフォルダを手動で削除するか、インストール場所から必要のな
いプリセットだけを削除してから、Maya を再度インストールしてください。
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Maya ヘア

ヘアに関する制限事項
固さのスケール（Stiffness Scale）がカーブの引き付けに影響しない

Maya 2009 では、固さのスケール（Stiffness Scale）がカーブの引き付けに影響し
なくなりました。代わりに、新しい引き付けスケール（Attraction Scale）のラン
プを使用して、単一のヘアグループまたはヘアシステム全体の長さに沿って開始
カーブに引き付け（Start Curve Attract）の値を制御できます。つまり、Maya
2008 以前のシーンファイルのヘアのうち、固さのスケール（Stiffness Scale）に
デフォルト以外の値を使用するものの動作が変更されます。

ヘアの幅が mental ray for Maya で正しくレンダーされない

mental ray for Maya でヘアをレンダーすると、ヘアの幅はヘアグループの幅に
対して定義されますが、Maya インタラクティブとソフトウェアレンダラではそ
のヘアの幅を直接ワールド空間で使用します。

解決方法

ヘアの幅を変更してから、mental ray for Maya でレンダーします。ヘアグルー
プの幅をヘアグループの幅係数（Clump Width Mult）を使用して毛根ごとに変
更している場合は、サイズの異なるヘアグループを別のヘアシステムに入れる
か、ヘアの配置をコントロールする生え具合マップ（Baldness Map）のような代
替方法を使用する必要があります。
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IK ソルバによりヘアレンダリングがクラッシュする

使用しているモードで IK ソルバに影響するダイナミックカーブがある場合、
Linux® 版の mental images® mental ray® for Maya でレンダリングを行うと、
クラッシュすることがあります。

解決方法

レンダリングをする前に IK をベイク処理し、IK ソルバが有効になっていないこ
とを確認してください。

ヘアの 3D モーションブラー

細線のブラシタイプがヘアの内部デフォルトブラシとして使用されると、3D
モーションブラーがサポートされません。

解決方法

ヘアシステムにペイントエフェクトブラシを割り当て、ペイント（Paint）ブラ
シタイプ（ブラシタイプ（Brush Type）= ペイント）を使用することができま
す。ペイント ブラシタイプを使用するとレンダリングが遅くなること、また、
遠くから見たときにヘアが非常に密に見える場合があることに注意してくださ
い。

注: 2D モーションブラーは、ヘアと細線（ThinLine）ブラシタイプに機能しま
す。

オーバーサンプリングとアンダーサンプリングに起因するシミュレーショ
ンレートの問題

シミュレーションレートはヘアソルバのオーバーサンプリングには影響しませ
んが、アンダーサンプリングによりモーションのスピードが劇的に変化します。

解決方法

ヘアをキャッシュしている場合はオーバーサンプリングまたはアンダーサンプリ
ングはせず、また再生レートを変更しないでください。時間単位を変更する場合
は、ヘアシステムのダイナミックプロパティを変更して補正する必要がありま
す。

長さのロック（Lock Length）がクラスタで機能しない

長さのロックはクラスタや他のデフォーマでは機能しません。
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長さのロックの使用中に元に戻す（Undo）が機能しない

長さのロックの使用中は、元に戻すを使ってもカーブを元の位置に戻すことはで
きません。

注: 長さのロックは CV をトランスフォームしている間の使用を対象としていま
す。他のアニメーションテクニックとの連動は現在はサポートされていません。
長さのロックをオンにしてカーブを編集する前に保存しておきます。

リファレンスされたヘアシステムで現在位置からレストカーブまたは開
始カーブの設定が機能しない

リファレンスされたヘアシステムで現在位置からレストカーブまたは開始カー
ブの設定が機能しません。

解決方法

代わりにリファレンスファイルでレストカーブまたは開始カーブを変更します。

固有でないヘアカーブ名とネームスペースでの問題

ネームスペースを使って同じカーブ名の複数のヘアシステムをインポートする
と、レスト位置の設定（set Rest Position）および開始位置の設定（set Start
Position）はカーブを区別することができません。

解決方法

一般的にはネームスペースの使用を推奨しますが、この場合には、名前の衝突を
解決するために、プリフィックス付きのヘアをインポートする方がよいでしょ
う。

重力がヘアで機能しない

Z アップシステムでは、重力がヘアでうまく動作しません。

解決方法

組み込みの重力の代わりに重力フィールドを使用します。

デフォルトのダイナミックカーブが各エンドで違った動作をする

毛先ポイントのロックはエンド CV の位置にロックしますが、エンドセグメン
トの方向にはロックしません。

ヘアに関する制限事項 | 141



解決方法

ヘアのエンドにトランスフォームコンストレインを適用します。

コリジョンコンストレインでヘアが縮れる

球体のコリジョンコンストレインが均一でなくスケールされ、ある次元が他の
次元よりも薄くなると、コンストレインに触れたときに硬いヘアが縮れます。

解決方法

ヘアの縮れが止まるまで剛性を軽減するか、コンストレインをより均一にスケー
ルします。
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Maya トゥーン

トゥーンに関する制限事項
ライティングベースの幅（Lighting Based Width）とオフセットメッシュ
（Offset Mesh）を組み合わせるとうまく動作しない

トゥーンラインのライティングベースの幅は、オフセットメッシュプロファイ
ルラインをサポートしていません。

解決方法

ライティングベースの幅が必要な場合は、ペイントエフェクトプロファイルを使
用します。

pfxStrokes コマンドが pfxToonShape ノードを完全にはサポートしていな
い

コマンドは pfxToon オブジェクト用のプロファイルカーブを出力しません。

解決方法

ConvertPaintEffectsToCurves を使用してトゥーンアウトライン用の NURBS カー
ブを抽出します。

サーフェスの反転（Reverse Surfaces）がポリゴンでしか動作しない

プロファイルラインに対してオフセットメッシュ（Offset Mesh）でトゥーンラ
インを使用する場合は、サーフェスの反転はポリゴンでのみサポートされます。
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解決方法

NURBS サーフェスとサブディビジョンサーフェスに対して、サーフェスを反転
する必要がある場合は、サーフェスをポリゴンに変換して、ポリゴンサーフェス
上にオフセットメッシュを作成します。NURBS サーフェスに対して、NURBS
サーフェス自身にサーフェス方向の反転（Reverse Surface Direction）を行う方
法もあります。
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トランスレータとプラッ
トフォーム固有の情報

トランスレータの制限事項
Maya のトランスレータ機能に関する制限事項と解決方法を次に説明します。

StudioImport の制限事項
（StudioImport）StudioTools のエイムコンストレインに異なる軸を使用
する

1 つのオブジェクトのエイムコンストレインに異なる複数の軸が使用されている
場合、それらのエイムコンストレインを Maya に取り込むと、同じ軸（オブジェ
クトの最初のエイムコンストレインで使用される軸）が共有されるようになりま
す。

（StudioImport）StudioTools のフェースがトリムしたサーフェスになる

StudioTools のフェースを Maya に取り込むと、トリムサーフェスになります。
このトリムサーフェスは元のフェースと外観が異なる場合があります。

（StudioImport）Maya に変換するときに srand（seed）が rand（seed）
で置き換えられる

srand（seed）関数を使用するエクスプレッションを Maya に移動すると、srand
（seed）が rand（seed）で置き換えられます。
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解決方法

0 から 1 までの乱数が必要な場合には、「rand（seed）」を「rand（1）」に置
き換えてください。エクスプレッションの乱数のシードを変更したい場合には、
Maya で使用可能な「seed」関数を使用してください。

（StudioImport）StudioTools のカラー（color）アトリビュートに割り当
てられたテクスチャがすべてのレンダリング可能なカメラのイメージプ
レーンになる

StudioTools 環境のカラーアトリビュートに割り当てられたテクスチャは、すべ
てのレンダリング可能なカメラのイメージプレーンになります。このイメージ
プレーンのサイズは必ずしも正しいとは限りません。

解決方法

イメージプレーンのサイズを適切に調整してください。

（StudioImport）ライト（Light）のグローが StudioTools と Maya 間で完
全には変換されない

ライトのグローは、StudioTools と Maya 間で完全には変換されません。ライト
の 2 つの主要なコンポーネントは、強度（intensity）と減衰値（decay）です。
StudioTools ライトの強度が 1.0、減衰値が 0 であれば、特に問題はありませ
ん。

解決方法

StudioTools と Maya 間でライトのグローを完全に一致させるには、Maya ライ
トの強度を次の式に従って調整してください。

glow_intensity = original_glow_intensity * light_intensity / decay

減衰値の値:

■ 1: 減衰値が「なし」の場合

■ light_decay: 減衰値が 1 の場合

■ light_decay**2: 減衰値が 2 の場合

■ light_decay**3: 減衰値が 3 の場合
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（StudioImport）StudioTools のレイヤシェーダ用に Maya で作成された
レイヤシェーダ

StudioTools で複数のシェーダが単一のオブジェクト上にレイヤ化されている場
合は、それらのシェーダ用に Maya のレイヤシェーダが明示的に作成されます。

（StudioImport）StudioTools のイメージプレーンの配置

StudioTools のイメージプレーンの配置を正しく変換するには、StudioTools の
パース ビューの解像度をデフォルトのレンダリング解像度と同じに設定し、イ
メージ空間のタイプとして スクリーン（Screen） を選択します。

（StudioImport）StudioTools の変換制限がある背景イメージと背景カ
ラーのテクスチャ

StudioTools 環境の背景カラーのテクスチャと背景イメージは、Maya のレンダ
リング可能なカメラのイメージプレーンに変換されます。背景イメージ用のイ
メージプレーンのデプスは、ファークリッピングプレーンの 90% に設定され
ます。背景カラーテクスチャ用のイメージプレーンのデプスは、ファークリッ
ピングプレーンの 95% に設定されます。

（StudioImport）変換中のアニメーションシーケンス番号の脱落

StudioTools のイメージファイル名の末尾に追加されるアニメーションシーケ
ンス番号が、Maya への移動中に失われる場合があります。

（StudioImport）レンダリング設定の変換制限がある StudioTools の開
始/終了（start/end）モード

Maya では、該当するモードがないため、レンダリング設定の開始/終了モード
は移動されません。開始/終了モードを使用すると、Maya に変換後の開始/終了
フレームが StudioTools の元の範囲とはかなり異なる場合があります。

Obj の制限事項
Obj に関する制限事項と解決方法を次に説明します。

OBJ ファイル名には拡張子「.obj」が必要

OBJ ファイルを Maya に認識させるには、ファイル名の拡張子が「.obj」でなけ
ればなりません。
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解決方法

OBJ ファイルの名前の末尾に「.obj」を追加してください。

MTL テクスチャ

MTL テクスチャはファイルテクスチャでのみ機能します。

IGES インポート/エクスポート
レベルマッピングはエクスポートでは機能しない

IGES エクスポートを使用している場合は、レベルマッピング（レイヤ）はサ
ポートされません。

トリムサーフェスに対して、追加のトランスフォームノードが作成され
る

IGES エクスポートを使用する場合には、トリムサーフェスを追加したトランス
フォームノードと一緒にエクスポートされます。

その他のトランスレータ
VRML2、OpenInventor エクスポートを使用すると圧縮が機能しない

Vrml2 のエクスポート（Export Vrml2）および OpenInventor のエクスポート
（Export OpenInventor）で圧縮を使用するには、gzip などの zip ユーティリ
ティが使用しているマシンのパスにインストールされているか確認してくださ
い。

プラットフォーム固有の制限事項

Maya for Windows の制限事項
Maya for Windows の問題に関する制限事項と解決方法を次に説明します。
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（Windows）Maya で切り離されたメニューからメニュー項目を削除す
る

切り離されたメニューからメニュー項目を削除すると、Maya（Windows）がク
ラッシュします。

（Windows）Maya が日本語/マルチバイトパスから起動しない

日本語/マルチバイト文字を含むカスタムの場所に Maya をインストールして起
動しようとすると、Windows ではエラーが返されます。

解決方法

日本語/マルチバイト文字を含むカスタムの場所に Maya をインストールしない
でください。

（Windows）小数点と小数点を表すコンマが混同される

小数点を表すコンマを使用する Windows の地域設定で、小数点を小数点を表す
コンマに置き換えられる場合があります。

解決方法

Windows の地域設定時に、小数点を表すコンマを小数点に置き換えます。

Maya for Linux の制限事項
Maya for Linux の問題に関する制限事項と解決方法を次に説明します。

（Linux）getModifiers コマンドが Linux 上で機能しない

Maya for Linux では、Ctrl キーを押しながらキーを押す操作やマウスのクリッ
クシーケンスが認識されないことがあります。

（Linux）ハードウェアオーバーレイがある場合とない場合で表示が異
なる

ハードウェアオーバーレイがある場合は赤で表示されるものが、ハードウェア
オーバーレイのないカード上では灰色と黒で表示されます。

ハードウェアオーバーレイがない場合、オーバーレイを想定して作成されたプ
ラグインは意図どおりには機能しません。
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（Linux）ドラッグ & ドロップ

デスクトップから Maya へのドラッグ & ドロップが機能しません。

（Linux）ウィンドウサイズ

一部のウィンドウに、高さや幅が初期設定されていません。また、ウィンドウが
デフォルトサイズの場合に、オプションメニューが表示されなかったり読めな
いことがあります。

解決方法

この問題は通常、ウィンドウを最初に開いたときにサイズが前もって設定されて
いなかった場合に発生します。手動でウィンドウのサイズを変更してください。

（Linux）メインウィンドウとスクリプトエディタ（Script Editor）のタ
イトルバーの表示（Show Title Bar）のインタフェースプリファレンス
（Interface Preferences）設定

（ウィンドウ > 設定/プリファレンス > プリファレンス > インタフェース
（Window > Settings/Preferences > Preferences > Interface）これらのウィン
ドウのタイトルバーの状態は、インタフェース: 一般的なインタフェース プリ
ファレンス（Interface: General Interface Preferences）ウィンドウの設定によ
る影響を受けません。

（Linux）Maya ウィンドウが表示されない

Window Manager コントロールパネルで設定されたウィンドウの動作によって
は、フォーカス時やウィンドウ内部をクリックしたときに、ウィンドウが自動的
に一番手前に表示されることがあります。その結果、Maya の子ウィンドウが隠
れて見えなくなります。子ウィンドウが下になり、新しいウィンドウが前面に表
示されます。

解決方法

以下のようにデフォルト設定を変更します。

■ KDE と Gnome については、『インストールとライセンス発行』マニュアル
の「Linux に関するその他の注意事項」を参照してください。
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（Linux） Maya for Linux でムービーファイルの作成がサポートされてい
ない

Maya for Linux ではムービーファイルの作成はサポートされていません。この
ため、プレイブラスト（Playblast）など他の機能の実行も妨げれられます。ま
た、Maya Live pointblasts をムービー形式で出力することもできません。

プレイブラストで一連のイメージを出力して Fcheck を使って再生することはで
きます。

（Linux）ハイパーシェード（Hypershade）で入力コネクションが表示
されない

ハイパーシェードでは、node1 出力を node2 入力にコネクトした場合、node2
の入力矢印をクリックしても入力コネクションの完全なメニューリストが表示
されません。

解決方法

入力矢印ではなく node2 のイメージそのものをクリックします。完全な選択項
目のリストが表示されます。

（Linux）Home 変数が設定されない場合がある

特定の条件下では、Home 環境変数が設定されない場合があり、さまざまなエ
ラーが発生します。

解決方法

Home 環境変数を正しいユーザプロファイルに設定します。

Maya for Mac OS X の制限事項
Maya for Mac OS X の問題に関する制限事項と解決方法を次に説明します。

（Mac OS X）のスナップが有効のままになる

任意のキー（v、c、x など）を押しながらスナップを有効にすると、ホットキー
を放した後もアクティブのままになることがあります。
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解決方法

ホットキーを離してもう一度中マウスボタンをクリックします。

（Mac OS X）G4/ハードウェアレンダリングサポート

最近に改良された Mac 対応のグラフィックスカードを利用できるよう尽力した
結果、G4 プロセッサのマシンでハードウェアレンダリングを使用できないよう
にする必要がありました。

その他のすべての機能は、G4 ベースのマシン上の Mac OS X で問題なく使用で
きますが、ハードウェアレンダリングを実行しようとすると、ハードウェアレ
ンダリングがサポートされていないという警告メッセージが表示されます。

（Mac OS X）Symlinks が /usr/sbin から削除された

Maya の旧バージョンでは、ライセンス発行ソフトウェアと Maya コマンドラ
インソフトウェアの symlink が /usr/sbinにインストールされたため、ユーザ
は端末でコマンドの名前を入力することができました（/usr/sbin/はデフォル
トパスに含まれます）。

この symlink が削除されました。これは、Maya の異なるバージョンをインス
トールした場合やアンインストールを行った場合に、symlink が原因で問題が生
じていたためです。

これらのコマンドライン機能にアクセスするには、ターミナルにフルパスで入
力するか、Maya に同梱のカスタムターミナル（.term）を使用してください。

（Mac OS X）プラグインをインストールするデフォルトディレクトリ

Maya for Mac OS X では、プラグインのインストールディレクトリのデフォル
トとして次のディレクトリが用意されています。

/Users/Shared/Autodesk/maya/2009

『Maya の基本』マニュアルのトピック「プラグインをロード/アンロードする」
を参照してください。

（Mac OS X）Mac OS X 用の機能が Windows や Linux で使用できない

次の機能は Mac OS X では使用できますが、Windows や Linux バージョンの
Maya では使用できません。

■ ホットボックスでのメニューの切り離し
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■ ホットボックスでのメニューの登録

■ QuickTime との統合

■ スクラブ時のタイムラインでのスレッドサウンド再生

■ AppleScript は Maya MEL コマンドを実行し、結果が戻されます（『MEL と
エクスプレッション』マニュアルの「AppleScript から MEL または MEL から
AppleScript をコールする」を参照）。

Mac OS X 用で利用できないサードパーティプログラム
■ モーションキャプチャドライバ

Maya for Mac OS X の制限事項
■ Maya 3.0 以前のファイルの読み込み

（Mac OS X）Mac OS X のファイルが Windows XP で開けない

Maya ASCII ファイルを Macintosh コンピュータと、Maya を実行するその他の
プラットフォームとの間で転送する場合、FTP を ASCII モードで使用する方法
が確実です。

（Mac OS X）MEL でバックスラッシュを使用できない（韓国語および日
本語システムのみ）

解決方法

同じラインに文字列を入力します（バックスラッシュでの行送りは使用しない
でください）。

（Mac OS X）テクスチャ配置マニピュレータが消える

配置を変更すると、テクスチャ配置マニピュレータが表示されなくなります。

解決方法

シーンビューでオブジェクトのない任意の場所で中マウスボタンをクリックす
ると、マニピュレータが表示されます。
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（Mac OS X）Fcheck のスピードボタンが作用しない

Fcheck で、フレームごと（Every Frame）がオンの場合に、スピード（Speed）
ボタン（-、+）を操作しても再生スピードが変わりません。

（Mac OS X）NURBS サーフェスのアイソパラムを選択したときに表示が
おかしくなる

NURBS サーフェスのアイソパラムを選択したときに、おかしなパターンが表示
される場合があります。

解決方法

アイソパラムを再度選択して、パターンを削除します。

（Mac OS X）アトリュビュートの追加（Add Attribute）ウィンドウのタ
ブ機能が期待どおりに動作しないことがある

アトリビュートの追加（Add Attribute）ウィンドウ（アトリビュート エディタ
（Attribute Editor）でアトリビュート > アトリビュートの追加（Attributes >
Add Attributes）を選択）のタブ機能が意図したとおりに動作しない場合があり
ます。

（Mac OS X）FBX 記号がエクスポートされない

独自のプラグインを記述する場合、このサービスパックに含まれる Maya FBX
プラグインのバージョンの記号はエクスポートされないのでご注意ください。

解決方法

http://www.autodesk.co.jp/fbx から Maya FBX プラグインをダウンロードして再
インストールしてください。

（Mac OS X）再生パフォーマンスに関する問題

再生が滑らかでない場合、再生時のスレッド数を変更することをお勧めします。

解決方法

Maya コマンドラインに以下を入力してください:

threadCount -n # of threads
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（Mac OS X）Maya が IGS ファイルフォーマットを認識しない

ファイルブラウザを開き、ファイルの種類（Files of Type）フィールドをIGES_DC
(*iges; *igs) に変更すると、Maya は拡張子が IGS であるファイルを認識しませ
ん。

解決方法

ファイルの拡張子の大文字 .IGS を .igs または .iges に変更します。

（Mac OS X）シェルフコマンドの最後の文字がセミコロン以外の場合に
削除される

最終コマンドの最後の文字がセミコロン以外の .mel ファイルをシェルフに追加
すると、最終コマンドの最後の文字が削除されます。

解決方法

.mel ファイルをスクリプト エディタにロードし、欠落した文字を補ってから再
度 .mel ファイルを保存します。

（Mac OS X）リモートマウントファイルシステムからロードできない

複数のクライアント PC と 1 台のセントラルファイルサーバで構成される環境
では、ファイルサーバからァイルを直接ロードしようとするとエラーが発生し
ます。これは、複数のクライアントが同時に同じファイルをロードしようとし
たときに特に発生します。

解決方法

Maya シーンファイルをファイルサーバからローカルクライアントマシンにコ
ピーしてから開きます。シーンでの作業が終了したら、同じファイルをファイル
サーバにコピーします。

（Mac OS X）IME の変更後にインタラクティブプリミティブの作成が機
能しない

IME モードが EN に設定された JP 環境で Maya を実行する場合、IME モードを
JP に切り替えてから EN に戻すと、インタラクティブ作成（Interactive
Creation）でポリゴンを作成する機能が失われます。
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解決方法

インタラクティブ作成（Interactive Creation）をオフにしてからポリゴンを作
成します。
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Maya コマンド

新しい Maya コマンド
Maya 2010 では、以下の新しい Maya コマンドが追加されました。これらの新し
いコマンドの詳細については、『MEL コマンドリファレンス』（ヘルプ > MEL
コマンドリファレンス（Help > MEL Command Reference））を参照してくださ
い。

■ attributeName

■ containerProxy

■ containerTemplate

■ containerView

■ copyAttr

■ frameBufferName

■ getLastError

■ getProcArguments

■ license

■ nBase

■ particleFill

■ polySelectSp

■ renderPassRegistry

■ reorderContainer
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■ setRenderPassType

■ softSelect

■ stereoCameraView

■ stereoRigManager

■ targetWeldCtx

■ texSmoothContext

■ treeView

■ vectorize

更新された Maya コマンド
Maya 2010 では、以下の Maya コマンドが更新されました。詳細については、
『MEL コマンドリファレンス』（ヘルプ > MEL コマンドリファレンス（Help
> MEL Command Reference））を参照してください。

animCurveEditor

追加されたフラグ

■ -constrainDrag

animLayer

追加されたフラグ

■ -copyAnimation

artAttrCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper
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artAttrPaintVertexCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper

■ -vertexColorRange

■ -vertexColorRangeLower

■ -vertexColorRangeUpper

artAttrSkinPaintCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper

artFluidAttrCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper

artPuttyCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper

更新された Maya コマンド  | 159



artUserPaintCtx

追加されたフラグ

■ -alphaclamp

■ -alphaclamplower

■ -alphaclampupper

attrControlGrp

追加されたフラグ

■ -annotation

■ -handlesAttribute

bakeResults

追加されたフラグ

■ -bakeOnOverrideLayer

■ -destinationLayer

■ -minimizeRotation

■ -removeBakedAttributeFromLayer

■ -resolveWithoutLayer

■ -smart

bakeSimulation

追加されたフラグ

■ -bakeOnOverrideLayer

■ -destinationLayer

■ -minimizeRotation

■ -removeBakedAttributeFromLayer

■ -resolveWithoutLayer
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■ -smart

bevelPlus

追加されたフラグ

■ -bevelInside

cacheFile

追加されたフラグ

■ -cacheFormat

■ -cacheableAttrs

■ -creationChannelName

■ -replaceWithoutSimulating

■ -runupFrames

camera

追加されたフラグ

■ -displayGateMask

channelBox

追加されたフラグ

■ -attrBgColor

■ -attrColor

■ -attrFilter

■ -attrRegex

■ -containerAtTop

■ -nodeRegex

■ -update
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colorIndex

追加されたフラグ

■ -debug

commandPort

追加されたフラグ

■ -listPorts

container

追加されたフラグ

■ -asset

■ -assetMember

■ -bindAttr

■ -connectionList

■ -current

■ -fileName

■ -includeHierarchyAbove

■ -includeHierarchyBelow

■ -includeNetwork

■ -includeShaders

■ -includeShapes

■ -includeTransform

■ -nodeNamePrefix

■ -parentContainer

■ -preview

■ -publishAndBind

■ -publishAsChild
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■ -publishAsParent

■ -publishAsRoot

■ -publishAttr

■ -publishConnections

■ -publishName

■ -unbindAndUnpublish

■ -unbindAttr

■ -unpublishChild

■ -unpublishName

■ -unpublishParent

■ -unsortedOrder

convertLightmap

追加されたフラグ

■ -useLensBake

cycleCheck

追加されたフラグ

■ -query

dgtimer

追加されたフラグ

■ -hide

■ -overhead

■ -rangeLower

■ -rangeUpper

■ -returnType
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■ -show

■ -sortMetric

■ -sortType

■ -trace

■ -uniqueName

■ -updateHeatMap

displayPref

追加されたフラグ

■ -displayGradient

displayString

追加されたフラグ

■ -delete

dynParticleCtx

追加されたフラグ

■ -nucleus

editorTemplate

追加されたフラグ

■ -annotation

■ -listExtraAttributes

■ -queryLabel

evalDeferred

追加されたフラグ

■ -evaluateNext
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■ -list

file

追加されたフラグ

■ -lastFileOption

■ -lockContainerUnpublished

削除されたフラグ

■ -objectType

■ -subType

fileBrowserDialog

-fileCommand の引数の型を string から script に変更

fileDialog

追加されたフラグ

■ -defaultFileName

■ -title

gradientControlNoAttr

追加されたフラグ

■ -asString

■ -changeCommand

■ -currentKey

■ -currentKeyChanged

■ -currentKeyColorValue

■ -currentKeyCurveValue

■ -currentKeyInterpValue
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■ -dragCommand

■ -rampAsColor

headsUpDisplay

追加されたフラグ

■ -getOption

■ -setOption

headsUpMessage

追加されたフラグ

■ -uvTextureEditor

■ -viewport

help

追加されたフラグ

■ -listUnconverted

■ -syntaxOnly

hudSliderButton

変更された引数の型

■ -buttonPressCommand: string から script に

■ -buttonReleaseCommand: string から script に

hyperGraph

追加されたフラグ

■ -graphDescription

■ -heatMapDisplay
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■ -imageForContainer

■ -layoutSelected

■ -mergeConnections

■ -opaqueContainers

■ -range

■ -showRelationships

削除されたフラグ

■ -invertRegularExpressionFilter

■ -regularExpressionFilter

iconTextButton

追加されたフラグ

■ -commandRepeatable

itemFilterAttr

追加されたフラグ

■ -published

layoutDialog

-uiScript の引数の型が string から script に変更

listAttr

追加されたフラグ

■ -hasNullData

■ -ramp

■ -usedAsFilename
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listHistory

追加されたフラグ

■ -futureLocalAttr

■ -futureWorldAttr

■ -historyAttr

■ -query

lockNode

追加されたフラグ

■ -lockUnpublished

ls

追加されたフラグ

■ -deletable

■ -internal

■ -nonDeletable

■ -preSelectHilite

manipMoveContext

追加されたフラグ

■ -postDragCommand

■ -preDragCommand

■ -preserveUV

■ -tweakMode
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manipOptions

追加されたフラグ

■ -preselectHighlight

manipRotateContext

追加されたフラグ

■ -postDragCommand

■ -preDragCommand

■ -preserveChildPosition

■ -preserveUV

■ -tweakMode

manipScaleContext

追加されたフラグ

■ -postDragCommand

■ -preDragCommand

■ -preserveChildPosition

■ -preserveUV

Mayatomr

追加されたフラグ

■ -fragmentMaterialAssignments

■ -passContributionMaps

■ -passUserData

■ -render

■ -useLensBake
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memory

追加されたフラグ

■ -dump

■ -kiloByte

■ -mark

■ -megaByte

menu

追加されたフラグ

■ -fullPathName

modelEditor

追加されたフラグ

■ -cameraSetup

■ -editorChanged

■ -nParticles

modelPanel

追加されたフラグ

■ -barLayout

move

追加されたフラグ

■ -preserveUV
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nParticle

追加されたフラグ

■ -attribute

■ -cache

■ -conserve

■ -count

■ -deleteCache

■ -dynamicAttrList

■ -floatValue

■ -gridSpacing

■ -inherit

■ -jitterBasePoint

■ -jitterRadius

■ -lowerLeft

■ -name

■ -numJitters

■ -order

■ -particleId

■ -perParticleDouble

■ -perParticleVector

■ -position

■ -shapeName

■ -upperRight

■ -vectorValue

削除されたフラグ

■ -clearCachedTextureMap

更新された Maya コマンド  | 171



■ -clearStart

■ -stuffStart

■ -textureToVertex

nameCommand

追加されたフラグ

■ -sourceType

nodeCast

追加されたフラグ

■ -copyDynamicAttrs

outlinerEditor

追加されたフラグ

■ outlinerEditor

■ -autoExpandLayers

■ -containersIgnoreFilters

■ -organizeByLayer

■ -showAnimLayerWeight

■ -showAssets

■ -showContainedOnly

■ -showContainerContents

■ -showPublishedAsConnected

playblast

追加されたフラグ

■ -activeEditor
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■ -cameraSetup

pluginInfo

追加されたフラグ

■ -activeFile

■ -cacheFormat

pointOnCurve

名前が変更されたフラグ

■ -n から -no に変更

pointOnSurface

名前が変更されたフラグ

■ -n から -no に変更

polyBoolOp

追加されたフラグ

■ -preserveColor

polyColorSet

追加されたフラグ

■ -currentPerInstanceSet

■ -perInstance

■ -shareInstances

■ -unshared
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polyCrease

追加されたフラグ

■ -operation

polyMergeVertex

追加されたフラグ

■ -mergeToComponents

polyMultiLayoutUV

追加されたフラグ

■ -offsetU

■ -offsetV

■ -prescale

■ -sizeU

■ -sizeV

polyPrism

追加されたフラグ

■ -numberOfSides

名前が変更されたフラグ

■ -ns から -nsi に変更

polyPyramid

追加されたフラグ

■ -numberOfSides
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名前が変更されたフラグ

■ -ns から -nsi に変更

referenceQuery

追加されたフラグ

■ -showDagPath

■ -showNamespace

renderSettings

追加されたフラグ

■ -camera

■ -customTokenString

■ -fullPath

■ -fullPathTemp

■ -genericFrameImageName

■ -imageGenericName

■ -layer

■ -leaveUnmatchedTokens

renderWindowEditor

追加されたフラグ

■ -currentCameraRig

■ -displayImageViewCount

■ -nextViewImage

■ -resetViewImage

■ -stereo

■ -stereoImageOrientation
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■ -stereoMode

■ -viewImageCount

renderer

追加されたフラグ

■ -batchRenderOptionsStringProcedure

■ -iprOptionsProcedure

rotate

追加されたフラグ

■ -preserveChildPosition

■ -preserveUV

scale

追加されたフラグ

■ -preserveChildPosition

■ -preserveUV

scriptCtx

追加されたフラグ

■ -debug

■ -meshComponents

■ -nParticle

■ -nParticleShape

scriptJob

追加されたフラグ

■ -nodeNameChanged
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scriptedPanelType

追加されたフラグ

■ -copyStateCallback

selectMode

追加されたフラグ

■ -debug

selectPref

追加されたフラグ

■ -containerCentricSelection

■ -manipClickBoxSize

■ -paintSelect

■ -paintSelectWithDepth

■ -preSelectHilite

■ -preSelectHiliteSize

■ -straightLineDistance

■ -useDepth

selectPriority

追加されたフラグ

■ -debug

■ -nParticle

■ -nParticleShape
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selectType

追加されたフラグ

■ -debug

■ -meshComponents

■ -nParticle

■ -nParticleShape

setEditor

追加されたフラグ

■ -debug

setKeyframe

追加されたフラグ

■ -animLayer

■ -dirtyDG

■ -identity

shelfButton

追加されたフラグ

■ -commandRepeatable

snapMode

追加されたフラグ

■ -pixelCenter

■ -pixelSnap
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stackTrace

追加されたフラグ

■ -parameterCount

■ -parameterType

■ -parameterValue

symmetricModelling

追加されたフラグ

■ -preserveSeam

■ -reset

■ -seamFalloffCurve

■ -seamTolerance

texRotateContext

追加されたフラグ

■ -snap

■ -snapRelative

■ -snapValue

texScaleContext

追加されたフラグ

■ -snap

■ -snapRelative

■ -snapValue
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timeControl

追加されたフラグ

■ -animLayerFilterOptions

■ -animLayerShowWeight

■ -forceRefresh

transferAttributes

追加されたフラグ

■ -searchMethod

undoInfo

追加されたフラグ

■ -closeChunk

■ -openChunk

■ -printQueue

viewManip

追加されたフラグ

■ -fitToView

■ -frontParameters

■ -goDefault

■ -goHome

■ -homeParameters

■ -levelCamera

■ -resetFront

■ -resetHome

■ -restoreCenter

180 | 第 24 章   Maya コマンド



■ -selectionLockParameters

■ -setFront

■ -setHome

■ -toggleSelectionLock

viewPlace

追加されたフラグ

■ -animate

wrinkle

削除されたフラグ

■ -geometry

■ -remove

xform

追加されたフラグ

■ -preserveUV

Maya コマンドの制限事項
一般

メニューバーのレイアウト

子コントロールを追加するまで、メニューバーのレイアウトが表示されません。

解決方法

メニューバーのレイアウトと子コントロールを作成してから、ウィンドウを表
示してください。
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MEL

文字列を整数として使用すると Maya がクラッシュすることがある

文字列を整数として操作する MEL スクリプトをソースにすると、Maya がクラッ
シュする可能性があります。

MEL 配列に関する制限

{} という表記を使用して MEL 配列の要素を指定すると、配列の最初の要素に基
づいて配列の型が推定されます。したがって、最初の要素に整数を指定した配列
において、2 つ目以降の要素に浮動小数点数を指定すると、警告メッセージが表
示されます。その場合、浮動小数点数は整数に変換されます。例

float $arr[] = { 1, 2.5 };

// Warning: Casting from float to int may result in a loss of

precision. //

print($arr[0] + “ “ + $arr[1] + “\n”);

1 2

配列 $arr の 2 番目の要素は意図した 2.5 ではなく 2 になります。

解決方法

配列の最初のエレメントが、配列に設定したいタイプとして宣言されていること
を確認してください。前述の例では、配列は次のように宣言してください。

float $arr[] = { 1.0, 2.5 };

<NewLine/>「1」を「1.0」と宣言することにより、配列のタイプが浮動小数点
であることが示されます。

ポリゴン作成コマンドのテクスチャフラグがサポートされない

ポリゴン作成コマンドの -textureフラグ（-tx）は、Maya 8.0 ではサポートさ
れません。代わりに -createUVsフラグ（-cuv）を使用してください。

MEL 文字列でのダッシュの使用

文字列の最初の文字がダッシュの場合、MEL インタプリタはそれをコマンドフ
ラグとみなします。

ただし、これは MEL コマンドでダッシュから始まる文字列を使用できる場合に
限ります。setAttr コマンドでは、ダッシュから始まる値の文字列を使用して型
の文字列のアトリビュートを設定できるようになりました。
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MEL ではダッシュで始まる文字列を使用しないことを強くお勧めします。これ
は他のコマンドでは動作しません。ダッシュで始まる文字列を他のコマンドでア
トリビュートとして使用しようとすると、不正な結果を招くことがあります。

stringArrayIntersector

バッチモードでは、MEL 関数 stringArrayIntersector は動作しません。

MEL でコネクトするアトリビュートは型が同一である必要がある

MEL で型が異なる 2 つの多次元配列アトリビュートをコネクトしようとすると、
突然終了してしまう場合があります。

解決方法

コネクトするアトリビュートの型は必ず同一にしてください。

Python

Python 2.6 では as()メソッドに代わって asUnits()メソッドを使用すると
競合を回避できる

以前に MAngle、MDistance、または MTime の各クラスで as() メソッドを使用
していた Python プラグインやスクリプトは、新しい asUnits() メソッドを使用
するように変更して Python 2.6 の asキーワードに関する競合を回避する必要
があります。

スクリプトエディタ（Script Editor）が .py ファイルをソースにできない

.py（Python）スクリプトをスクリプトエディタでソースにしようとすると
（ファイル > ソーススクリプト（File > Source Script））、MEL として読み取
られるためエラーが返されます。

解決方法

インポートディレクティブを使用します。スクリプトは PYTHONPATH または
sys.path に置いてください。

スクリプトは Python を受け入れません。

Python をスクリプトノードで使用することはできません。
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解決方法

Python スクリプトを .pyファイルに書き込んで、スクリプトディレクトリに
保存してください。スクリプトノードで次の MEL コマンドを使用してくださ
い。

python("\ \ import myPythonScript;\ myPythonScript.pyCommand();\

\ "); 262522 nf 10.0

Toxik で Maya Python モジュールを 2 回インポートできない

Toxic で、新しい Python 組み込みインタプリタを使用して Maya Python モ
ジュールの 2 回目のインポートができないという既知の問題が存在します。

Python のランタイムコマンドとホットキー

Python のランタイムコマンドであるメニュー項目には、ホットキーが表示され
ません。

シェルフ上の menuItems に存在する Python コマンドがエラーを生成す
る

シェルフボタンの一部として menuItems にアタッチされた Python コマンド
は、Maya を再起動するとエラーになります。初回使用時は menuItem コマン
ド（-commandフラグは sciprt 型）を使用してコマンドが作成されるためエラー
にはなりませんが、2 回目以降、コマンドは string string（多目的）引数を取る
-miフラグを持つ shelfButtonコマンドを使用して、保存された shelf.melファ
イルに作成されます。

解決方法
1 Python コマンドを MEL python コマンドでラップします。

mc.menuItem(checkBox = True, label = "menuItem 1", command

="python(\"print 'MENU ITEM 1 PRESSED'\")")

mc.menuItem(checkBox = True, label = "menuItem 2", command =

"python(\"print 'MENU ITEM 2 PRESSED'\")")

2 シェルフからコールする必要のある関数を含む Python スクリプトを、ロー
カルの maya/scriptsフォルダに格納しておきます。

"python(\"import shelfScripts;shelfScripts.thisFunction();\")"
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シェルフコマンドを追加した後、メニューを使用する前に、Maya を再
起動する必要があります。

Python のランタイムコマンドによってエラーが生成される

Python ランタイムコマンドが、Maya の再起動時にプロシージャを見つけるこ
とができません。これらは誤って MEL コマンドとして解釈されています。

解決方法
1 Python コマンドを MEL python コマンドでラップします。

2 ランタイムコマンドからコールする必要のある関数を含む Python スクリ
プトを、ローカルの maya/scriptsフォルダに格納しておきます。

"python(\"import myRunTimes;myRunTimes.thisFunction();\")"

Maya を再起動すると、MEL インタプリタが使用され、関数が正しく実行され
るようになります。

64 ビットシステムに存在しない Python モジュール

次のモジュールは Python の 64 ビットディストリビューション（Windows と
Linux）に含まれていません。

audioop, imageop, rgbimg

詳細については、http://svn.python.org/projects/python/trunk/README を参照し
てください。

PyQt の使用時にファイルのリファレンスでエラーが発生する場合がある

制作に PyQt を使用している場合に、スタンドアロンの maya.standalone を介
したシーンのファイルリファレンスで glibc detected のエラーが発生したら、以
下を追加してみてください。

from PyQt4.QtCore import *

この後、リファレンスを試してみてください。

Maya コマンドは MEL 文字列しか想定していない

コールバックがある Maya コマンドには、MEL 文字列しか想定されていないも
のもあります。これに該当するフラグについては、スクリプトエディタ（Script
Editor）のこのコマンドのヘルプを参照してください。型が scriptであれば、
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Python または MEL を受け入れ、型が stringであれば、MEL しか受け入れる
ことができません。

解決方法

MEL コールバック文字列に「Python」MEL コマンドを使用します。

-c 'python "import myScript;myScript.myFunction()"'

MEL プロシージャに Python 関数を登録する方法については、「ユーザ ガイド
> 一般 > Python > Python で初めてスクリプトを記述する場合のヒントとコツ」
も参照してください。
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ファイルフォーマット

ファイルフォーマットの制限事項
Maya にインポートされる .obj ファイル内のセットはシェーディンググ
ループとみなされる

Maya にインポートされる .obj ファイル内のすべてのセットは、シェーディング
グループとみなされます。このため、Maya 内部でオブジェクトのレンダリング
グループを調整すると、.obj ファイルからインポートされたセットのメンバーシッ
プが同時に変更されます。

解決方法

Maya で、メンバーシップを維持したいセットを含む個々の .obj ファイルごとに、
セットの内容を選択して新しいセットを作成してください。

Maya に Adobe Illustrator 9.0 eps ファイルをインポートする

Maya に Adobe Illustrator 9.0 eps ファイルをインポートすると、トランスフォー
ムノードになりますが、ビューには何も表示されません。

解決方法

Adobe Illustrator 9.0 で、Adobe Illustrator 8.0 形式を指定して、eps ファイルと
して保存します。

25
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（Mac OS X）IGS ファイルフォーマットが認識されない

ファイルブラウザを開いてファイルの種類（Files of Type）フィールドをIGES_DC
(*iges; *igs) に変更しても、拡張子が IGS のファイルが認識されません。

解決方法

ファイルの拡張子を大文字の .IGS から .igs または .iges に変更します。

3.0 以前のシーンファイルが認識されない

Maya 2010 では、Maya 3.0 以前のシーンファイルは認識されません。

解決方法

Maya の旧バージョンからシーンファイルをロードするには、最初にシーンを
Maya 5.0 までの中間リリースにロードしてファイルを保存し直します。

ファイルリファレンスの制限事項
プロキシリファレンスでリネームプリフィックスがサポートされない

名前の衝突を解決するため、プロキシリファレンスではリネームプリフィック
スが機能しません。

解決方法

プロキシリファレンスを操作するときは、ネームスペースオプションを使用し
てください。

参照されるノードのネームスペースとロード

Maya は必ず参照されるノードをテンポラリネームスペースにロードし、それ
から永続ネームスペースに移動します。そのため、ノード追加コールバックに
よって返される名前が、ノード削除コールバックによって返される名前と異なり
ます。

解決方法

ノードを連続して追跡するには、nameChanged コールバックを使用して、ノー
ドが永続ネームスペースに移動されたあとのオブジェクト名を見つける必要があ
ります。
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mental ray のデータを含む複数のシーンを参照すると予期しない結果に
なる

mental ray for Maya のデータを含む複数のシーンを参照すると、次の問題が発
生することがあります。

■ リファレンスファイルをロードすると、すでにコネクトされているノードに
関する複数の警告メッセージがスクリプトエディタ（Script Editor）に表示
されます。

■ シーンをレンダリングすると、予期しないレンダリング設定に基づいてイメー
ジが生成されます。

Maya は、mental ray のレンダー設定（Render Settings）にある共有ノードを
正しく識別しません。これらのいずれかのノード内にあるリファレンスをロード
するたびに、そのファイルから共有ノードに setAttrs と connectAttrs が適用さ
れます。mental ray for Maya のレンダー設定がどのような設定になるかは、
ロードする最後のリファレンスに依存します。

解決方法
■ Maya で、シーン用に参照する各ファイルに同じレンダー設定を設定します。

■ 親シーンにファイルの参照を設定し、警告メッセージは無視します。

■ レンダリング前に mental ray for Maya のレンダー設定を確認します。

リファレンスをロックすると、移動や回転などの複合アトリビュート上
のアニメーションが再生されない

解決方法

フィードバック用にアニメーションが必要であるが、リファレンスが誤って変更
されないようにしたいという場合、Excluded アトリビュートのスクリプトに親
の複合アトリビュートを追加すると、ロック状態をカスタマイズすることができ
ます。あるいは、リファレンスをロックする代わりに、誤って選択されないよ
う、適切に設定されたディスプレイレイヤにそのリファレンスを含めることが
できます。
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複数のレイヤを含むファイルリファレンスで Export As Reference が機能
しない

複数のレイヤが存在するシーンから複数のオブジェクトに対してリファレンスの
み維持（Keep only a reference）を実行することはできません。

解決方法

複数のレイヤを削除し、オブジェクトをリファレンスとしてエクスポートし、あ
とでレイヤを再割り当てしてください。

ポリゴンメッシュジオメトリを親シーン内で変更するにはコンストラク
ションヒストリが必要

ポリゴンメッシュを含むシーンを参照し、親シーン内からそのメッシュに変更
を行う場合、ポリゴンメッシュを参照する前にポリゴンメッシュに既存のコン
ストラクションヒストリがないと、変更は考慮されません。

解決方法

参照する前に、参照するポリゴンメッシュジオメトリがリファレンスファイル
内に少なくとも 1 つのヒストリノードを持っていることを確認してください。

同一のノード名を使用するとリファレンスの編集が失われる

リファレンスからノードに編集を適用するには、ノードを一意に識別できる必要
があります。次の場合にはこれができません。

■ リネームプリフィックスを使用していて、リネームプリフィックスおよび
リファレンスノード名と同じ名前を持つ親ファイルにノードを追加する場合

解決方法

親シーンで編集の適用を開始する前に、ノードの名前が一意であることを確認し
てください。

リファレンスファイルにあるオブジェクトのハイパーグラフ
（Hypergraph）レイアウトが無視される

ファイルを参照するとき、リファレンスファイルにあるオブジェクトのハイパー
グラフレイアウトが無視されます。
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解決方法

リファレンスファイルにあるオブジェクトのレイアウトを変更してください。
インポートまたは参照するときにハイパーグラフを閉じたままにし、あとでク
リーンアップします。

ダブルクォート付きの MEL コマンドを含むエクスプレッション

参照またはインポートされたファイル内に、ダブルクォート（" "）で囲まれた
MEL コマンドを含むエクスプレッションが記載されている場合、ダブルクォー
ト（" "）で囲まれた部分については、ノード名に正しいプリフィックスが付けら
れません。

解決方法

ネームスペースを使用してファイルのインポートと参照を行ってください。また
は、ダブルクォート付きの MEL コマンドを使用しないように、エクスプレッ
ションを変更してください。C スタイルのエクスプレッション（「foo.x = 0.5」
など）は参照時に正しく処理され、ノード名が正しく変更されます。一方、MEL
スタイルのコマンド（「setAttr foo.x 0.5」など）は正しく処理されません。

名前の衝突を解決するためにプリフィックスを使用する場合の制限事項

ネームスペースでファイルを参照するリネームプリフィックスを使用してファ
イルを参照すると、（参照階層内で上位の）リネームプリフィックスがネーム
スペースに変換されます。

デフォルトのリネームプリフィックスを使用して同じシーンに同じファイルを
複数回参照すると、そのファイルに含まれるオブジェクトへの曖昧な参照が生成
されます。参照されるファイルまたはインポートされるファイル内でそのシーン
が参照されている場合は、同じシーンへの複数回のファイル参照が間接的に行わ
れることに注意してください。

解決方法

ファイルを参照するときは常にネームスペースを使用してください。しかしイン
ポートに一度ネームスペースを使用すると、衝突しているかどうかにかかわら
ず、すべてがネームスペースに入ります（すでにネームスペースがあっても、別
のネームスペースが追加されます）。しかしプリフィックスを使用すると、既存
のネームスペースを外し、プリフィックスを使って衝突を解決します。ですか
ら、すでにファイルに存在するものによって、衝突の解決方法を選択するとよい
でしょう。または、複数回インポートされるファイルに対して、固有のリネーム
プリフィックスを割り当ててください。この操作を行うには、ファイル > イン
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ポート（File > Import）オプションウィンドウに移動するか、またはスクリプ
トエディタ（Script Editor）内で file コマンドに -renamingPrefix フラグを使
用します。

同じリネームプリフィックスを使用して同じファイルをインポートおよ
び参照するときの問題

同じリネームプリフィックスを使用して同じファイルをインポートおよび参照
するときに、問題が発生する場合があります。ファイルを参照してからインポー
トすれば、問題は発生しません。ただし、ファイルをインポートしてから参照す
ると、オブジェクト名が曖昧になります。また、マルチレベルリファレンスで
同じリネームプリフィックスを使用すると、インポートファイルにエラーが生
じることがあります。

解決方法

ネームスペースを使用してファイルのインポートと参照を行ってください。また
は、ファイルを参照してからインポートするか、インポート時と参照時で異なる
リネームプリフィックスを使用してください。

ネームスペースまたは名前の衝突のメカニズムに関する制限

現在のシーン内で参照を設定したときに、その参照設定の内部で MEL スクリプ
トを参照している場合は、その MEL スクリプト内で参照されるノード名に対し
てネームスペースまたは名前の衝突のメカニズムが適用されません。このため、
MEL スクリプトにリファレンスファイルに含まれるノード名に基づく処理が記
述されている場合は、問題が発生する可能性があります。

解決方法

シーンに含まれる特定のノードの名前に基づく処理を MEL スクリプト内に記述
しないでください。

ネストしたリファレンスを置き換えられない

ネストしたリファレンスファイル（つまり、メインのシーンの子ではないリファ
レンス）の置き換えは、一時的なアクションです。新しいファイルへのリファレ
ンスは、メインのシーンと一緒には保存されません。

解決方法

リファレンスの親ファイルを開き、置き換えます。
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共有シェーディングネットークまたは共有ディスプレイレイヤをオンに
した状態でリファンレンスの編集内容を保存できない

リファレンスが共有シェーディングネットワークまたは共有ディスプレイレイ
ヤのいずれかのオプションで作成されている場合、リファレンスの編集を保存
（Save reference Edits）を実行することはできません。UI のメニュー項目は使
用できなくなり、file -saveReferenceコマンドを使用してもエラーが返され
ます。

シェーディングネットワークの構造を変更すると共有できない

共有シェーディングネットワークオプションでリファレンスを作成する場合、
作成された共有シェーディングネットワークの構造を変更しないようにしてく
ださい。親シーンのシェーディングネットワークのノードを追加したり削除し
たりすると（たとえば、親シーンにノードを作成して参照されるシェーディング
ネットワークノードの 1 つにコネクトする）、次にリファレンスをリロードし
たときに、このネットワークが適切に共有されないことがあります。

この制限事項は、アトリビュートやアトリビュート値には適用されません。アト
リビュートの追加や削除、アトリビュート値の変更は可能です。

アニメーションのエクスポート時のノードの問題

file コマンドのアニメーションのエクスポートフラグは、アニメーションノー
ドしか書き込みません。エクスポートされないその他のノードの下にアニメー
ションノードがペアレント化されていると、これらの欠落ノードを参照する
connectAttr コマンドが書き込まれます。これらの connectAttrs には相対パス
が使用されます。ほとんどの場合、これらの欠けているノードは実際には一部の
他のリファレンスファイルに属しているためです。

非固有ノード名が含まれている場合、エクスポートされるノードが同じ名前の別
のノード下でペアレント化されている場合、エクスポートされないノードの相対
パスが同じになる可能性があります。このため、エクスポートされたアニメー
ションを Maya に再度インポートしたときに結果が正しくなくなります。

解決方法

ロケータなどのペアレント（非アニメーション）ノードに固有の名前を付ける
か、またはペアレント化された非アニメーションノードもエクスポートするエ
クスポート方法（選択したエクスポートなど）を選択してください。
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ファイルを参照する際にヒストリを持たない UV の値が正しく取得され
ないことがある

リファレンスファイルからジオメトリを取り込む場合に、ポリゴンジオメトリ
でヒストリを持たないようにツィークされた UV 値がが正しく取得されないこと
があります。

解決方法

このオブジェクトのリファレンスファイルに、支障をきたさない、必要最小限
のコンストラクションヒストリを設定します。たとえば、Maya でリファレン
スファイルを開き、ある頂点に対してコンストラクションヒストリを有効にし
て、実際には頂点は移動せずにメッシュの編集 > コンポーネントのトランス
フォーム（Edit Mesh > Transform Component）を実行します。
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ユーティリティと補助機
能

RIB Export の制限事項
Rib Export に関する制限事項と解決方法について次に説明します。

RIB プラグインで変換されない Maya オブジェクトがある

RIB プラグインによって変換されない Maya オブジェクトがいくつかあります。
特に重要な点は、テクスチャとパーティクルが変換されないことです。ただし、
カメラ、ライト、ジオメトリ、およびそれらのアニメーションは正しくトランス
レートされます。非常に単純なアルゴリズムによって、Maya の Lambert、Phong、
Blinn の各シェーダが RenderMan の同等のシェーダに変換され、カラー（Color）
アトリビュートがコピーされます。RenderMan のテクスチャを Maya のシェーダ
に変換しても正しい色は得られません。また、現バージョンの RIB プラグインで
は個々のサーフェス単位のシェーディンググループがサポートされないため、特
定のサーフェスに割り当てられたシェーダは変換されず、RenderMan によってレ
ンダリングすると、それらのサーフェスは白くなります。

Maya のライトの減衰値と RenderMan のライトのデフォルト設定

RenderMan のライトの減衰（Decay）値はすべて 2 であるため、Maya のライト
の減衰値が 2 以外の値に設定されていると、ライティングにおいて輝度の不一致
が生じます。
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解決方法

Maya のライトの減衰値を 2 に設定してください。

Maya のアンビエントライトが RenderMan で正しく表現されない

Maya のアンビエントライト（環境光）は RenderMan で正しく表現されないた
め、トランスレート後のアンビエントライトは RenderMan でレンダリングさ
れたシーンから浮き出て見える傾向があります。

解決方法

アンビエントライトの輝度（intensity）を下げてからトランスレートを行うか、
アンビエントライトをすべて削除するか、または Maya のアンビエントシェー
ダのパラメータを 0 に設定して RenderMan の外観に合わせてください。

モーションブラーがオフの状態で RIB ファイルに書き込まれた Maya シー
ンに関する警告

モーションブラーをオフにして Maya シーンを RIB ファイルに書き込んだ場合、
そのファイルを RenderMan でレンダリングしたときに、「R07005 Premature
RiMotionEnd」という形式の警告が表示されます。

解決方法

この警告は無視しても問題ありません。この問題は Maya の将来のリリースで
解決される予定です。
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API および開発キット

API および開発キットの制限事項
Maya 2010 の API と開発キットに関する制限事項と解決方法について次に説明し
ます。Maya を使用して重要なプロジェクトに取り掛かる前に、『API ガイド』マ
ニュアルを読むことをお勧めします。

（Windows）『API ガイド』に誤ったコンパイラが掲載されている

『API ガイド』マニュアルの「コンパイラの要件」セクションで、Windows 用と
して誤ったコンパイラが掲載されています。Windows 版 Maya 2010 のプラグイ
ンを開発する場合は、Visual Studio 2008 SP1 コンパイラを使用してください。

黒と MPxHwShaderNode プラグインに割り当てられていない色の区別が
できない

現在、MPxHwShaderNodeプラグインの割り当てられていない色に使用する値を設
定する方法はありません。現在は、黒（0,0,0,1）が割り当てられていない色とし
て使用されています。

MPxData が指定されている場合に MPxNode プラグインのアンロードがで
きない

MPxNode プラグインが initialize()メソッドで MPxData を作成すると、ノー
ドを作成しなかった場合でも、このプラグインをアンロードしようとすると使用
中である旨の警告を受けます。これは、プロキシ MPxData タイプが使用されてい
るからです。
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解決方法

compute()メソッドで必要とされるまで MPxDataを作成しないでください。

MItMeshPolygon::getColors(colorArray)ですべてのカラーにアクセスで
きない

MItMeshPolygon::getColors()メソッドには 2 番目のパラメータがあります。
このパラメータはメソッドで考慮されるべきカラーセットのリストを指定しま
す。リストを指定しないと、現在のカラーセットで動作します。

解決方法

MItMeshPolygon::getColors()メソッドで考慮されるべきカラーセットのリス
トを指定します。

プラグがノードの削除または接続解除で削除される

他のノードに接続されているノードを削除または接続解除すると、接続または接
続解除したノードに接続されているプラグも削除されます。

解決方法

すべてのアトリビュートに新しいプラグを作成してください。

アトリビュートが変更されたコールバックに関する制限事項

移動（Move）などのツールによってアトリビュートの変更を行った場合、アト
リビュートが変更されたコールバックは起動されません。

MFnDependencyNode のフラグの制限事項

MFnDependencyNode のフラグの割り当てを解除しても、フラグはリセットさ
れません。これらのフラグをリセットするには、DG 全体を走査する必要があり
ます。

シーン内のディペンデンシーノードの一部分だけが目的であることもあるので、
パフォーマンスを上げるためには、この操作を制御する方が良いでしょう。

MFnMesh::assignUVs()がヒストリをサポートしていない

メソッド MFnMesh::assignUVs()は、ヒストリをサポートしていません。そのた
め、このメソッドを使って UV に行った変更が、ディペンデンシーグラフの更
新として上書きされる可能性があります。
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アトリビュートのロングネームが不正に再利用される可能性がある

ノード上で、既存のアトリビュートとロングネームが同じでショートネームが違
う新しいアトリビュートを作成することができます。これにより、チャンネル
ボックスとアトリビュートエディタ（Attribute Editor）で更新問題が発生しま
す。

API プラグとディペンデンシー階層に関する制限

Maya API では、プラグの階層がサポートされず、単一のディペンデンシーノー
ド内部における各プラグ間の依存関係が認識されません。Dirty プロパゲーショ
ンは、ノード間の接続については正しく機能しますが、MPxNodeで作成された
ユーザ定義ノード上の内部アトリビュート間の接続ではエラーが発生します。

解決方法

ノードに対する入力プラグと出力プラグ間の相互依存関係を定義するときは、
attributeAffects()を使用して階層を平坦にしてください。

OBJ ファイルには「.obj」という拡張子が必要

ファイル > シーンを開く（File > Open Scene）やファイル > インポート（File
> Import）のファイルタイプ（File Type）オプションが Best Guess に設定され
ているときに、Wavefront OBJ ファイルを Maya に自動的に認識させるには、
そのファイルの拡張子が「.obj」でなければなりません。

解決方法

拡張子が「.obj」でないファイルを OBJ ファイルとしてインポートするときは、
ファイルタイプ（File Type）オプションを OBJ に設定してください。

複数のプラグインを使用する Maya シーンのバッチレンダリング

複数のプラグインを使用する Maya シーンで、各プラグインが OpenMayaUI、
OpenMayaAnim、OpenMayaFXのいずれかのライブラリを必要とするときに、（た
とえば、有効なライセンスが存在しないといった理由から）すべてのプラグイン
の initializePlugin がエラーになる場合は、シーンのバッチレンダリングを試み
た時点で、致命的なエラーが発生します。

解決方法

userPrefs.mel ファイルの最後に次の行を手作業で追加してください。
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dynamicLoad OpenMayaUI

dynamicLoad OpenMayaAnim

dynamicLoad OpenMayaFX

プラグインのアンロードとリロード

パーサによって既に解析されたエクスプレッションまたは MEL プロシージャか
らプラグインコマンドがコールされると、プラグインがアンロード（メモリか
ら削除）されます（または、一度アンロードされてからリロードされます）。エ
クスプレッションを起動するか、プロシージャを再実行すると、Maya がクラッ
シュする可能性があります。エクスプレッションまたは MEL プロシージャが解
析されるときは、プラグインコマンドの doIt へのポインタが保存されます。通
常、このポインタの値は再計算されないため、メモリ内の別のアドレスでプラグ
インがアンロードまたはリロードされると、ポインタは無効になります。

プラグインによって定義されたコマンドを MFnPlugin::registerUI()を使用し
て登録すると、同様の問題が発生します。

解決方法

MEL の eval 文の内部にプラグインコマンドのコールを入れてください。これ
で、エクスプレッションが解析されるかプロシージャが実行される度に、eval
文が強制的に再コンパイルされます。プラグインが既にアンロードされている場
合はそのことが検出されて、エラーが発生します。プラグインがリロードされて
いれば、eval 文の再コンパイル時に doIt への新しいポインタが再計算されま
す。

グロー輝度アトリビュートのあるカスタムマテリアルシェーダプラグ
イン

グロー輝度アトリビュートとともに、カスタムマテリアルシェーダプラグイン
を実装した場合、シーンの内部 Maya マテリアルシェーダ（Lambert マテリア
ル、Blinn マテリアル、Phong マテリアルなど）の glowIntensity に 0 より大
きな値が設定されていない限り、このアトリビュートはソフトウェアレンダラ
で無視されます。現在、ソフトウェアレンダラは、0 よりも大きなglowIntensity

値の内部タイプに一致するマテリアルシェーダノードにのみ照会します。この
制限事項を直接回避する方法はありません。

解決方法

カスタムシェーダの glowIntensityアトリビュートのレンダリングが確実に行
われるようにするには、MSceneMessage::kBeforeSoftwareRenderコールバッ
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クと MSceneMessge::kAfterSoftwareRenderコールバックを登録しておく必要
があります。最初のコールバックでは、「shadingNode -asShader lambert;」
によって内部マテリアルシェーダノードを作成し、それから返されたノード名
を読み込む必要があります。その後、ノードの glowIntensity アトリビュートを
0 より大きな値に設定する必要があります。2 つ目のコールバックでは、この
「ダミー」ノードを削除するだけです。

2 つのノードのプラグをコネクトして接続を切断する

2 つのノードのプラグをコネクトした直後に、この接続を切断するのが望ましい
場合があります。MDGModifier::connect()を使用して、2 つのノード間でジオ
メトリデータをコネクトする場合、および画面がリフレッシュされるまでに接
続が切断される場合、データは下位ノードではキャッシュされません。

解決方法

プラグを切断する前に

M3dView::active3dView().refresh();

をコールすると、ディペンデンシーグラフに評価を強制してしまいます。これ
により、下位のジオメトリノードで入力データが読み取られて評価されたあと
接続が切断されると、データがキャッシュできるようになります。

不完全な MPlugs

MNodeMessage::addAttributeAddedOrRemovedCallback()で登録されたユーザ
定義メソッドに渡されたプラグは不完全なMPlugです。MPlug::getValue(MObject
value) では、複雑なデータタイプの値にアクセスすることはできません。

解決方法

この問題を回避するには、次のようなコードを使用します。

MFnDependencyNode fnDn(plug.node());

/*where "plug" is the name of the plug passed in as a parameter

*/

MString newPlugName(plug.name());

/* MPlug::name() will actually return a string containing the

"nodeName.attributeName" so it may need to be parsed for the

following call. */

MPlug realPlug = fnDn.findPlug(newPlugName);
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前述の例で、「realPlug」は完全に機能する、アクセス可能な MPlug です。

格納できる内部アトリビュート（配列）を持つカスタムノード

配列である格納可能な内部アトリビュートを持つカスタムノードを、シーンファ
イルから Maya に読み込んだ場合、このノードにより表示される配列インデッ
クスが正しくない可能性があります。これは、配列エレメントの数をプラグの論
理インデックスと比べたときに値が同等であるとわかった場合、
MPxNode::setInternalValue()メソッドで明らかになります。この現象は内部
アトリビュートでのみ発生するという点に注意してください。

Maya から渡される MObject のタイプ

Maya から次のメソッドに渡される MObjectのタイプは、常に MFn::kInvalid

です。

virtual MPxGeometryIterator * iterator (MObjectArray &

componentList, MObject & component, bool useComponents)

virtual MPxGeometryIterator * iterator (MObjectArray &

componentList, MObject & component, bool useComponents, bool world)

const

これらのルーチンは、MPxGeometryData から派生したクラスで使用されます。
現在のところ、この問題に対する解決方法はありません。

ライトシェーダノードを作成するためのフックがない

現在のところ、Maya のエリアライトノードと似たプロパティを持つライト
シェーダノードを作成するためのフックは API 内にはありません。

blendShape を作成する

MFnBlendShapeDeformer::create()で API の内部から blendShape が作成され
た場合、MFnNurbsCurve::create()を使用して新規に作成されたカーブのMObject

とともに、メソッド MFnBlendShapeDeformer::addBaseObject()を使用すると、
このメソッドは失敗します。

解決方法

新規に作成された NURBS カーブの MDagPathを検索して、このクラスから
MObjectを取得します。このオブジェクトは addBaseObject()で正常に使用で
きます。
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「add pick」を実行するツール

MPxSelectionContext で作成されたツールは、デフォルトで、「add pick」を
実行します。対照的に、Maya に組み込まれた選択ツール（Select Tool）では、
デフォルトで、「replace pick」が実行されます。「add pick」ではアクティブ
なセレクションリストに選択内容が追加されますが、「replace pick」では現在
のセレクションリストが選択したオブジェクトで置き換えられます。

解決方法

MGlobal::displayInfo()を使用してシーンの何も表示されていない部分で左マ
ウスボタンをクリックするように指示し、新規選択を開始します。

メソッド setCursor()

MPxSelectionContextクラスのインスタンスでメソッド setCursor()をコール
すると、このメソッドは失敗します。MPxContextのインスタンスで同じメソッ
ドをコールすると、マニュアルの記載どおりに機能します。

メソッド MDrawRequestQueue::isEmpty()

MDrawRequests が追加されていない MDrawRequestQueueのインスタンスでメ
ソッド MDrawRequestQueue::isEmpty() を使用すると、Maya がクラッシュし
ます。

解決方法

1 つまたは複数の MDrawRequestが追加された待ち行列でこのメソッドをコール
すると、マニュアルの記載どおりに機能します。ステートチェックコードを組
み込んで、isEmpty()をコールする前に MDrawRequest が追加されたことを確
認します。

テクスチャシェーダを入力として Maya に組み込まれたマテリアルシェー
ダに割り当てる

入力としてテクスチャシェーダを、Lambert マテリアルなどの Maya に組み込
まれたマテリアルシェーダに割り当てると、テクスチャノードのメッセージア
トリビュートと下位の materialInfo ノードのテクスチャ 0 アトリビュートが自
動的に接続されます。正確なハードウェアレンダリングのためにはこれが必要
です。カスタムマテリアルシェーダではこれが自動的に行われることはなく、
接続するにはプロシージャを実装する必要があります。残念ながら、シーンを
いったん保存して再び開くと、テクスチャと materialInfo ノードのテクスチャ
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0 アトリビュートとの接続は解除されてしまいます。代わりに、マテリアル
シェーダのメッセージアトリビュートがこの接続を使用しています。

解決方法

この接続を切断するには、プロシージャを実装し、テクスチャノードのメッセー
ジアトリビュートをテクスチャ 0 アトリビュートと再度接続する必要がありま
す。プラグインの初期化メソッドにコールバックを登録してこの接続をチェック
し、必要に応じて変更するか、または AE テンプレートスクリプトを修正して
必要なときに接続を行うと、この問題を解決することができます。

Texture2d ノードで目的のハードウェア解像度をモニタする

Texture2d ノードで目的のハードウェア解像度をモニタするために、レンダラに
より、解像度（resolution）アトリビュートが検索されます。このアトリビュー
トは、Lambert マテリアルなどの組み込まれたマテリアルシェーダノードで
ハードウェアテクスチャリング > テクスチャの品質（Hardware Texturing >
Texture quality）を設定した場合に、あとから必要に応じてテクスチャに追加
されます。カスタムマテリアルシェーダプラグインはこれに該当しません。

解決方法

必要に応じて入力テクスチャにあとから解像度アトリビュート（タイプ kLong）
を任意で追加する、プロシージャを実装する必要があります。解像度アトリビュー
トに指定できる値は 32、64、128、または 256 です。

MPxContext::doHold()メソッド

Alt キーを押しても、コンテキストツールで MPxContext::doHold()メソッドが
コールされます。通常は、Altキーを使用すると、コンテキストツールが無効に
なり、タンブル機能を排他的に使用できるようになりますが、両方が同時に動作
します。コンテキストツールでは両方が同時に動作します。

シェーダプラグイン、および float2 複合アトリビュートの使用

float2複合アトリビュートを使用するシェーダプラグインが、データブロック
から不正確なデータを受け取ることがあります。
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解決方法

複合アトリビュートとしてデータを抽出し、個別にコンテンツを取得するのが一
番です。すなわち、次の例のほうが、同じ内容を別の形で表した 2 番目の例よ
りも望ましいコーディングです。

float2& uv = block.inputValue( aUVCoord ).asFloat2();

float u = uv[0];

float v = uv[1];

vs.

float& u = block.inputValue( aUCoord ).asFloat();

float& v = block.inputValue( aVCoord ).asFloat();

2 番目の方法でコーディングすると、場合によっては、u と v の値が同じになる
ことがあります。

MFnMesh::deleteFace()のコールの問題

MFnMesh::deleteFace()へのコールでは、影響を受けるメッシュの上位のコンス
トラクションヒストリとして deleteComponent ノードが挿入されますが、
MFnMesh::addPolygon()へのコールでは、対応するコンストラクションヒスト
リノードは挿入されません。

解決方法

MFnMesh::addPolygon()は、影響を受けるメッシュオブジェクトの上位に配置
されたノードの計算メソッド内部からのみ使用します。計算メソッド内で、
MFnMeshインスタンスは、入出力データとして渡された kMeshDataで動作しま
す。

API 内部でアクティブなビューポートを照会する

API 内部でアクティブビューポートを照会して、テクスチャが現在表示されて
いるか、またこのオプションを設定できるかどうかを判断する方法はありませ
ん。

MPxCommand と複雑なデータタイプ

MEL コマンドラインから引数を受け取ることを目的とした MPxCommandを記述
する場合は、ポインタ値によってコマンドプラグインに複雑なデータタイプを
渡す方法はないので、注意してください。
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解決方法

クラス MArgList には、MEL コマンドラインからプラグインコマンドに複雑な
データタイプを渡すことができるメソッドがいくつか用意されています。これ
は次のとおりです。

MStatus get( unsigned& indexReadAndUpdate, MVector&, unsigned

numElements=3 ) const

MStatus get( unsigned& indexReadAndUpdate, MPoint&, unsigned

numElements=3 ) const

MStatus get( unsigned& indexReadAndUpdate, MMatrix& ) const

MStatus get( unsigned& indexReadAndUpdate, MIntArray& ) const

MStatus get( unsigned& indexReadAndUpdate, MDoubleArray& ) const

MStatus get( unsigned& indexReadAndUpdate, MStringArray& ) const

MFnPluginData::create()で MObject への参照を維持できない

作成したときに割り当てが行われていない場合、MFnPluginData::create()で、
MObjectへの参照を維持管理することはできません。たとえば、次のコードは失
敗します。

fnPluginDat.create(id, &stat);

MObject obj = fnPluginDat.object();

解決方法

常に、作成時にMObjectを割り当て、内部的に参照が管理されるようにします。
例:

MObject obj = fnPluginDat.create(id, &stat);

MFnFreePointTriadManipulator::setSnapMode(false)

MFnFreePointTriadManipulator::setSnapMode(false)が false に設定されてい
る場合、単一の軸ハンドルを操作しても、スナップモードのままになります。
中央ハンドルを使用すると、マニピュレータは自由に動きます。
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グローバルセレクションリストでは、メッシュオブジェクトコンポー
ネントの選択順序は保持されない

グローバルセレクションリストでは、メッシュオブジェクトコンポーネント
の選択順序は保持されません。たとえば、選択したメッシュ頂点で動作するよう
に設計されたツールは、選択順序に依存してはいけません。

MItDependencyGraph が指定された開始プラグやノードに影響を与える
コネクションだけを横切る

MItDependencyGraphは、指定された開始プラグやノードに影響を与えるコネク
ションだけを横切ります。したがって、メッセージアトリビュートやダイナミッ
クアトリビュートへのコネクションのような、一部のコネクションノードは横
切られません。また、worldMatrix 出力を通って上位へ向かう場合、トランス
フォームノードの移動、回転、スケールアトリビュートへのコネクションは見
つかりません。さらに、MAnimUtil::isAnimated()は機能を MItDependencyGraph

に依存しているので、トランスフォームノードの worldMatrix アトリビュート
を横切らなければそこにたどり着けない場合、移動、回転、またはスケールにコ
ネクションされた animCurves は見つかりません。

解決方法

MItDependencyGraphによってトランスフォームノードまたはメッセージプラ
グに到達したら、カレントの繰り返しを削除して別の MItDependencyGraphを
開始します。MAnimUtil::isAnimated()によってトランスフォームノードまた
はメッセージプラグに到達したら、再度、MAnimUtil::isAnimated()をコールし
ます。

objExists MEL コマンドの起動時の制限

シーンファイルの修正中に objExists MEL コマンドを MGlobal
::executeCommand() で起動すると、不正な結果を招くことがあります。

MArgDatabase::getFlagArgument()と MArgParser::getFlagArgument()の
使用上の制限

メソッド MArgDatabase::getFlagArgument() と MArgParser::getFlagArgument()
は、引用符で囲んだ 2^31 より大きい数を必要とします。

MPxSurfaceShape 関連の問題

次に MPXSurfaceShape 関連の問題について述べます。
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MPxSurfaceShape で作成されたユーザ定義シェイプ

MPxSurfaceShapeで作成されたユーザ定義シェイプでは、コンポーネントごと
のテクスチャマッピングやシェーディングはサポートされていません。

ファイルが見つからない場合、MFileObject resolvedName が空になる

ファイルが見つからなかった場合に、MFileObject の解決済みのパスと名前が空
になるようになりました。以前は、未処理のパスと名前が使用されていました。

ファイルが見つからなかった場合、次の関数は空の文字列を返すようになりまし
た。

■ name()

■ path()

■ fullPath()

■ resolvedName()

■ resolvedPath()

■ resolvedFullName()

基本型へのリファレンス

『API ガイド』には、API メソッドで「int」や「float」などの基本型へのポイ
ンタまたはリファレンスが必要な場合、Python ではポインタに関する情報がな
く、基本型へのリファレンスを渡すことができないため、MScriptUtil クラスを
使用してポインタ/リファレンスを生成する必要があると記載されています。

以下の例は、MScriptUtilの使用方法をわかりやすく示したものです。
MFnLattice.getDivisions() のコールから x、y、z の値を取得する方法を示して
います。
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import maya.OpenMaya as OpenMaya

import maya.OpenMayaAnim as Anim

xutil = OpenMaya.MScriptUtil()

xptr = xutil.asUintPtr()

yutil = OpenMaya.MScriptUtil()

yptr = yutil.asUintPtr()

zutil = OpenMaya.MScriptUtil()

zptr = zutil.asUintPtr()

it = OpenMaya.MItDependencyNodes(om.MFn.kFFD)

while not it.isDone():

latDefFn = Anim.MFnLatticeDeformer( it.thisNode() )

latFn = Anim.MFnLattice( latDefFn.deformLattice() )

latFn.getDivisions(xptr, yptr, zptr)

x = xutil.getUint(xptr)

y = yutil.getUint(yptr)

z = zutil.getUint(zptr)

doSomethingUseful(x, y, z)

it.next()

getUint()は MScriptUtilの静的メソッドであるため、最終値を取得するための
代替方法としてクラスから直接コールすることもできます。例:

x = OpenMaya.MScriptUtil.getUint(xptr)
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マニュアル

Maya ヘルプの制限事項
ヘルプ > Autodesk DirectConnect ヘルプ（Help > Autodesk
DirectConnect Help）を選択しても、DirectConnect ヘルプが適切にロー
ドされない

Windows の場合、メインメニューバーからヘルプ > Autodesk DirectConnect
ヘルプを選択すると旧バージョンの DirectConnect ヘルプがロードされます。Mac
OS X の場合、ヘルプ > Autodesk DirectConnect ヘルプを選択すると
DirectConnect Web ページが表示されます。

解決方法

次のディレクトリに移動し、index.html ファイルをダブルクリックして Autodesk
DirectConnect ヘルプを開きます。

■ （Windows）C:\Program Files\Common Files\Autodesk

Shared\DirectConnect2010\docs

■ （Mac OS X）/Library/Application

Support/Autodesk/DirectConnect/3.0/Docs/

Safari または Firefox で表示するとページ内リンクが壊れている

Maya オンラインヘルプを Safari または Firefox で表示すると、ヘルプのスタイ
ルシートの問題で、同ページ内の見出しへのリンクが正しく動作しません。
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解決方法

オンラインヘルプの使用に支障はありませんが、スタイルシートを編集すると
この問題を解決できます。以下の変更を行う前に、スタイルシートのバックアッ
プコピーを取っておくことをお勧めします。

スタイルシートを編集するには

1 テキストエディタで cpm.cssを開きます。スタイルシートは以下の場所に
あります。

■ （Windows）C:\Program

Files\Autodesk\Maya2010\docs\Maya2010\en_US\style

■ （Mac OS X）/アプリケーション/Autodesk/maya2010/docs/en_US/style

■ （Linux）/usr/autodesk/maya2010-x64/docs/Maya2010/en_US/style

2 以下のセクションから、行 display: none;を削除します。
.anchor_wrapper {

display: none;

}

3 スタイルシートファイルを保存して閉じます。

これ以降は、Safari または Firefox でオンラインヘルプを起動してもページ内リ
ンクは正しく動作します。

（Mac OS X） Safari 4 のバージョンによっては Maya オンラインヘルプ
の検索機能が動作しない

Safari 4 Web ブラウザのバージョンによっては、Maya オンラインヘルプの検索
タブを使用してヘルプを検索できません。

解決方法

検索タブを使用してオンラインヘルプを検索するには、Safari ブラウザをバー
ジョン 4.0.3 以上にアップデートしてください。

（Linux）FBX ヘルプが起動しない

Maya のメインメニューバーから ヘルプ > Autodesk FBX ヘルプ（Help >
Autodesk FBX Help）を選択しても、FBX ヘルプが正しく起動しません。
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解決方法

以下の場所から FBX ヘルプを起動してくださ
い。/usr/autodesk/maya2010-x64/docs/Maya2010/en_US/fbx/en_US/index.html

（Windows）Microsoft Internet Explorer でヘルプコンテンツがブロック
される

Autodesk Maya の Maya ヘルプは JavaScript を使用していますが、Microsoft
Internet Explorer はデフォルトでこれをブロックしてマイコンピュータの HTML
ページを表示させないようにします。

デフォルトでは、マイコンピュータからヘルプにアクセスするごとに、アクティ
ブコンテンツを表示するかどうか尋ねるセキュリティ警告メッセージが表示さ
れます。ヘルプをロードするには、メッセージをクリックし、[ブロックされて
いるコンテンツを許可] を選択してください。

このメッセージが表示されないようにするには

Internet Explorer で、[ツール] > [インターネットオプション] を選択し、[詳細
設定] タブをクリックしてセキュリティセクションまでスクロールダウンしま
す。マイコンピュータのファイルでのアクティブコンテンツの実行を許可する
（Allow active content to run in files on My Computer）をオンにします。

（Windows）Microsoft Internet Explorer で ActiveX コントロールに関す
る警告が表示される

マイコンピュータから Maya ヘルプシステムをロードし、ブラウザプラグイン
COM オブジェクトを Windows に登録すると（『Maya の基本』マニュアルの
「Maya Web ブラウザ プラグインをインストールする」を参照）、次の警告メッ
セージが表示されることがあります。

「このページの ActiveX コントロールは、安全でない可能性があり、ページの
ほかの部分に影響する可能性があります。ほかの部分に影響しても問題ありませ
んか?」

[はい] をクリックして、ヘルプページのロードを続けます。

学習ムービー再生には QuickTime 7.1 またはそれ以降が必要

ムービーの表示に問題がある場合は、ご使用の QuickTime のバージョンを更新
してください。
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（Windows）学習ムービーがネットワーク経由で QuickTime 7 で正しく
再生されない

Windows の QuickTime 7 を使用してネットワークで Maya にアクセスしてい
る場合、学習ムービーが正しく再生されないことがあります。Maya をコンピュー
タのハードドライブにインストールすると、ムービーが正常に再生されます。
これは、Maya 7 の出荷時における Windows 上の Apple QuickTime 7 に関す
る既知の問題です。

（Windows）学習ムービーのキャプションテキストが再生時にムービー
の最初に表示されないことがある

学習ムービーの下に通常表示されるキャプションテキストが、Windows コン
ピュータでムービーの最初に表示されないことがあります。これは、QuickTime
Player のオプションがムービーを開いたとき自動的に再生するよう設定されて
いる場合にムービーを最初に再生したときに発生します。この問題は Windows
でのみ発生します。

解決方法

Windows コンピュータの QuickTime Player で次の設定を行います。

［編集］ > ［設定］ > ［Player 設定］を選択し、［ムービーを開いたときに自
動的に再生］をオフにします。

［編集］ > ［設定］ > ［QuickTime 設定］を選択し、［ムービーを自動的に再
生］をオフにします。

（Windows）学習ムービーのキャプションテキストがムービーのコード
ページ設定と言語設定が一致していない場合に正しく表示されないこと
がある

学習ムービーのテキストキャプションが、ムービーのコードページ設定と言語
設定が一致していない場合に Windows コンピュータでの再生時に正しく表示さ
れないことがあります。たとえば、コードページ設定が日本語であるコンピュー
タ上でムービーの言語を中国語に設定してムービーを再生すると、中国語のキャ
プションテキストが正しく表示されないことがあります。オーディオはどんな
場合でも正しく動作します。これは、Maya 8.5 の出荷時における Apple
QuickTime 7 に関する既知の制限です。

解決方法

コンピュータが現在設定されている言語でムービーを再生します。

214 | 第 28 章   マニュアル



（Mac OS X）日本語版 Safari でコメント送信のダイアログで文字化けが
発生する

日本語版 Safari でマニュアルのトピック下部にあるこのページについてのご意
見をお寄せくださいというリンクをクリックすると、文字化けしたページが表示
されます。

解決方法

他のブラウザ（Mozilla Firefox など）を使用してコメントを送信してください。

日本語などのマルチバイトキャラクタのパスにインストールすると Maya
ヘルプをロードできないことがある

Maya と Maya マニュアルを日本語などのマルチバイトキャラクタを含むパス
にインストールすると、ブラウザによっては Maya ヘルプをロードできない問
題が発生します。

解決方法

マニュアルはマルチバイトキャラクタのないパスにインストールしてください。
リモート（Remote）ヘルプオプションを使用し、ウィンドウ > 設定/プリファ
レンス > プリファレンス > ヘルプ > ヘルプの場所（Window >
Settings/Preferences > Preferences > Help > Help Location）を使用して、Maya
を新しいヘルプの場所にポイントします。

日本語版ヘルプで検索に全角スペースを使用するとエラーが発生する

日本語版 Maya ヘルプの検索フィールドに全角スペース文字を入力すると、検
索機能は動作しません。

解決方法

検索フィールドには半角スペースのみを使用してください。

日本語版 Internet Explorer での Maya ヘルプの検索エンジンのエラー

Internet Explorer で OR パラメータをオンにして「UV エディタ」などの一般用
語を検索すると、「このスクリプトの実行を中止しますか?」という警告メッセー
ジが表示される場合があります。このダイアログで [はい(Y)] をクリックすると、
検索は中止されます。

Maya ヘルプの制限事項 | 215



解決方法

次のいずれかを実行します。

■ 検索結果が表示されるまで、警告ダイアログボックスで [いいえ(N)] をクリッ
クします。

■ 検索パラメータを OR から AND に切り替えます。同じ警告が表示される場
合、検索結果が表示されるまで警告ダイアログで [いいえ(N)] をクリックし
てください。

■ Mozilla Firefox などの別のサポート対象ブラウザを使用します（このエラー
は Firefox では発生しません）。

Linux コンパイラ要件のファイルパスが不正である

「開発者リソース > API ガイド > ビルド環境を設定する > Linux のコンパイラ
の要件」セクションで、gcc コンパイラ命令で次の 1 行を実行するように指示さ
れています。

../files/gcc-4.1.2/configure --prefix=/opt/gcc412 --program-

suffix=412 --enable-shared --enable-threads=posix --enable-

checking=release --with-system-zlib --disable-libunwind-exceptions

--enable-__cxa_atexit

ただし、最初の部分は ../files/gcc-4.1.2/configureではな
く、../gcc-4.1.2/configureとする必要があります。
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